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1.1

Introduction

Introduction

This guide introduces AVEVA's Clash Manager product. As part of Model Management it is
provided as an extension to AVEVA Marine OUTFITTING DESIGN. As Standalone Clash
Manager it is provided as an extension to AVEVA Marine Oultfitting. This chapter lists the
different types of user who would need to read this guide and sets out what knowledge they
will need before they start.

Clash Manager complements the built-in design clash capability of AVEVA Marine Ouffitting.
It provides comprehensive recording, trend analysis, identification, management and the
resolution of clashes through an approval mechanism.

Clash Manager provides reports on clashes and enables a status, history and responsible
discipline to be allocated to each one. This enables the OUTFITTING user to prioritize,
control and monitor the work involved in the resolution of all clashes. The module aids in
assembling the required input data to desclash, transparently running desclash and loading
the resulting desclash output into a separate database that provides reporting, viewing and
approval mechanisms.

The Clash Manager GUI displays information on the occurrences of the clashes, and can
request the OUTFITTING GUI to graphically display the physical positions of the clashing
items.

The GUI enables the user to:

1. Check for clashes within a specified part of the OUTFITTING model.

Check for clashes involving the OUTFITTING Current Element (CE).

View the number of clashes, at specified status, associated with each discipline.
View a breakdown of information about the elements involved in the clashes.

Allocate a status (Unapproved, Pending, Conditional or Approved) to a clash, and to
add comments regarding any status changes.

Specify which discipline is responsible for resolving a clash.
Display selected clashes at the OUTFITTING 3D display.

a s~ DN

N o

Who Should Use This Guide

General users should use this guide to understand the tasks Clash Manager can do and to
find details of how to achieve a specific task using the controls provided.

General users and Administrators should use this guide to adjust Clash Manager settings to
suit project requirements (some settings are visible and editable only for Administrators).

Administrators can also use this guide to set up batch processes using the MMSCMD utility
to automate certain Clash Manager tasks.

© 2007 AVEVA Solutions Ltd 1:1 12.0
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1.2

1.3

Introduction

Assumptions

Users have a valid Model Management or standalone Clash Manager licence and the
software has been installed.

Users of Clash Manager have a basic knowledge of AVEVA Marine Oultfitting.

Model Management users have access to the PE Workbench database OUTFITTING is
running.

Standalone Clash Manager users have access to the Oracle or Microsoft SQL Server
database set up for this product.

How the Guide is Organised

The guide is divided into chapters, as follows:
Introduction introduces Clash Manager.
Concepts describes the Clash Manager concepts.

Design Workflow describes the design workflow to achieve the overall purpose of
discovering and resolving clashes.

Procedures describe the procedures for viewing, preparing and running clashes.
GUI describes the GUI and options available.
Entry Information contains information on wildcards, syntax and rules.

Model Management Wizard describes how to use the Model Management Wizard for Clash
Manager.

Performance Hints gives hints on enhancing perfomance.

Implementing Clash Manager on an Existing Project describes the configuration required.

Product Compatibility

Clash Manager can be used with the following products:

AVEVA Marine OUTFITTING DESIGN 12.0 or later

Standalone Clash Manager can also be used with AVEVA Marine Oultfitting 12.0 or later.
As part of Model Management, AVEVA PE Workbench 5.5 (Oracle 9)

As part of Model Management, AVEVA PE Workbench 5.6 (Oracle 10)

As Standalone, Oracle 9

As Standalone, Oracle 10

As Standalone, Microsoft SQL Server

© 2007 AVEVA Solutions Ltd 1:2 12.0
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Concepts

2 Concepts

2.1 Clashes

A Clash occurs when portions of two elements occupy the same 3D space in a
OUTFITTING model. The following terms are used to define a clash situation:

Clash number A unique number automatically allocated to each clash

Element Any named element in the OUTFITTING model that represents a
physical item involved in a clash. An element cannot be a SITE or
ZONE. Element 1 and Element 2 within a Group are specified.

Group Multiple clashes between a pair of elements within a given volume
may be grouped into a single Clash Group and may be selected for
viewing, reporting or approval as a single entity

Discipline The discipline responsible for resolving the clashes within a group.
The discipline may be automatically or manually assigned.

Status The following Status can be allocated to a Clash Group:
Unknown - an initial or default status
Unapproved - no action has been taken
Pending - the clash is being investigated
Conditional - the clash is approved subject to specified conditions
Approved - the clash is an acceptable feature of the Ship Design

Comments Descriptions of the current and/or historical situation regarding a
group / clash detail

Clash Set Defines the portion of the model to be clash checked. This
comprises the MDB name, and Obstruction and Check and Exclude
lists. User defined Title and Comment can also be appended.

The Obstruction List contains the items that clashes are checked
against. They are usually solid or large items such as walls,
buildings and primary steel.

The Clash List contains the items that are to be checked for clashes
with the Obstruction List items.

The Exclude List contains items to be excluded from the Obstruction
List. An example of its use is as follows. If there are 30 Zones in a
Site of which 28 are to be in the Obstruction List, rather than adding
28 Zones to the Obstruction List, it may be more convenient to add
the Site to the Obstruction List and add the 2 unwanted Zones to the
Exclude List.

© 2007 AVEVA Solutions Ltd 2:1 12.0
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2.2

Concepts

Type Clash types are:
‘Clash’
‘Clearance’
"Touching'.

Level Clash levels are:
'‘Hard/Hard'
'‘Hard/Insulation’
'Hard/Soft
Insulation/Insulation
Insulation/Soft
Soft/Soft
Not Proven

Access Rights

Note: Clash Manager Administrator privileges, unlike other Model Management
Administrator rights, are based on Windows Login IDs and are set directly using
Clash Manager itself. This difference exists to enable Clash Manager to be used
without an installation of PE Workbench.

The arrangements for access rights to Clash Manager cover two aspects, namely User
Access Levels and Security Levels.

The User Access Levels aspect enables the Administrator to specify the users who are to
be the Members and Supervisors of each discipline.

The Security Levels aspect enables the Administrator to specify whether members or
supervisors of particular disciplines may change Clash Status, acquire Clash Ownership,
perform Clash Checks of the OUTFITTING Current Element and/or add Comments to clash
records. Each of these is respectively covered by a separate Security Level namely, Clash,
Owner, Clash Check CE and Comments.

Note: There are no options to set a Security level for preparing and running clash checks,
setting up Clash Manager options and carrying out the 'Advanced Tasks'. These
functions can be carried out only a Supervisor of the ADMIN discipline.

For each Security Level there are five pre-defined states namely, High, Medium High,
Medium, Medium Low and Low. Each of these states has corresponding settings (minimum
requirements). The default State for each Security Level is Medium and this is used as the
guideline when access rights are mentioned in the Clash Manager Procedures.

As required, the Administrator may override the pre-determined settings by specifying
custom settings for one or all of the Security Levels.
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3

3.1

3.1.1

3.1.2

Design Workflow

Design Workflow

This topic is intended for Supervisors of the Administration discipline, and describes when
the Clash Manager forms, and the procedures in this guide, are used to achieve the overall
purpose of Discovering and Resolving Clashes, as mentioned under Model Management
Design Workflow. The start of each Activity summarized in that topic is shown by an italic
upper-case heading in the following sequences.

The sequences and descriptions in this topic are intended to be read by users unfamiliar
with Clash Manager, as they introduce set-up options and configuration tasks in the context
of their effects on the design workflow. An experienced user would endeavour to handle all
configuration tasks at the start of a project.
Following the sequences, are notes on:

» Clash Manager Configuration

« Roles of the Discipline Designers

* Automatic Assignment Rules

« Automatic Acceptance Rules

e Status
¢ Clash Sets
* Log Files

« Project-wide Clash Status Reporting
Hyperlinks in the steps of the sequences, draw the reader's attention to the relevant notes.

The tasks in the sequences are carried out only by a Supervisor of the Administration
discipline, except where other users are mentioned.

Initial Configuration and Setup

Initial Project Setup

1. Configuration task that must be set up prior to the following workflow sequence are
carried out at the Clash Manager Configuration Form - Project Tab.
Refer to Setting Up Clash Management Options.

Checking for Clashes and Resolving Them

1. The initial situation is that there are sufficient items built in the 3D Model in
OUTFITTING to necessitate checking whether or not any of them clash and, if so,
nominating who is the discipline designer responsible for resolving the clash(es).

© 2007 AVEVA Solutions Ltd 31 12.0
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Design Workflow

Disciplines

2.

The general principle of assigning the responsibility for the resolution of a clash is that
it should rest with the discipline associated with one or other of the clashing elements.
(Another discipline can be assigned, where appropriate.) If you are using Clash
Manager without the PE Workbench installation (Stand Alone Clash Manager) it is
necessary to associate (for example) OUTFITTING MMSDISC attribute values with
Clash Manager discipline names so that the appropriate disciplines are identified in
Clash Manager. This configuration task and the selection of the OUTFITTING attribute
and the default discipline are carried out at the Clash Manager Configuration Form -
Discipline Tab.

If you use the Check Check CE option you can also set up a special clash set named
‘Default’ which will be used as a template for all personal clash sets created with the
Check CE option.

Refer to Setting Up Clash Management Options.

Clash Sets

3.

Before you can run a clash check you have to specify the items to be included. You do
this by creating a Clash Set, which essentially contains two lists of objects. The first list
consists of objects that are considered to be obstructions (usually steelwork or
structure items). The second consists of objects that might possibly clash with the
obstructions. You select the contents of the lists in the Clash Set you wish to run,
together with other details such as the co-ordinates of the space occupied by the clash
set, at the Clash Manager - Clash Sets Form and at subordinate forms Clash Manager
- Clash Set Data, - Add * List Item, - Edit * List Item, - Browse OUTFITTING Model
and - Evaluate.

Refer to Preparing a Clash Run.

Clash Groups

4.

There may be several clashes in close proximity to each other between an item and an
obstruction. For example, a pipe running approximately parallel with a steelwork item
may hit it several times. You should consider how you want to handle this type of event,
because to report every clash may provide more detail than is desirable. For example,
an engineer may consider these multiple clashes as one big clash and resolve it
accordingly. Clash Manager provides a method of combining such clashes into 'Clash
Groups', and reporting on these, as well as on the individual clashes. The configuration
task for specifying how the Clash Groups are to be organized is carried out at the Clash
Manager Configuration Form - Group Tab.

Refer to Setting Up Clash Management Options.

Auto-assign Discipline

5.

When both elements of a clash belong to the same discipline, members of that
discipline are probably responsible for resolving the problem. However, when two
disciplines are involved, it is not obvious which one is responsible (that is, which one is
the Owner discipline). To avoid unnecessary manual action, Clash Manager provides a
method of automatically assigning the owner discipline to a clash. For the Clash Group,
the owner discipline can be set to that of the ‘Worst Case’ clash in the group. Setting up
the Auto-assignment process and its associated Class, Level/Type and Priority
considerations is configuration task performed at the Clash Manager Configuration
Form - Assign, Discipline, Class, Level/Type, and Priority Tabs.

Refer to Setting Up Clash Management Options.

Auto-accept Clash

6.

Certain items may clash by design, for example, cables entering a junction box. Clash
Manager will see these as clashes, but the design engineers would not wish to take

© 2007 AVEVA Solutions Ltd 3:2 12.0



_AV:VA Clash Manager User Guide

3.2

3.2.1

3.2.2

Design Workflow

action and, in other words, would 'Approve' the clashes. For clashes of this kind, Clash
Manager provides a method of automatically approving them. The process is based on
Rules that, if satisfied, result in the clash being automatically allocated a status, such
as Approved. The rules also enable specific comments to be attached to the record of
the clash to indicate why it was automatically accepted. The Auto-Acceptance rules
and comments are set up as a configuration task at the Clash Manager Configuration
Form - Accept, Status and Comments Tabs.

Refer to Setting Up Clash Management Options.

Preferences
7. Before you run the clash check, your can specify a number of features that determine

how the clash check operates. Also, you can specify the colour-coding of clashing
elements in the Clash Reports and in the corresponding OUTFITTING display. These
actions are carried out at the Clash Manager Options Form - Preferences Tab.

Refer to Setting Up Clash Management Options.

Clash Set Execution

Run Clash Set and Report
8. You can now run the clash check either from the Tools>Run Clash Set menu option or

from the Clash Sets Form and subsequent Run Clash Set Form. Alternatively, the
clash set can be run as a batch job overnight using mmscmd and Windows scheduled
tasks. The results are presented on Clash Reports. (If you have any doubt that the
clash set has run successfully, you should check the Log Files.) You can organize the
report arrangements to suit your requirements and you can filter the content using the
Clash Report Filter Form.

Refer to: Running a Clash and Viewing Clash Report.

Assign Discipline
9. Your concern now is about the clashes that are not approved. The owner discipline

may have been automatically assigned, or it may be Unallocated because no auto-
assignment rule was satisfied. You can manually assign an Owner Discipline to the
unallocated clashes using facilities at the Clash Report (and possibly the Edit Clash
Groups Form) or at the Clash (Group) Properties Form.

Refer to Updating Clash Status and/or Discipline.

(It may be necessary to correct the design model to ensure correct automatic discipline
assignment is achieved. For example, the PURP attribute may not be set correctly at
zone level).

10. Alternatively, for every Clash Group in which all clashes have identical status and/or

owner disciplines, you can assign that status and owner discipline to the Clash Group.
This is initiated by the 'Reset Group Status' and 'Reset Group Owner' buttons on the
Clash Manager Options Form - Advanced Tab.

Refer to Advanced Tasks.

Data Access Control
11. The Data Access Control arrangement restricts the entry or updating of comments and

status applicable to clashes. The authorized users are members and supervisors of the
disciplines of the clashing elements and of the owner discipline. The access control is
set up as a configuration task at the Clash Manager Configuration Form - Security
Tab.

Refer to Setting Up Clash Management Options.
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3.3

3.3.1

3.4

3.4.1

Design Workflow

Engineering Clash Resolution

Clash Checking the CE

12. To ascertain specific clash details, the discipline design engineer, as a supervisor of the
CE clash owner discipline, as configured by the Administrator, can run a personal clash
check on the CE.

Refer to Clash Checking the CE (Current Element).

Comments

13. As the design engineers change the OUTFITTING model to avoid clashes they can
add comments about the clashes, provided they are members or supervisors of the
element or owner disciplines. The comments are added at the Clash (Group)
Properties Form.

Refer to Updating Clash Properties.

Status

14.To enable the progress in clash resolution to be monitored, you, a member of the
ADMIN discipline, or a Supervisor of the owner discipline other users, as configured,
can periodically update the Status of a clash. This is done at the Clash Reports (and
possibly the Edit Clash Groups Form) or at the Clash (Group) Properties Form, until
it is finally ‘Approved'.
Refer to Updating Clash Properties and Updating Clash Status and/or Discipline.
Alternatively, the designer may have updated the OUTFITTING model to remove the
clash.

Re-run Clash Set Execution

Re-run Clash Set and Report

15. Periodically you re-run the Clash Check for the Clash Set from the Clash Manager -
Clash Sets Form to check on progress made in resolving the clashes, both by the
‘Display Counts' facility on this form and by viewing the resultant Clash report for
Status changes. When required, you can check on the clash status of all or selected
elements by viewing the Element Report.

Refer to Running a Clash, Viewing Clash Report and Viewing Element Report.

Note that, following a re-run, a clash detail is deemed to be the same as existing detail,
if it is between the same two elements and if the position of the clash is within a
tolerance specified when the clash group was organized. When a clash detail from the
current run matches an existing clash detail, the clash level and type of the new
instance is compared against the existing recorded details. If the level/type detail has
worsened, then the clash status of the detail is revised. If a user-defined acceptance
rule applies to the detail, then the status is recomputed in accordance with the rule. If
no rule applies, then the status is set to the default value. If the new clash levelitype is
the same as before or better, no adjustment is made to the status.

When processing of all the details is complete, the status recorded against each group
affected by the run is reset to the value of the worst case status recorded against any of
the member details. This process captures the case where the status of an existing
detail changes, as well as cases where a new detail is added to a group or an existing
detail is removed from a group. The recorded group status can improve or deteriorate
as a result.
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3.5

3.5.1

3.6

3.6.1

Design Workflow

Clash Reporting, Audit and Recomputation

Statistics
16. You can view the clash statistics discipline-by-discipline at the Clash Manager Form.

Refer to Viewing Overview of Clash Data.

Run More Clash Sets
17. As the design of the OUTFITTING 3D model continues, you can extend the scope of

the existing Clash Set and/or create more Clash Sets and run them, as outlined above.

Note: If the normal process of reading desclash output files and post-processing the data

and loading it into the Clash Manager database is interrupted or fails, the
considerable time already spent running desclash need not be wasted. The entire
set of desclash output files may be loaded, replacing any partially loaded.
Alternatively, selected files may be merged into the results of the last Clash Run.
These actions are initiated by the 'Load Clash File' button on the Clash Manager
Options Form - Advanced Tab.

Refer to Advanced Tasks.

Recomputation
18. The actions at the Clash Manager Configuration Form described in the previous

steps, in general, would not be repeated. However, if significant changes have to be
made at this form, recomputation must be performed at the Clash Manager - Clash
Recomputation Form, which, in these circumstances, is automatically displayed.

19. When changes are made to the OUTFITTING Model, it is necessary either to perform

Clash Recomputation or to re-run all affected Clash Sets, in order to update Clash
Manager data. The Clash Manager - Clash Recomputation Form is not automatically
displayed following a change in OUTFITTING, and must be accessed manually to
enable recomputation to be performed.

Refer to Advanced Tasks.

Track Changes
20. As more Clash Sets are run, the statistics displayed at the Clash Manager Form apply

to the combination of all Clash Sets. This information, applicable to the current date,
can be stored as a 'Milestone' for future reference in determining the progress made on
the project. The creation of the Milestone is by selecting 'Track Changes' at the Clash
Manager Options Form - Advanced Tab. Milestones can be created, as required.
Refer to Advanced Tasks.

Continuing Tasks
21. The appropriate tasks are repeated until all clashes are resolved.

As required, make use of the facilities for automatic overnight operations of Running a
Clash Set or Tracking Changes.

Refer to Command Line Interfaces - Clash Manager Functions.

Report on the Project-wide Clash Status by your preferred method.

Housekeeping Tasks

Following Model Changes
1. When the OUTFITTING model has been substantially updated, the clash details

remain in the Clash Manager database (not the OUTFITTING database) even though

© 2007 AVEVA Solutions Ltd 3.5 12.0



_AV:VA Clash Manager User Guide

3.6.2

3.6.3

3.6.4

Design Workflow

the item(s) they refer to have been removed. In these circumstances, the particular
clash details continue to be reported until all Clash Sets containing the detail have been
rerun.

These clash details, including their comments, can be removed from the Clash
Manager database by use of the 'Delete all Unreferenced Groups and Elements,
including Comments' button on the Clash Manager Options Form - Advanced Tab.
This process removes historical data and consequently the original comments will have
been lost, if the clash re-appears.

Refer to Advanced Tasks.

At Project End

2. At the end of a project all clash report data and history data can be removed from the
database by use of the 'Delete All Clash Data, including Comments and History' button
on the Clash Manager Options Form - Advanced Tab. The configuration data and
clash set definitions, check list and obstruction list all remain. The remaining data is
truncated to recover unused space in the Oracle Table Space.

Refer to Advanced Tasks.

Roles of the Discipline Designers

Clash Manager includes a security model that enables you to specify the users who are to
be the Members and Supervisors of each discipline and then to specify whether members or
supervisors of particular disciplines may change Clash Status, acquire Clash Ownership,
perform Clash Checks of the OUTFITTING Current Element and/or add Comments to clash
records (refer to 'Concepts - Clash Manager Access Rights').

Depending on the size and scope of the project, you need to decide what role the discipline
designers will take in the clash resolution process. Typically, there are three approaches that
can be taken:

1. ALL discipline designers have access to the Clash Manager reports and are
responsible for ensuring the clash free status of their part of the design model. This
approach is most suitable for medium to large projects where a large clash data set is
anticipated and requires frequent review by all designers on a part time basis. For this
approach, the Security Levels tend to be towards the Low state.

2. Discipline supervisors or a small number of nominated discipline designers are given
access to the Clash Manager reports. These users are responsible for ensuring the
clash free status of their discipline’s part of the design model. This approach is most
suitable for small to medium projects where a small team of users can adequately
manage and review the Clash Manager reports on a part-time basis. For this approach,
the Security Levels tend to be at the Medium state.

3. An overall clash coordinator is responsible for ALL clashes on the project and is tasked
to review the Clash Manager reports and perform clash resolution in consultation with
discipline designers. This approach is most suitable for small projects where only a
small clash data set is anticipated and can be easily handled by one person on a part
time basis. For this approach, the Security Levels tend to be towards the High state.

The approaches described above are for guidance only but are typical of those taken by
existing users in the deployment of Clash Manager. You may decide to adopt one of the
above approaches, or formulate your own solution to match your specific project
requirements.

Clash Manager Configuration

Before Clash Manager can be used on a project, it is necessary for you to perform some
configuration tasks. The focus of these tasks is to produce an organized and structured
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presentation of clash data that assists in the management of the clashes. All configuration
tasks described here are carried out at the Clash Manager Configuration form.

The basic configuration tasks, which are necessary regardless of project size, are as
follows:

e Project — OUTFITTING project code, user-id, password and MDB

« Discipline — determines how disciplines are identified for the clashing elements

e Security — controls user, supervisor and administration access rights

« Group — controls group settings for consolidation of detail clashes

e Assign — determines how clashes can be automatically assigned to a discipline.
The above tasks should serve for small to medium sized OUTFITTING projects, with the

remaining advanced configuration tasks namely, Accept, Class, Priority, Status,
Comments, Level/Type and Gtype/Tracking, safely left at the default values.

For larger projects, the advanced configuration tasks should be carried out, to achieve
complex assignment and acceptance rules.

Automatic Assignment Rules

In order to set up successful assignment rules you need knowledge of how the
OUTFITTING model is structured and how each discipline will model design items. You
need this to enable you to determine the best set of rules for your specific project. Typically,
the following situations are considered when formulating the automatic assignment rules:

« Access-ways and Escape routes

e Issued Pipes

* Exotic Materials

e Primary Steelwork

* Issued Secondary Steelwork

e Tertiary Steelwork

e Stress Critical Pipes

* Issued Elements

» Electrical Lighting

» Electrical and Instrument Stands

* Withdrawal Volumes
As your project progresses and Clash Manager is used in earnest, it is inevitable that you
will need to either modify or add to your clash assignment rules. When you do this it may be

necessary to recompute all or some of the clashes in the database to take account of the
new rules.

Automatic Acceptance Rules

Automatic clash acceptance can save a lot of time for the project, removing the need for the
designers or clash coordinators to review and approve acceptable clashes. To set up
successful acceptance rules for a project, you need knowledge of how the OUTFITTING
model is structured and how each discipline will model design items.

The following list contains some example situations where specific acceptance rules may be
applicable:

* All Soft/Soft — Touch, Clear, Clash
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Architectural Fittings with Architectural Walls — Touch, Clear
Supports with Main Steelwork — Touch, Clear

Structural with Structural — Touch, Clear

Supports with Stair ways and Ladders — Touch, Clear

Stair Ways and Ladders with Any Other Discipline — Touch, Clear
Lay Down Areas with Any Other Discipline — Touch, Clear
Handling Ways with Handling Ways — Touch, Clear, Clash

Main Escape Ways with Main Escape Ways - Touch, Clear, Clash
Secondary Escape Ways with Secondary Escape Ways - Touch, Clear, Clash
Access Ways with Any Other Discipline — Touch, Clear

Escape Ways with Any Other Discipline — Touch, Clear
Penetration Sleeve with Any Other Discipline — Touch, Clear
Support with Piping — Touch, Clear

Spray Volume with Spray Volume — Touch, Clear, Clash
Hazardous Areas - Touch, Clear, Clash

Note that the automatic acceptance facility does not only approve clashes. It can be used to
set a clash to any standard status, namely:

Unknown
Unapproved
Pending
Conditional
Approved

3.6.7 Status

The standard clash status values that Clash Manager uses to categorize a clash are as
follows:

Unknown — an initial or default status applied to new clashes if none of the automatic
acceptance rules are triggered

Unapproved — the clash has not been reviewed and remains as a valid or outstanding
clash for the project

Pending - this status is used to indicate that the clash is currently under review by the
design teams

Conditional — this status is used to indicate that the clash has been reviewed and
resolved in the design model. This also implies that following the next clash run this
clash will no longer appear in the clash report. For reporting purposed this status
implies a resolved clash.

Approved - this status is used to indicate that the clash has been reviewed and is
considered acceptable by the design team. The clash will continue to be reported in
subsequent clash runs, but its approved status will remain with the clashing items
throughout the remainder of the project lifecycle. In Model Management terms, if an
element has only ‘Approved’ clash status in the database, it is considered ‘Clash Free'.

For the purpose of evaluating the worst case the standard status always appear in the order
shown above, the worst case being at the top of the list.

User-defined status can be inserted into the list to suit specific project requirements. The
use of these status can be restricted to specific disciplines, or users. For example, status
could be inserted as follows:
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« Piping to Verify — a conditional approval to be used by the PIPING discipline only.
This status may be used by the clash coordinator who has conditionally accepted a
number of clashes on behalf of the PIPING team. Setting the status to this new value
makes it easy for the PIPING team to filter on this status on the clash reports and
therefore to review all clashes conditionally accepted on their behalf.

e For Design Review — a pending status for use by all users. Clashes with this state
require further investigation or discussion at the next design review meeting.

Clash Sets
It is recommended that the number of Clash Sets for a project is kept to a minimum.

There are no limits on how you structure the Clash Sets, for example, by area, discipline,
design status or combinations of these. The following examples show how Clash Sets have
been configured:

* By design area and discipline — with structural as the obstruction and all other
disciplines checked against the structures.

* By design discipline and design status — with disciplines checked against each other
based in model design status. An example of this approach is to only clash check items
with ‘built’ or ‘checked’ status.

e By design area/sub-area, discipline and design status — for a large OUTFITTING
project, it may be necessary to subdivide design areas into smaller sub-areas, strips or
modules, in order to complete a clash set or series of clash sets overnight, in batch
mode. These smaller Clash Set runs execute quickly, but incur additional
administrative overhead to coordinate the Clash Set execution.

It is recommended that you construct your Obstruction, Check and Exclude lists using
wildcards, where possible. This reduces the amount of administration required during the
life of the project, because, as sites, zones or elements are added or deleted from the
design databases, they will be automatically included or removed from Clash Set lists that
use wildcards.

AVEVA has seen a number of situations where clients have started a project with a large
number of clash sets (x100s) and, through experience gained during the life of the project,
have rationalized these down to a more manageable number (x10s). Therefore, before
implementing Clash Manager, think carefully about the approach you will take when defining
your Clash Sets, and ensure the number of Clash Sets is kept to a manageable size.

Log Files

Following execution of a clash set, you can check whether the process is successful by
interrogating the log files that are generated. The log files for a clash set run are created in a
sub directory under the directory referenced by your TEMP environment variable. The most
reliable method to determine your TEMP directory is to ‘echo’ the TEMP environment
variable setting in a Windows command window: echo %temp%. Alternatively, open a
Windows Explorer session with the TEMP path from the Start>Run... dialog. Once you have
determined the location for your temporary system files, you will find the files in the
directory: Pclam_'project code’_'windows_username’_'clash_set _number’

There are five files generated by the clash set, and a series of output files; one for each
checked element. The names and purposes of the files are as follows:

pclam.fin — this file will contain the message ‘OK’ if the clash set processed without
error. If an errors occurred during the desclash execution, then the OUTFITTING error
message text is written to this file.
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pclam.log — this file is the main log file and contains messages to indicate the
processing of each check element. The foot of the file contains the message ‘Normal
Termination’ if the clash set completed successfully.

pclam.mon — this file contains a detailed set of messages and time stamps to indicate
duration of each stage of processing and loading of clash output files into the Clash
Manager database.

pclam.pmlmac — this is the pml macro executed by the clash set to generate the
clash output files

pclam_check.pmlmac — this is the check macro called by pclam.pmlmac that
performs the check check processing in Desclash.

pclam_nnnn.OUT - this is the output file generated for each checked element.

Project-wide Clash Status Reporting

In order to keep project management aware of the model’'s clash status, it is important to
generate regular clash status reports. There are a number of ways of doing this and any
combination of the methods described here can be utilized:

Business Objects — this is AVEVA's recommended method of reporting for all Ship
Model Management products. A BO universe is required for this and, once in place, the
BO reports can be produced easily and quickly.

Track Changes — this creates milestones in the Clash Manager database to allow
filtering of statistics on the main Clash Manager bar charts. This also allows
rudimentary clash trend analysis to be performed. The bar chart graphics directly
cannot be saved directly, however a third-party screen capture tool can be used to do
this. Alternatively, statistics can be saved in csv format for import into Excel, or similar
spread sheet application, as described below.

Microsoft Excel — a number of clients are using this method to great effect to produce
detailed statistics for clash status. An example of how this can be achieved is to take a
daily or weekly save of the main form statistics and load these into an Excel sheet. This
data can then be used to produce detailed trend analysis reports, using Excel’s in-built
charting and statistical functions.

'Screen Shots’ — Simply take regular screen ‘shots’ from the main Clash Manager bar
chart display.
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4 Procedures

4.1  Setting Up Clash Management Options

1. Select View>Clash Manager or at the Toolbar, select Clash Manager.
2. The 'Main Clash Manager Form' form is displayed.
3. Select Tools>Settings.

Preferences

4. The 'Clash Manager Options' form is displayed. At the Preferences tab, select your
preferred methods of handling clash information and highlighting features in the Clash
report and in the OUTFITTING display. (Refer to Options Form).

Configuration

5. Security: This step is available only to Supervisors of Administrator discipline.
If configuration of the Clash Manager operation is required, press the Clash Manager
Configuration button on the Preferences tab of the 'Clash Manager Options' form. The
‘Clash Manager Configuration' form is displayed. Enter, update or delete data at the
tabs appropriate to the configuration tasks in hand. (Refer to Clash Manager
Configuration Form).

6. The 'Clash Recomputation' form is displayed, if significant changes have been made to
the configuration. Initiate the recomputation process for the required features. (Refer to
Clash Recomputation Form).

4.2  Viewing Overview of Clash Data

Security: This procedure is available to members of all disciplines.

1. Select View>Clash Manager or at the Toolbar, select Clash Manager.

2. The 'Clash Manager' form is displayed. View the listed and graphical data. (Refer to
Clash Manager Form).

3. As required, display overview data for Clash Groups, or Individual Clashes by selecting
Summary Display then Clash Goups, or Summary Display then Clash Details at
the "Tools' dropdown menu. Alternatively, the data can be viewed as required using the
popup menus. (Refer to Popup Menus).

4. Filter the displayed data, as required using the popup menus (Refer to Popup Menus)
or by selection of Summary Display then Filter Chart at the 'Tools' dropdown menu.

4.3 Preparing a Clash Run

Security: This procedure is available only to Supervisors of Administrator discipline.

1. Select View>Clash Manager or at the Toolbar, select Clash Manager.

© 2007 AVEVA Solutions Ltd 4:1 12.0



_AV:VA Clash Manager User Guide

4.4

44.1

4.4.2

Procedures

The 'Clash Manager' form is displayed. Select Tools>Clash Sets.

The 'Clash Sets' form is displayed. As required, select an existing clash set for editing,
or add a new clash set. (Refer to Clash Sets Form).

The 'Clash Set Data' form is displayed. As necessary, update the data for the clash set.
(Refer to Clash Set Data Form).

If, in Step 4, items or expressions are to be added to the Clash Set Obstruction, Check
or Exclude lists, the 'Add List Item' form is displayed.
Enter details as required. (Refer to Add List Item Form).

If, in Step 4, elements are to be selected for inclusion in a list, the 'Clash Manager -
Browse OUTFITTING Model' form is displayed.
Browse the OUTFITTING hierarchy and select an item. (Refer to Browse Model Form).

If, in Step 4, existing items or expressions are selected for editing, the 'Clash Manager
- Edit List Item' form is displayed. Edit the details. (Refer to Edit List Item Form).

At the 'Clash Set Data' form, as necessary, check the expression expansions by
selecting Evaluate at the popup menu. (Refer to Popup Menu).

If, in Step 6, expression expansion is checked, the 'Clash Manager - Evaluate' form is
displayed. As necessary, remove any unwanted items from the list of items. (Refer to
Evaluate Form).

At the 'Clash Set Data' form, as necessary, update the data for Extents, Limits etc, and
click on the OK button to create a clash set. (Refer to Clash Set Data Form).

Note: The clash run for this clash set can be initiated directly from the 'Clash Sets' form

(see above). In general, clash runs are initiated from the 'Tools' dropdown menu
(refer to Running a Clash).

Running a Clash

This procedure is available only to Supervisors of Administrator discipline.

Running Clash Set Direct from the Tools Dropdown Menu

M ownbd PR

Select View>Clash Manager or at the Toolbar, select Clash Manager.
The 'Clash Manager' form is displayed. Select Tools>Run Clash Set.
A submenu of Clash Sets is displayed. Select the required Clash Set.

The Clash Set will be run. The results appear in the 'Clash Manager - Clash Sets' form,
and the clashes can be viewed using the Clash Report. (Refer to Clash Sets Form).

Running Clash Set from the Clash Sets Form

Select View>Clash Manager or at the Toolbar, select Clash Manager.
The 'Clash Manager' form is displayed. Select Tools>Clash Sets.

The 'Clash Manager - Clash Sets' form is displayed. Select the clash set, which needs
to be run and click on the Run Desclash button. (Refer to Clash Sets Form).

The 'Run Clash Set' form is displayed. As required, change the default characteristics
of the clash set and initiate the clash run. (Refer to Run Clash Set Form).

The Clash Set will be run. The results appear in the 'Clash Manager - Clash Sets' form,
and the clashes can be viewed using the Clash Report. (Refer to Clash Report).
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Running Clash Set as a scheduled batch job

It is common for Administrators of large OUTFITTING projects to run clash sets overnight,
as the desclash portion of a clash run can be very time-consuming, making it impractical to
run during the day. For full details of this option, refer to Clash Manager Functions.

1.

Create a .bat file (using Windows notepad, or other text editor) in a folder of your
choosing.

The bat file should contain definitions of project evars, so the correct environment is
set. See the example file C:\AVEVA\mmsAL.4\runSynchrolPE_evars.bat.

Once the evars have been set, add the following command to the batch file to run the
clash set. e.g.

C\AVEVA\mmsA1l.4\exe\mmscmd enrl <password> IPEora IPE
W:AIPE\PDMS\IPEDFLTS\IPE.cfg
C:\AVEVA\Pdms11.5\pdmsuser\logfiles\IPE\clashlog.#date#.#time#.txt -clash set
123 “Batch Run”

Where

IPEora is the oracle connect string

IPE is the OUTFITTING project

IPE.cfg is the Model Management Configuration file

clashlog.#date#.#time#.txt is a log file of the resulting clash run

-clash set 123 is the clash option of mmscmd and you have specified clash set no 123
"Batch Run” is a comment that will be stored against the clash run.

The clash set can then be run by either double-clicking on the .bat file, or scheduling it
to run later (e.g. overnight) using Windows Scheduled Tasks.

Multiple clash sets can be run from a single .bat file, by specifying a separate command
line for each clash set.

Note that clash sets should be run consecutively, as there may be contention for some
oracle data and processes if two clash sets are run in parallel.

Clash Checking the CE (Current Element)

This procedure is available to users as defined by the administrator (Clash Manager
Configuration Form - Security Tab).

Note: The CE must be at or below a Group Element Type. The Group Element is the

1.
2.

3.

element that will be clash checked.

Select View>Clash Manager or at the Toolbar, select Clash Manager.

The 'Clash Manager' form is displayed. Select Tools>Clash Check CE, to initiate the
Clash Check CE process.

The first time the user initiates the Clash Check CE process in a particular MDB, a
personal clash set titled * Userid/MDB' is created and displayed on the Clash Manager -
Clash Set Data form. Update the default details, as required (see Notes on Personal
Clash Set on the 'GUI for Clash Manager' - 'Clash Set Data Form' ). When the details
are as required, click on the OK button.

Note: Userid is the user’s windows Userld and not the OUTFITTING Userld.

4.

The personal clash set is run. The clashes can be viewed using the Clash Report.
(Refer to Clash Report).
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Note: If a clash is resolved through deleting or relocating one or both of the clashing

elements, records of the clash will become dormant when any clash set referencing
the elements is re-run.

45.1 Viewing Clash Report

Select View>Clash Manager or at the Toolbar, select Clash Manager.

. The 'Clash Manager' form is displayed. Select Tools>Clash Report>Display Report.

The 'Clash Manager - Clash Report' is displayed. Organize the display to show the
Clash Groups and/or Clash Detail reports, and the filter pane, as required. (Refer to
Clash Report). View the data displayed and, as required,

a) apply the existing filter by selecting Enable Clash Group/Detail Filter at the popup
menu or Enable Filter at the report "Tools' dropdown menu, or

b) change the filtering by selecting Set Clash Group/ Detail Filter at the popup menu
or Set Filter at the report "Tools' dropdown menu.

If Set Filter has been selected, the 'Clash Manager - Filter' form is displayed. Enter the
required filtering characteristics. (Refer to Filter Form).

If confirmation of the filter characteristics is required, select Filter at the report 'View'
dropdown menu. The Filter pane appears. (Refer to Clash Report).

Apply the new filter by selecting Enable Clash Group/Detail Filter at the popup menu
or Enable Filter at the report ‘Tools' dropdown menu.

4.6  Viewing Element Report

1.
2.

3.

Select View>Clash Manager or at the Toolbar, select Clash Manager.

The 'Clash Manager' form is displayed. Select Tools>Element Report>Display
Report.

The 'Element report’ is displayed. (Refer to Element Report). View the data displayed
and, as required,

a) apply the existing filter by selecting Enable Filter at the popup menu or Use Filter at
the report "Tools' dropdown menu, or

b) change the filtering by selecting Set Filter at the popup menu or Set Filter at the
report ‘Tools' dropdown menu.

If Set Filter has been selected, the 'Clash Manager - Filter' form is displayed. Enter the
required filtering characteristics. (Refer to Filter Form).

If confirmation of the filter characteristics is required, select Filter at the report 'View'
dropdown menu. The Filter pane appears. (Refer to Element Report).

Apply the new filter by selecting Enable Filter at the popup menu or Use Filter at the
report ‘Tools' dropdown menu.

4.7  Updating Clash Status and/or Discipline

The default arrangements are as follows:

1.

Status can be updated by a Supervisor of the Owner discipline,

Owner Discipline can be acquired by a Supervisor of the new owner discipline,
Owner Discipline can be assigned by a Supervisor of the current owner discipline,
Owner Discipline can be imposed by a Supervisor of the current discipline and a
Member of the Administrator discipline.

Display the 'Clash report', include the Clash Groups and/or Clash Detail, and filter the
contents, as required. (Refer to Viewing Clash Report).

© 2007 AVEVA Solutions Ltd 4:4 12.0



_AV:VA Clash Manager User Guide

4.8

4.9

49.1

2.

3.
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At the Clash Groups or Clash Detail report, highlight the clash group(s) or detail(s)
concerned. (Refer to Clash Report).

Use the appropriate Toolbar buttons, Quick Assign Keys 1, 2, U, P, C, A, or popup
menu options to update the owner discipline and/or status, as required. (Refer to Clash
Report).

Note: To use Quick Assign Keys 1, 2, U, P, C and A, the Enable Quick Keys 1/2 & U/P/C/A

4.
5.

option at the Preferences tab of the Clash Manager Option form must be set to 'true’.
Security: Only a Supervisor of Administrator discipline has access to use Quick
Assign keys.
Repeat Steps 2 and 3 until all required updates have been completed.
Save the updated data.

Updating Clash Properties

The default arrangements are as follows:

Status can be updated by a Supervisor of the Owner discipline,

Owner Discipline can be acquired by a Supervisor of the new owner discipline,
Owner Discipline can be assigned by a Supervisor of the current owner discipline,
Owner Discipline can be imposed by the Supervisor of the current discipline and a
Member of the Administrator discipline,

Comments can be added by a Member of any discipline involved with the clash.

Display the 'Clash report’, include the Clash Groups and/or Clash Detail, and filter the
contents, as required. (Refer to Viewing Clash Report).

At the Clash report, highlight the clash group(s) or clash detail(s) concerned.

If a single clash group has been selected, select Clash Group Properties at the popup
menu (refer to Clash Report). The 'Clash Group Properties' form is displayed. Update
the clash group properties, as required. (Refer to Clash (Group) Properties Form).

If multiple clash groups or details have been selected, Select Edit Clash Groups ***-
*** at the popup menu. (refer to Clash Report). The 'Edit Clash Groups' form is
displayed. Edit the properties of the clash groups, as required. (Refer to Edit Clash
Groups Form).

If a single clash detail has been selected, select Clash Properties at the popup menu
(refer to Clash Report). The 'Clash Properties' form is displayed. Update the clash
properties, as required. (Refer to Clash (Group) Properties Form).

Advanced Tasks

The tasks in this procedure are available only to Supervisors of Administrator discipline.

1.
2.
3.

Select View>Clash Manager or at the Toolbar, select Clash Manager.
The 'Clash Manager' form is displayed. Select Tools>Settings.

The 'Clash Manager Options' form is displayed. Select the Advanced tab. (Refer to
Options Form).

Tracking Changes

The Track Changes operation creates a milestone for the display of statistical data at the
Clash Manager form. It initiates saving the current discipline/status/counts data, and the
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source data for the total number of ‘objects’, and the numbers not checked, clash free, and
clashing

The 'objects’ are controlled GTYPESs that have been the subject of a clash check, as an item
or subordinate item on a Check List. For each controlled GTYPE, the total number is
recorded, together with worst case status, level/type of any clash involving it. (The worst
case may be Clash Free.)

Note: The range of controlled GTYPEs that are included in a Track Changes operation can
be restricted at the Gtype/Tracking tab of the Clash Manager Configuration form.

To initiate a Track Changes operation, proceed as follows:

1. In the Description field, enter a description of the new milestone and click on the
Track Changes button.

2. A message ' Are you sure you want to perform Track Changes' is displayed. Accept the
message to create a Clash History Milestone.

Recomputing Element Properties

If changes have been made in the OUTFITTING model that result in changes to the results
of previous clash runs, proceed as follows:

1. Click on the Recompute Properties button. The 'Clash Manager - Clash
Recomputation' form is displayed.

2. Initiate the recomputation process for the required features. (Refer to Clash
Recomputation Form).

Loading Clash File

This facility is intended to be used if and when the normal process of reading desclash
output files, post-processing the data, and loading it into the Clash Manager Database is
interrupted or fails, or if the RDBMS becomes unavailable through network or hardware
faults. This action avoids wasting the possibly considerable time already spent running
desclash. To use the facility, proceed as follows:

1. Click on the Load Clash File button. The Load Clash File form is displayed. (Refer to
Load Clash File Form).

2. At the Load Clash File form, use the Default button and/or directories pane to select
the directory that contains the files to be loaded.

3. Asrequired, click on the [>>| button to expand the form on order to view the contents of
selected files.

4. To effectively create a new clash run containing all files in the selected directory, check
the ALL checkbox and click on the OK button.
OR
To merge selected files into the results of the latest clash run, select the required files,
uncheck the ALL checkbox and click on the OK button.

Resetting Clash Group Status

If all elements within certain Clash Groups have the same Status, the Status of each of
those Clash Groups can be set to the status of its elements. To update these clash group
features, proceed as follows:

1. Click on the Reset Group Status button.
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2. The message 'Reset Group Status to Worst Case Detail Status. Do you want to
Continue?' is displayed. The message box includes Yes and No buttons.

3. Click on the Yes button to reset the group status.

Resetting Clash Group Owner

If all elements within certain Clash Groups have the same Owner discipline, the Owner
disciplines of each those Clash Groups can be set to those of its elements. To update these
clash group features, proceed as follows:

1. Click on the Reset Group Owner button.

2. The message 'Reset Group Owner to Common Detail Owner. Do you want to
Continue?' is displayed. The message box includes Yes and No buttons.

3. Click on the Yes button to reset the group owner.

Deleting Unreferenced Data

When the OUTFITTING model has been substantially updated, the clash details remain in
the Clash Manager database although the item(s) they refer to have been removed. These
clash details, including their comments, can be removed from the Clash Manager database
as follows:

1. Click on the Delete All Unreferenced Groups, Elements and Comments button.

2. The message 'Are you sure that you want to remove all unreferenced Groups and
Elements?' is displayed. The message box includes Yes and No buttons.

3. Click on the Yes button to delete all groups and elements.

Deleting All Clash Data

At the end of a project all clash report data and history data can be removed from the
database. The configuration data and clash set definitions, check list and obstruction list all
remain. The remaining data is truncated to recover unused space in the Oracle Table
Space. To remove the data, proceed as follows:

1. Click on the Delete All Clash Data, including Comments and History button.

2. The message 'Are you sure you want to Delete All Clash Data' is displayed. The
message box includes Yes and No buttons.

3. Click on the Yes button to continue.

4. The warning message' This option deletes All Clash Data, Groups, Detail, History and
Comments. It cannot be undone! Are you really sure you want to continue?' is
displayed. The message box includes Yes and No buttons.

5. If you wish to delete ALL clash data, including comments, click on the Yes button.
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5.1 Main and Dropdown Menus

The Main Menu is displayed across the top of the Clash Manager form. Its options lead to
the following dropdown menus:

PD Clash Manager,

File Edit “ew Tools fdmin Help

L L N e B = B

5.1.1 File Dropdown Menu

The available options and their purposes are:

Save As Displays the standard saving form to enable the user to save the
data displayed in the Clash Manager form in: XML output, XML with
style sheet, CSV output, or tab-separated text output.

Save/Refresh Initiates a Savework in an active OUTFITTING DESIGN session, if
in a master DB, and initiates a Savework and a flush to the master
DB, if in an extract DB. If the Savework/flush is successful, a Save
operation is initiated in PE, and the data in the current form is
updated accordingly.

Properties Displays the current settings.

Filenames List of previously displayed P&IDs.
(one or more)

Exit Closes the Clash Manager form.

5.1.2 Edit Dropdown Menu
The available options and their purposes are:
Select All Option is not applicable to Clash Manager and is disabled.
Remove Selected Option is not applicable to Clash Manager and is disabled.
Remove All Option is not applicable to Clash Manager and is disabled.

Find Option is not applicable to Clash Manager and is disabled.
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5.1.3 View Dropdown Menu

The available options and their purposes are:

P&IDs

2D Objects

3D Objects
Clash Manager
Toolbar
Statusbar

Messages

Activates Ship Connectivity Manager.

Leads to the Ship Model Object Manager - 2D Objects form.
Leads to the Ship Model Object Manager - 3D Objects form.
Has been selected to activate Clash Manager.

Controls whether or not the tool bar is displayed.

Controls whether or not the status bar is displayed.

Controls whether or not the Messages window is displayed.

5.1.4 Tools Dropdown Menu
The available options and their purposes are:

Stop

Connect to
OUTFITTING
DESIGN Session

Connect to Oracle
Session

Clear 3D Display
Clash Check CE

Clash Report

Element Report

Option is not applicable to Clash Manager and is disabled.

Connects to a current OUTFITTING DESIGN session if either
OUTFITTING has been invoked after Clash Manager or the
connection has been lost by exiting and re-entering OUTFITTING.

Connects to Oracle session.

Clears the OUTFITTING 3D display.

Initiates the Clash Check CE process.

Leads to the following sub-menu:

Display Report  Displays the Clash Manager - Clash Report.
Clash Groups Displays the Clash Groups in the Clash Report.

Clash Detail Displays the Clash Detail in the Clash Report.

Use Filter Applies the filter criteria to the data displayed on
the Clash Report.

Set Filter Leads to the Clash Manager - Filter form.

Metric Sets limits to mm.

Imperial Sets limits to inches.

Leads to the following sub-menu:
Display Report  Displays the Element Report.

Use Filter Applies the filter criteria to the data displayed on
the Element Report.

Set Filter Leads to the Clash Manager - Filter form.
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Leads to a sub-menu of the five most recently used clash sets, from
which the required set is selected. The menu includes an Others
option that leads to the Clash Manager - Clash Sets Form, in which
other clash sets can be selected.

Leads to the Clash Manager - Clash Sets Form.
Leads to the following sub-menu:

Clash Groups The Clash Manager form Discipline List and
Chart shows Clash Groups.

Clash Detail The Clash Manager form Discipline List and
Chart shows clash detail.

Filter Chart Applies the filter criteria to the data displayed on
the Clash Manager form Discipline List and
Chart.

Leads to the Clash Manager Options Form.

5.1.5 Admin Dropdown Menu
The available options and their purposes are:

Model Object Manager Leads to Model Management Configuration form.

Configuration

Load Project Settings Loads current project settings.

5.1.6 Help Dropdown Menu

The available options and their purposes are:

Contents

About

Displays this Online Guide in a new window.

Displays the product version in a new window.

5.2 Clash Manager Form

The form displays summary data on current clashes and provides statistical information on
the total numbers of objects and controlled objects and how many of them are clash-free,
clashing, and not clash-checked. It is divided into three sections, the sizes of which can be
set by dragging their borders. The top left-hand section displays current and statistical data
in tabular format. The bottom left-hand section displays statistical information in bar chart
format. The right-hand section displays the current and, optionally, historical data, as a bar

chart.

Snapshots of data may be saved at appropriate milestones by selecting Track Changes at
the Clash Manager Options form.
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Main Clash Manager Form

FD Clash Manager
e [dt Wew Took Advn el

ek @l Al

Discigine UnAppioved Ponding | Conditional Appoved  Total  -0b
ADMIBESTRATOR S0 500
CIVILS PIPE
EQUIFMENT
HVAC
HSTRUMENTS
FAIFING ) i s i e
STRUCTURAL 10 10
SUFPORTS
UNALLOCATED
A00 400
Totds i '] '] 1 483
o x50
< 3| 0 %0
10 10
30 e
e | LMAPPROVED
an =+ 08 -
CONDITIONAL
o o 200 4- i . . 2o [l AROVED
o L3
150 150
(1.3 .13
I rect iz Crecied = e
s 05 [ CasnFres
Clashing
04 LS
=0 =
03 03
0 e e e
02 0z i é Ed 3 £ S s . ]
] - Fd g £ S
=l s = =1
E = é B 2 g =
o1 a1 4 & 5 2
= 5
T} oo Clah Groupa

5 Omele Connncion. M| POMS Desion Sessien | S0TR007

Dy ML12.0.0.Tee,

Top Left-hand Section

Each row of the table in the top left-hand section is dedicated to a discipline, the nhames of
which appear in the left-hand column. The table is divided vertically in two sections. The left-
hand section shows current data; the right-hand statistical data.

The columns in the left-hand section show the numbers of Approved, Unapproved, Pending
and Conditionally Approved clashes. The right-hand column shows the total number of
clashes for each discipline. The bottom row of the table shows the total numbers of clashes
for each category, and the grand total.

The columns in the right-hand section show, for each discipline, the number of 'Controlled
GTYPESs' (objects), and the numbers not checked, clash free and clashing. The headings of
the columns include an asterisk (*) to draw the users attention to the milestone date, which
is shown at the bottom of the discipline column. The bottom row shows the totals for each
category. The grand total is the total number of objects.

The bar charts in the Bottom Left-hand Section and in the Right-hand Section can be filtered
by using the pop-up menu and selecting ‘filter charts’, then double-clicking on disciplines in
this table. The affected disciplines are then shown in BLUE .

Bottom Left-hand Section

The bar chart in the bottom left-hand section displays graphically the data displayed in the
right-hand side of the table in the top left-hand section.
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Each bar represents a discipline (for a certain period). The height is proportional to the total
number of objects. Sections of the bars are colour-coded to show the numbers of Clash
free, Clashing and Not Clash Checked objects that make up the total. These default colours
may be changed by double-clicking the relevant bar or legend. The legend can be hidden by
selection at the popup menu, or moved by dragging with the mouse.

Right-hand Section

The bar chart in the right-hand section shows data for each discipline that has clashes. By
default, the current data is displayed. The last period, or the complete history, may also be
displayed, as selected at the popup menu.

Each bar represents a discipline (for a certain period). The height is proportional to the total
number of clashes. Sections of the bars are colour-coded to show the numbers of
Approved, Conditional, Unapproved and Pending clashes that make up the total. These
default colours may be changed by double-clicking the relevant bar or legend. The legend
can be hidden by selection at the popup menu, or moved by dragging with the mouse.

Chart filtering may be selected at the popup menu. When filtering is selected, disciplines
may be added to, or removed from, the chart display by double-clicking the discipline name
in the left-hand section of the form.

Popup Menus

Separate popup menus, displayed by clicking the mouse right-hand button, are available for
each section of the form. The options and their purposes are listed below.

Top Left-hand Section Popup Menu

The available options and their purposes are:

Clash Groups The list and chart show clash groups.
Clash Detail The list and chart show clash detail.
Filter Chart Enables the content of the chart to be filtered by double-clicking on

the discipline name.

Save As Displays the standard saving form to enable the user to save in: XML
output, XML with style sheet, CSV output, or tab separated text
output. The data is saved to file, but the chart graphic is not.

Bottom Left-hand Section Popup Menu
The available options and their purposes are:
Display History The chart shows the complete history of clashes.

Not Clash Checked Whether or not the chart includes numbers of objects that are not
clash checked.

Clash Free Whether or not the chart includes numbers of objects that are clash
free.

Clashing Whether or not the chart includes numbers of objects that are
clashing.
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Whether or not the legend for the bar chart is displayed.

Enables the content of the chart to be filtered by double-clicking on
the discipline name.

Displays the standard saving form to enable the user to save in: XML
output, XML with style sheet, CSV output, or tab separated text
output. The data is saved to file, but the chart graphic is not.

5.3.3 Right-hand Section Popup Menu

The available options and their purposes are:

Display History
UnApproved
Pending
Approved
Conditional
Show Label
Clash Groups
Clash Detail
Filter Chart

Save As

534 Clash Sets Form

The chart shows the complete history of clashes.

Whether or not the chart shows unapproved clashes.

Whether or not the chart shows pending clashes.

Whether or not the chart shows approved clashes.

Whether or not the chart shows conditionally approved clashes.
Whether or not the legend for the bar chart is displayed.

The list and chart show clash groups.

The list and chart show clash detail.

Enables the content of the chart to be filtered by double-clicking
on the discipline name.

Displays the standard saving form to enable the user to save in:
XML output, XML with style sheet, CSV output, or tab separated
text output. The data is saved to file, but the chart graphic is not.

This form is used to compile a list of all clash sets. It provides the content of the sub-menu
displayed by the selection of Run Clash Sets at the "Tools' dropdown menu.
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BN AVEVA Clash Manager - Clash Sets

Set Title Lazt Run Conmments By

28 Group_Check

44 LEICA-CLASH

265 MaAW Test Clash 2007/06/2914.21:41 martin,. ward

i MewClashSet

185 pipe

208 gp-clagh

168 zample 20070410 145229 reload files uma.mahesh

228 site-clash

26 Test_Equi

124 Testclash

125 Testmodchecklist

247 uma.mahesh /MOMIPE

< >
Edit... | Delete | Copy... | Add. . | Run Dezclash...

The main area of the form is occupied by a text box that lists current details of all clash sets.

A Details button available to users (members/supervisors of all disciplines) leads to the
‘Clash Manager - Clash Set Data' form.

The following buttons are available to the Supervisor of the Administrator discipline:

Add

Delete

Copy

Edit

Run Desclash

Dismiss

Used for creation of a new clash set. Leads to the 'Clash Manager
- Clash Set Data' form, pre-populated either with the 'Default’ clash
set, or with default settings derived from environment variables.

Deletes the highlighted clash set.

Creates a copy of the highlighted clash set, but with a new set
number.

Used to modify details of the highlighted clash set. Leads to the
'Clash Manager - Clash Set Data' form, pre-populated with details
of the clash set.

Initiates clash checking for the highlighted clash set. Leads to the
'Run Clash Set' form.

Closes the form.

In addition to those buttons the following options are available on the popup menu. Right
click to display the options.

Revert Clash Run

Displays details of the previous clash run.
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Display Counts When this option is checked, the number of clashes generated will
be displayed on the Clash Sets form.

Refresh Refreshes the form contents.

Clash Set Data Form

This form is used to enter details of a new clash set, or to edit details of an existing clash
set.

Clash sets can be defined directly, copied from an existing clash set, or created from the
‘Default’ template clash set, if defined.

B} AVEVA Clash Manager - Clash Set Data

Set [326 Title | MDE [ MOMIPE
Comment |
Obstruction List | Exclude List | Check List
add.. || Delete | add.|.] Delete Add.. | .| Delete

Extents lLimits ] Histnl_l,l]

Owerlap |2 Unitz
" Inch

Gap |D Reszet to Diefault Values|
i+ MM

Clearance |D

Mocheck "nesw"

it |STHU EQUI HAMG new'’ Tolerance |0
[ lgnare Connections Cancel
™ Map Overids " Branch & Check - E‘lﬁggﬁgl

[~ Check ADD f+ Branch B Check Items Only

Notes on 'Default’ Clash Set: The defaults on this form for new clash sets can be defined
by a 'Default’ clash set, or by environment variables. The 'Default' clash set method is
recommended because using environment variables in a windows environment is
particularity user-unfriendly and does not promote re-use of the default data between users
of the same project. Also, users may have different environment variables, or access the
common database from different installations of the software, served from different file
servers.

The 'Default’ clash set provides default values for New Clash Sets created via the ADD
option on the Clash Sets form and also when a Personal Clash Set is created automatically
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during the Clash Check CE process. The 'Default’ clash set method enables items in the
Check, Obstruction or Exclude Lists to be set as defaults, whereas there is no existing
capability to provide default Check, Obstruction or Exclude Lists through the use of
environment variables.

To use the 'Default’ clash set method, the Administrator must first create a Clash Set entitled
‘Default’ containing the required default values. When the 'Default’ clash set exists, the ADD
option will implicitly perform a copy of the 'Default’ Clash Set. Note that if environment
variables exist, they will be used after the initial values have been set through copying the
‘Default’ Clash Set. Subsequent alteration of environment variables affect the '‘Default’ clash
set when it is used for new clash sets.

The environment variables and typical default values are as follows:
PCLAM_DEFAULT_BCHECK=A|b
PCLAM_DEFAULT_IGNORECONNECT IONS=TRUE | False
PCLAM_DEFAULT_MAPOVER=TRUE|]False
PCLAM_DEFAULT_CHECKADD=TRUE | False
PCLAM_DEFAULT_TOLERANCE=0
PCLAM_DEFAULT_NOCHECKWITHIN=""STRU EQUI HANG"
PCLAM_DEFAULT_CLEARANCE=2
PCLAM_DEFAULT_GAP=0
PCLAM_DEFAULT_OVERLAP=0

Notes on Personal Clash Set: During the Clash Check CE process, the form is used to
enter details of a personal clash set. This clash set is used for EVERY clash check of the CE
in the particular MDB and, consequently, the default values should be used wherever
possible. The Title and MDB fields are read-only. The Check List is automatically
completed with details of the group element of the CE. Entries can be made in the
Obstruction and Exclude lists, but it is recommended that neither is populated. In these
circumstances the Obstruction list defaults to ALL and the Exclude list remains empty.

The form includes the following items:

Set Generated automatically as a unique index for the clash set.
Cannot be changed.

Title The title associated with the clash set. Can be changed from
‘Default’ or entered if the field is bank.

MDB The name of the Mdb to be used within OUTFITTING.

Comment Any comment to be associated with the clash set.

Obstruction List A list of named elements or wildcards covering a range of

elements and their attributes from within the specified Mdb that
form the Obstruction List. The popup menu option 'Evaluate'
(see below) may be used to verify the resultant Obstruction list
is as required. Note that for this evaluation the Exclude List is
not used in deriving the resulting Obstruction list.

© 2007 AVEVA Solutions Ltd 5:9 12.0



AV=VA

Clash Manager User Guide

Exclude List

Check List

Add, |...] and Delete

Extents

Limits

History
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Reset to Default Values

Nocheck Within

"new" Tolerance

MAP Override

Ignore Connections

Branch Check
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A list of named elements or wildcards covering a range of
elements and their attributes from within the specified Mdb.
This ‘Exclude List’ specifies members that are to be excluded
from the Obstruction list. . The popup menu option 'Evaluate’
(see below) may be used to verify that the resultant Exclude
list is as required.

A list of named elements or wildcards covering a range of
elements and their attributes from within the specified Mdb that
form the ‘check list’ for the clash detection. The popup menu
option 'Evaluate' (see below) may be used to verify that the
resultant Check list is as required.

Note: Where minimal clashing activity is expected 'SITES' (or
wildcards returning Sites) should be entered into the
Checklist. Where much activity is expected, individual
ZONEs (or wildcards returning Zones) should be
entered into the Checklist. This ensures the best mix of
parallel Clashing and Loading.

These buttons, below each of the lists, respectively have the
same functions as the 'Add’, '‘Browse' and 'Delete’ options of
the popup menu (see below).

The items on this tab are used to specify the overlap, gap and
clearances.

The items on this tab are used to specify the co-ordinates of
the space occupied by the clash set.

The items on this tab show the dates and details of previous
clash runs.

Used to select either mm or inch as the dimensional unit.

Used to reset the values specified for Overlap, Gap and
Clearance to the default values.

No clash checks between items within the same hierarchy of
given Types.

Any clash that is between the same two elements of an
existing clash and is within this tolerance is NOT treated as a
new clash.

If checked, causes desclash to ignore errors in the Spatial
Map, which would otherwise abort the desclash run.

Ignore Connections at steelwork Junctions.

Used to select either 'A Check' or 'B Check'. The default is 'B
Check'.

‘A Check' checks for clashes within an item. This option is not
normally recommended.

'B Check' checks for clashes between different items. This
option is normally used.

© 2007 AVEVA Solutions Ltd

5:10 12.0



_AV:VA Clash Manager User Guide

5.3.6

GUI

Check ADD Passes the ‘Check ADD’ option to desclash. This causes the
Clash Check List to be automatically added to the Obstruction
List.

OK Confirms selections made and closes the form.

Cancel Ignores selections made and closes the form.

Note on modified checklist items option: some OUTFITTING ADMIN options, including
merge (compress) and reconfigure, flag every element as having possibly changed
geometry. To obtain maximum benefit from ‘Clash Check Modified Elements Only’ a full
Clash Check will need to be executed after use of these options.

Popup Menu

A popup menu is available from the Obstruction List, Exclude List and Check List panes
by right-clicking the mouse.

B\ AVEVA Clash Manager - Clash Set Data

Set [326 Title |
Caommert |
Obstruction List | Exclude List
Add
Browse
Add ... | | add..|.]  Delete

The available options and their purposes are as follows:

Add For adding items or expressions to the particular list. Leads to the
relevant 'Add List Item' form.

Edit For editing expressions. Leads to the relevant 'Edit List Item’ form.

Browse For adding elements derived from the OUTFITTING hierarchy. Leads to

the '‘Browse OUTFITTING Model' form
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Delete Deletes the selected item from the list. (The item is not deleted from the
OUTFITTING model.)

Evaluate For viewing the overall list when its wildcards are expanded. Leads to the

‘Evaluate’ form, which displays a consolidated listing of the results of
querying the OUTFITTING model and expanding the expressions in the
particular list.

Note: Double-clicking an item in the any of the lists leads to the '‘Browse OUTFITTING
Model' form if the item is an element name, or leads to the 'Edit List Item' form if the
item is an expression or simply a GTYPE.

Add List Item Form

This form is used to add simple items and expressions to the Obstruction, Check and
Exclude lists on the 'Clash Set Data' form. (The name of the form includes the name of the
particular list.)

: PD Clash Manager - Add Obstruction List Item E|

|£ENI -15B-Fwd

Cancel

The form includes the following items:

Unnamed field For entry of the item name or the expression.

OK Closes the form and updates and includes the item or expression in
the Obstruction, Check or Exclude list on the Clash Set Data form.

Cancel Closes the form and ignores any changes made.

Note: For the syntax of the elements and their attributes refer to Notes on Element Rule
Syntax.

Note Regarding Modification of Existing Expressions: Prior to the introduction of
expressions to the lists, the syntax was limited to wildcards applicable to item names. For
example, <wildcard> of <owner>, which if entered as */M of WORL would have added all
Items under WORL which begin with /M. This would now be written as an
<expressionStypeB>: name like <wildcard> of <owner>, which would be entered as name
like ~/M of WORL. Refer to Notes on Element Rule Syntax.

Edit List Item Form

This form is used to edit expressions and simple items in the Obstruction, Check and
Exclude lists on the 'Clash Set Data' form. (The name of the form includes the name of the
particular list.)
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B\ PD Clash Manager - Edit Obstruction List [tem E'

|£|:w| 15B-Fw

Cancel

Unnamed field

OK

Cancel

The form includes the following items:

can be edited, as required.

Initially includes selected record from the particular list. This record

Closes the form and updates the record in the Obstruction, Check

or Exclude list on the Clash Set Data form with the edited version.

Syntax.

Browse Model Form

B} AVEVA Clash Manager - Browse PDMS Model

Closes the form and ignores any changes made.

Note: For the syntax of the elements and their attributes refer to Notes on Element Rule

This form is used to add items to the ‘Obstruction’, '‘Check' and 'Exclude’ lists on the 'Clash
Set Data' form and also to add items to the Tracking Selection Rules on the GTYPE/
Tracking tab of the Clash Manager Configuration form.

%]

MDE | /MOMIPE

=

= & woRL

+-g SITE /CIVI-154
-8 SITE /CiVI-158

Eunf - OME /ClV|-158-Fuw
+-g SITE /CIvI-15C
+-g SITE /CIVI-150
+-g SITE /CIVIFOUND
+-§g SITE /CWIMIST
+-§g SITE /CWI-TRENCHES
+-$8 SITE /ELEC-154

|Dbstruction List

|;c|\.f|-1 EB-Fwf

Add Refrazh

Dismnizz |
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The form includes the following items:

MDB For selection of the Mdb associated with the Tracking Selection
Rules at the Clash Manager Configuration form. Otherwise read-
only.

Pane displaying the For selection of the item to be added

OUTFITTING ) .

hierarchy Note: A OUTFITTING DESIGN session must be active when a
selection is being made.

Dropdown list For selection of Obstruction, Check or Exclude list at the 'Clash Set

Data' form. Otherwise not used.

Un-named text box Shows name of selected item. Direct entries can be made, if

required.
Add To add the selected item to the form that called up this form
Refresh To update the displayed data
Dismiss To close the form

5.3.10 Evaluate Form

This form displays the results of expanding the expressions in the Obstruction, Check or
Exclude list on the 'Clash Manager - Clash Set Data' form, or the results of expanding the
Tracking Selection Rules on the 'Clash Manager Configuration form - Gtype/Tracking tab'.
The form includes the following items:

j PDClash Manager - 1 ltem @

Obstruction

Remove Dizmizs
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For viewing the items and selecting any to be removed from the
particular list, the name of which is shown at the top of the pane.

Removes the selected items from the expanded list and adds the
<!> NOT wildcard to the item(s) in the particular list.

Closes the form.

5.4 Run Clash Set Form

BN Run Clash Set 265

X

[P Test Clash

(" Branch & Check

{* Branch B Check

Clash Run Comments

[v MAP Overide v lgnare Connections
Modified Checklist
[v Check ADD I ltems Oy

11:01:28 W aiting for completion of CheckList item 1 af 5.

| Cancel [

This form provides facilities to:

1. View and, as required, modify the default characteristics of a clash set,
2. Initiate a clash run and
3. View the progress made during the run.

The form includes the following items:

Branch Check Type

MAP Override

Check ADD

Ignore Connections

Used to select either 'A Check' or 'B Check'’ for this run. The
default is set in the data associated with the Clash Set. 'A
Check' does a full primitive by primitive check of every
component within a branch. This option is not normally
recommended. 'B Check' is a simplified check which ignores
clashes between certain pairs of components within the
branches. This option is normally used.

If checked, causes desclash to ignore errors in the Spatial
Map, which would otherwise abort the desclash run. The
default is given in the Clash Set data.

Passes the ‘Check ADD’ option to desclash. This causes the
Clash Check List to be automatically added to the Obstruction
List. Any existing contents of the Obstruction List are ignored.
The default is given in the Clash Set data.

Ignore Connections at steelwork Junctions. The default is
given in the Clash Set data.

© 2007 AVEVA Solutions Ltd
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Modifed Checklist Sets the date of the last run of the selected Clash Set and
Items Only each check-item tested for a change in GEOMetry since that

date. Items that have changed or that have not been checked
before will be checked as usual. Items that have not changed
will be recorded and any previously found clashes will be
recovered and incorporated into the current clash run.

Clash Run Comments  Allows the user to enter comments prior to the clash run..

Progress bar and During the clash run, the bar graphically indicates the
adjacent indications percentage progress.

During the clash run, a 'Loading item number' message
appears above the bar and is continually updated.

During the clash run, continually updated numbers below the
bar show 'Total clashes processed’ and a 'Significant
Elements'.

During the clash run, a 'Heartbeat' at the bottom right-hand of
the form shows that the process is in operation.

If the clash update cannot be completed, an error message

appears.
Run To initiate a clash run
Cancel To abort a clash run

As each item on the CheckList is processed by desclash, the data is loaded into the Clash
Manager Database while at the same time desclash continues processing subsequent
CheckList items.

Clash Report

Reports on clashes are presented in a separate window that includes a main menu with
dropdown menus, a toolbar and a status bar. A popup menu is available for both reports.

There are two types of report, namely, Clash Groups and Clash Detail. Both reports are in
tabular format. The reports appear in separate panes, and either or both can be displayed.
The pane that is 'Active’ has a dark blue title bar; the 'Inactive’ pane has a grey title bar.
Scroll bars are available for access to data that overspills the panes. Details of the current
filter can be displayed in a separate pane, titled Filter, at the bottom of the window.

When reports are produced as a result of a Clash Check CE operation, both Clash Groups
and Clash Detail reports are automatically filtered by a temporary filter that includes all filter
options, with the element name filter set to the appropriate Group Element of the Current
Element. The reports show all clashes relating to the Group Element. The automatic
production and filtering of the reports for a Clash Check CE, can be enabled or inhibited at
the 'Clash Manager Options' form.

Example Clash Report
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PD/Clash Manager, - Clash Report - Filtered

A o KKK 133X 3 1 333 3K 3 36 X 3K 33 3 X X XK X X

File Edt View Tools Help
EHOod «x2 7 EEBOMN 7vHE
Clash Groups
Group Disciplini Status Level Type Group Eleml Discipline GType 1 Group Elem2  Discipli GType 2| C
1821 |FIFING RS HH  CLa  /PIPE-154:AG PIPING ZONE | /PIPE-154B | PIFING ZONE | set discipling: PIPING: [Disc] | me
1822 |FIFING DEEREEE HH | CLs  APIPE-1SA-E PIPING ZONE | /PIPE-1540 | PIFING ZOME | set discipline: PIPING: [Disc] | me
1823 |FIFING IEEEEEA HH  CLa APIPEQISAE PIFING ZONE | /PIPE-18ARY | FIFING ZOME | set discipling: PIPING: [Disc] | me
1824 |FIFING DEEEEE HH | CLs  APIPE-1SA-B PIPING ZONE | /PIPE-154PS |PIFING ZOME | set discipline: PIPING: [Disc] | me
1825 |FIFING IEEEEEA HH | CLa  /PIPE-15AAG PIPING ZONE | /PIPE-15APS | PIFING ZOME | set discipline: PIPING: [Disc] | me
1826 |FIPING DEEEEE HH | CLa  APIPE-1SA-0 FIPING ZONE | /PIPE-154PS | PIPING ZOME | set discipline: PIPING: [Dise] | me
1827 |FIFING RS HH | CLA  /PIPE-1SAPS  PIFING ZONE | /PIPE-18ARY | PIFING ZOME | set discipline: PIPING: [Disc] | me
1828 |FIFING EEEEE HH  CLA  APIPE-1SAAG PIPING ZONE | /PIPE-154-0 | PIFING ZOWE | set discipling: PIPING: [Disc] | me
1829 |FIPING RSN HH | CLe  /PIPE-15A4G PIPING ZONE | /PIPE-154-RY | PIFING ZOME | set discipline: PIPING: [Disc] | me
1830 |FIFING EEEEEER HS  CLa APIPEA1SANT  PIFING ZONE | /PIPE-T1BANT | PIFING ZOME | set discipling: PIPING: [Disc] | me
1831 |FIFING DEEEEE s CLs  APIPE-1SA-0 PIFING ZONE | /PIPE-154T |PIFING ZOME | set discipline: PIPING: [Disc] | me
1832 |FIPING IEEEEER HS  CLa  /PIPE1SANT  PIPING ZONE | /PIPE-1BANT | PIFING ZOME | set discipline: PIPING: [Disc] | me
1833 |FIFING DEEEEE H:  CLs  APIPE-1SANVT  PIFING ZONE | /PIPE-154T | PIFING ZOME | set discipline: PIPING: [Disc] | me
1834 [PIFNG 5 IR Hs  CL:  /PIPEA1SANT  PIFING ZOME | /PIPE-1BANT | PIFING ZOME | Status changed to &pproved | me
1835 |FIFING RS HS  CLs APIPEA1SARY PIPING ZONE | /PIPE-15ANT | PIPING ZOWE | set discipling: PIPING: [Disc] | me
1836 |FIPING RS HS | CLe  /PIPEA1SANT  PIFING ZONE | /PIPE-1544T | PIFING ZOME | set discipline: PIPING: [Disc] | me
1837 |FIFING EEEEEER HS  CLa APIPEA1SANT  PIFING ZONE | /PIPE-T1BANT | PIFING ZOME | set discipling: PIPING: [Disc] | me
1838 |FIFING DEEEEE H: | CLs  APIPE-1SANWT  PIFING ZONE | /PIPE-154T |PIFING ZOME | set discipline: PIPING: [Disc] | me
1839 |FIFING IR HS  CLe  /PIPE-1SARY PIPING ZONE | /PIPE-1BANT | PIFING ZOME | set discipline: PIPING: [Disc] | me
1840 |FIFING DEEEEE H: | CLs  APIPE-1SANVT  PIPING ZONE | /PIPE-154T | PIFING ZOME | set discipline: PIPING: [Disc] | me
1841 |FIFING RS HS | CLe  /PIPE1SANT  PIFING ZOME | /PIPE-1BANT | PIFING ZOME | set discipline: PIPING: [Disc] | me
1842 |FIFING EEEEE HS  CLA  APIPEA1SANT  PIPING ZONE | /PIPE-15ANT | PIPING ZOWE | set discipling: PIPING: [Disc] | me
1843 |FIPING RSN HS | CLe  /PIPE-1SARY PIPING ZONE | /PIPE-1544T | PIFING ZOME | set discipline: PIPING: [Disc] | me
1844 |FIFING RS HH  CLa APIPEQ1SAY PIPING ZONE | /PIPE-18AY | PIFING ZOME | set discipling: PIPING: [Disc] | me
1845 |FIFING DEEEEE HH | CLs  APIPE-1SAY PIPING ZOMNE | /PIPE-154% | PIFING ZOME | set discipline: PIPING: [Disc] | me
1846 |FIFING [Unkngwn | 1l CL&  /PIPE-1845L  PIPING ZONE | /PIPE-1BASL | PIFING ZOME | set discipline: PIPING: [Disc] | me
1847 |FIFING DR CLa  /PIPE-154-5L  PIPING ZONE | /PIPE-154-5L |PIFING ZOME | set discipline: PIPING: [Disc] | me
1848 |FIFING IEEEEER G TOU /PIPE-1SASL PIPING ZOME | /PIPE-15A5L | PIFING ZOME | set discipline: PIPING: [Disc] | me
1849 |FIFING RS HS  CLa APIPEA1SASSL PIPING ZONE | /PIPE-15A-5L | PIFING ZOWE | set discipling: PIPING: [Disc] | me
1850 |FIFING [Unknown | 1l CLa  /PIPE-154-5L  PIPING ZONE | /PIPE-154-5L | PIFING ZOME | set discipline: PIPING: [Disc] | me
10m1 | IEIENE DR L Cle | PIPFOIRACW PIPING FNNF JPIRFIRAST [ RIRING FAME | <at disrinne: PIRING: Mier] ;,— ud
=
WPD Clash M anager - Clash Report - Filtered 483 Clash Groups, 0 Clagh Details 9 Oracle Connection POMS Design Session | 12/03/2007

Clash Groups Report

Each row of this report is dedicated to a clash group. The data in the columns is identified by
the column headings, namely,

Group discipline, status, level and type
Group Element 1 discipline and GTYPE
Group Element 2 discipline and GTYPE
Group comments, user, co-ordinates, and when created.

Note: The GTYPE column shows the Gtype of the actual physical clash, not necessarily

the Gtype of the element.

The width of a column can be set by double-clicking on the column heading, or by dragging
the column edge to the desired position. Double-clicking toggles the width between that of
the heading and that of the widest data item in the column.

Columns at the left-hand side of the Discipline and Status columns display a Spanner
(wrench) icon when the value has been manually set. A blank signifies that the value has
been automatically set. The principle purpose of this icon is to enable the report records to
be sorted into manually and automatically applied values of discipline and/or status.

The left-hand column shows the status of the group, as follows:

Approved

Unapproved
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= Conditional

GUI

Fields in the report are colour-highlighted. The colours used and the background colour can

be set at the Clash Manager Options form. Typical colour-coding is as follows:

YELLOW Indicates the owner discipline, and if appropriate, highlights the
element which belongs to the discipline

RED UNALLOCATED discipline

CYAN Change highlighting

GREEN Value automatically set

ORANGE Value manually set.

Clash Detail Report

Each row of this report is dedicated to an individual clash within the group(s) selected in the
Clash Groups report. The structure of the report, column one indications and field colour-
coding are as described for the Clash Groups report. At the right-hand side is an additional

column for 'Remarks' that are derived from the 'Clash Properties' form.

Note: In both reports, Clash Level is abbreviated as follows:

Abbreviation Clash Level Description

HH Hard/Hard
HI Hard/Insulation (or Insulation/Hard)
HS Hard/Soft (or Soft/Hard)

1] Insulation/Insulation

IS Insulation/Soft (or Soft/Insulation)
SS Soft/Soft
NP Not Proven

Filter Pane

£atvew e —— S s e e P TR ST P RN TE I i oy
X 1840 |PIFING RS HS | CLA | /PIPEA1SANT  PIPING ZOWE | /PIPE18AVT | PIRING ZOME | set discipling: PIPING: [Disc] | me s
< b3
Filter
Clazh Report Filter Inactive A
Filter applied to Group
Clash &pproval Show Al Approval States
Clash Type Shawy Al Clash Types
Clash Lewvel Show All Clash Levels
Dizcipline Show &l Clash Disciplines
bkt S Dizcipline Show All Clash Areas
Clash Set Sheow All Clash Sets
Group/|ndex
Element [Match Caze] v
WPD Clash b anager - Clazh Report 489 Clash Groups 9 Oracle Connection PDMS Design Session | 12/09/2007
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This pane displays the filter criteria and values currently set to limit the data shown on clash
reports. The information appears in a two-column table showing criteria in the left-hand

column and values in the right-hand column.

551 Popup Menu

The options available in the popup menu depend on the number of records selected, the
report in which they are selected, whether the Clash Details report is displayed alone, and
on the security options set by the Administrator. The options, their availability and functions

are as follows.

PDClash Manager - Clash Report

File Edit Wiew Tools Help

=502 v x? ¥ EE|

Group Dizcipling Status Level Tyg
§ 1 Display Clash Detail EE
X 1 Clash Group Properties. .. oL
X 1 approve L
X 1 Conditional L
§ 1 Pending EE
¥ 1 Views Group 1540 CL
% 1 Set Design CE JPIPE-15A-YT (x) cL

1 CL
§ 1 Claim Clashing Elements oL
X Flush Clashing Elements oL
w1 Unclaim/Tssue Clashing Elerments oL
. 1 Set Clash Group Filker ... CL
§ 1 Enable Clash Group Filker EE
¥ 1 saveds.. CL
K ez EEmEY T e | CL
o 1090 DIDIRI I uc r.

OPTION WHEN AVAILABLE

(Selection in Report)

Display Clash Detail One or more groups in Clash

Groups
Clash Group Single clash group in Clash
Properties Groups

Clash Properties

Edit Clash Groups  Multiple groups in either

Kkok_kkk

Assign Owner
Discipline (Disc
Name)

Approve

Single clash in Clash Detail

Single group in Clash Groups

One or more in either

FUNCTION

Displays associated clashes in
Clash Details report.

Leads to the Clash (Group)
Properties Form.

Leads to Clash Properties form.

Leads to the Edit Clash Groups
Form.

Sets discipline required to resolve
clash.

Sets status to Approved.
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Conditional One or more in either
Pending One or more in either
Unapprove One or more in either

View Group(s) One or more groups in Clash
(number) Groups

View Clash(es) One or more clashes in Clash
(number) Detall

Set Design CE (first One or more in either
element name)

Set Design CE One or more in either
(second element

name)

Claim Clashing One or more in either
Elements

Flush Clashing One or more in either
Elements

Unclaim/Issue One or more in either

Clashing Elements

Set Clash Group One or more groups in Clash
Filter Groups

Set Clash Detail One or more clashes in Clash
Filter Detail when displayed alone

Enable Clash Group One or more groups in Clash
Filter Groups

Enable Clash Detail One or more clashes in Clash
Filter Detail when displayed alone

Save As One or more in either

GUI

Sets status to Conditional.
Sets status to Pending.
Sets status to Unapproved.

Displays the selected group(s) at
the OUTFITTING 3D display.

Displays the selected clash(es) at
the OUTFITTING 3D display.

Sets the selected item to be the
OUTFITTING Current Element.

Sets the selected item to be the
OUTFITTING Current Element.

Extracts the selected item in the
OUTFITTING hierarchy and brings
it to the wuser's OUTFITTING
workspace.

Saves the OUTFITTING changes
to the master model.

Issues the OUTFITTING changes
to the master model.

Leads to the Clash Manager -
Filter Form.

Leads to the Clash Manager -
Filter Form.

Applies the filter criteria to the data
displayed.

Applies the filter criteria to the data
displayed.

Saves the Active pane.

Note: Some of the options above will not be available if the User has insufficient access
rights, as set by the Administrator. Typically this may include Assign Owner

Discipline, or Approve.

55.2 Main Menu

The Main Menu is displayed across the top of the Clash Reports window. Its options lead to

the following dropdown menus:

© 2007 AVEVA Solutions Ltd 5:20

12.0



_AV:VA Clash Manager User Guide

GUI

PD Clash Manager - Clash Report
File Edit Wew Tools Help

L1 s o8 4 s " o | FE

5.5.3 File Dropdown Menu

The available options and their purposes are:

Save As Displays the standard saving form. This enables the user to save
information in the report as follows:

(Current Pane) Comma Separated (*.csv)
(Current Pane) Tab Separated (*:txt)
(Current Pane) XML (*.xml)

(Current Pane) XML & Stylesheet (*.xml)
Consolidated XML Report (*.xml)
Consolidated HTML Report (*.html).

The first four options (Current Pane) save information, in the
stated format, from the Clash Groups report or Clash Detail
report, depending on which pane is active.

The final two options save information from both Clash Groups
and Clash Detail reports and from the filter pane. The information
is presented as a Consolidated Report.

The xml version of the Consolidated report refers to a common
style sheet supplied with Clash Manager. The HTML version is a
result of processing through this style sheet. Applying the style
sheet before output, resolves all problems regarding viewing,
saving, copying or emailing, as the HTML version is a self-
contained file.

When the 'Save' button on the Standard Saving form is pressed,
a 'Report Comments' dialog box is displayed. This dialog box is
for entry of any comments that are to appear at the start of the
consolidated report.

Refresh If Clash Groups are displayed, refreshes the groups with the
current filter and clears the Clash Detail report.

Note: The 'Auto Display Clash Detail' option on the Preferences
tab of the Clash Manager Options form is set to False.

If Clash Detail alone is displayed, refreshes Clash Detail using
the current filter.

Close Closes the window.
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5.5.5

5.5.6

5.5.7

GUI

Edit Dropdown Menu

This menu operates on the Active pane. The available options and their purposes are:

Select All Selects all tabulated items in the report. Is greyed-out if the number
of records in the active pane exceeds the Large Transaction>
Warnings>Claim/Flush/Issue/Edit/Select All setting at the 'Clash
Manager Options' form.

Remove Selected Removes the selected items from the report.

Note: Operations on all clashes in the active pane, such as
display, or approve are still applied to the removed items.
They are only removed from the active pane.

Remove All Removes all items from the report.

Find Leads to the standard 'Find' dialog box.

View Dropdown Menu

The available options and their purposes are:

Clash Groups Controls whether or not the Clash Groups pane is displayed.
Clash Detail Controls whether or not the Clash Detail pane is displayed.
Filter Controls whether or not the Filter pane is displayed.
Toolbar Controls whether or not the tool bar is displayed.

Status Bar Controls whether or not the status bar is displayed.

Tools Dropdown Menu

The available options and their purposes are:

Clash Check CE Leads to Clash Manager - Clash Set Data Form.

Set Filter Leads to the Clash Manager - Filter Form.

Enable Filter Applies the filter criteria to the data displayed on the Clash
Reports.

Clear 3D Display Clears the OUTFITTING graphics display.

Clear 3D Labels Clears the Clash Group/Index Labels on the OUTFITTING
graphics display.
Settings Leads to the Clash Manager Options Form.

Help Dropdown Menu

The available options and their purposes are:

Contents Displays this Online Guide in a new window

About Displays the product version in a new window.
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55.8 Tool Bar

When selected for display, the toolbar appears under the Main Menu. The icons and
purposes of the buttons are as follows:

EMRun Clash Set 25

|l:hsl'i Manger Testing
" Branch & Check [+ MAF Ovenide [+ lgnose Connections
@ Bianch B Check W Check ADD P

Elements referenced in the Selected Clashes are added to the OUTFITTING
Drawlist.

Sets Owner Discipline of selected records to Discipline of First element.

Sets Owner Discipline of selected records to Discipline of Second element.

L e © [§

Sets status of selected records to Approved.

# Sets status of selected records to Unapproved.

)

Sets status of selected records to Pending.

ha,

Sets status of selected records to Conditional.

E

Clears the OUTFITTING graphics display.

bl

Clears the Clash Group/index Text Labels on the OUTFITTING graphics display.

If Clash Groups are displayed, refreshes the groups with the current filter and
clears the Clash Detail report.

If Clash Detail report alone is displayed, refreshes the Clash Detail using the
current filter.

<)

-3

Finds selected data on the current report.

<

Applies the filter criteria to the data displayed.

© 2007 AVEVA Solutions Ltd 5:23 12.0



_AV:VA Clash Manager User Guide

5.5.9

5.6

5.6.1

GUI

%{ Leads to the Clash Manager - Filter Form.

% Displays the filter pane.

Note: Some of the icons above will not be available if the User has insufficient access
rights, as set by the Administrator.

Status Bar

When selected for display, the status bar appears across the bottom of the window.

Il 1 lAzh et Shirw &l 1 lazh Seks
WPD Clash Manager - Clash Report 489 Clazh Groups % Oracle Connection FDMS Design Session | 12/09/2007

It includes information on the:

filtered or not filtered status of the display (the example shows filter “Area 15B”)
number of objects displayed,

Oracle connection status,

OUTFITTING status,

date.

Filter Form

Form Usage

This form is used to restrict the data displayed on the Clash Report and Element Reports.
All of the filtering facilities are available for the Clash Report, but when the form is used for
the Element Report, the facilities are restricted and the unavailable facilities are disabled
and shaded out. The standard filtering (on the Filter tab) and the advanced filtering (on the
Advanced tab) can be switched on or off separately for the Clash and Element reports.

Users may save filter settings as named filters. This enables you to save and quickly
retrieve commonly used filters without having to reset the filter options each time.

The facilities available for the Element Report are as follows:

On the Filter tab -
e Approval State
« Discipline
« Project-defined field (default Areacode)
* Element Wildcards
On the Advanced tab -
* Project-defined field (default Class)
* Project-defined field (default Priority).
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AVEVA Clash Manager - Filter

Filker
Filter: Unnamed
Basic T Advanced ]
Approval State
W Anoroved Diizcipline | M5 Digcipline
P [ ADMINISTRATOR . query MMS Discipline
M Un4pproved CIVILS FIFE
[¥ Pending [¥] EQUIPMENT
v Conditional HWAC
v [#] INSTRUMENTS
PIFIMG
STRUCTURAL
Clazh T
A YRS [ SUPPORTS
W Clash UNALLOCATED
¥ Clearence
[+ Touching
Clash Lewel he 2l
[ Hard/Hard Clash Get
[v Hard/Insul ClazhSet
W Hard/Saft Maw! Test Clash
[v Inzulfnzul sample
[v Insul/Soft
[v Soft/Soft
[w Mot Praven
[Filter Discipline Dwner/Els1/Ele2 |
Reset W Al Mixed Disciplines Only [ v Al
Element wildcards
Groupslndes wildeards | | CE
[¥ Enahle Filker [v tatch Caze (] 4 Cancel

Form Description

The main area of the form is occupied by two tabs, named Basic and Advanced which are
described below.

At the top of the form is the option to save and open named filters accessed from the Filter
dropdown menu.

New Creates a new filter by resetting all filter criteria to their default value.

Open Opens selection form of existing saved filters (if any). Select the
desired filter and click on open to open the filter.

Save Saves the current named filter. If the filter is unnamed, you are
prompted to give it a name.

Save As... Prompts you to save and name the current filter.

Delete Deletes the current named filter. You are prompted to confirm deletion.
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The following items are at the bottom of the form:

Enable Filter
OK

Cancel

Enables/disables the filter.

Accepts the recently entered filter characteristics and closes the
form.

Ignores any recently entered filter characteristics and closes the
form.

The items on the Basic tab are as follows:

Approval State

Clash Type

Clash Level

Reset

Discipline list with a
checkbox for each
listed discipline.

'Filter' dropdown list
and All checkbox
below the Discipline
list.

Mixed Disciplines
Only

Project-define (default

Areacode) list with a
checkbox for each
item.

All checkbox below the

list.

Clash Set list with a
checkbox for each set.

Used to select the states of clashes to be included in the report.
At least one must be selected. Approval Status are APPROVED,
UNAPPROVED, PENDING and CONDITIONAL and CLASH
FREE. Note that many Clash Status may be created which have
one of the aforementioned states. Status may be filtered using
the Advanced Filter.

Used to select the type(s) of clashes to be included in the report.
At least one must be selected.

Used to select the levels(s) of clashes to be included in the
report. At least one must be selected.

Checks all checkboxes and blanks all text fields on the tab. Used
mainly to check all checkboxes in the above sets.

Used to select the discipline(s) of clashes to be included in the
report. Any or specific disciplines can be selected at their
checkboxes. For all disciplines use the All checkbox. Repeated
use of the All checkbox will turn on or off all disciplines.

The 'Filter' dropdown list defaults to the report being filtered to the
clash owner. The other options enable discipline filtering for either
of the clashing elements and the owner. The 'All' checkbox is
used to check all disciplines.

Used to select clashes between elements having different
disciplines, or when only one discipline is selected, clashes within
that discipline only.

Used to select the areacodes of clashes to be included in the
report. For all codes use the All checkbox.

Note: The data selected by the Project-defined field is set by the
Administrator.

Used to select the clash sets to be included in the report. For all
sets use the All checkbox. The clash sets are listed with the most

All checkbox below the recently run clash set at the top.

list.
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Group/Index Used for selection of clash sets filtering. The textbox can accept a
wildcards list of index numbers.
Element wildcards Used for selection of clash items filtered only by their names.

Element wildcards are entered as space-separated Oracle
wildcards, for example,

%42% %43% %44% %45%

matches any clash where either element name contains "42",
"43" , "44" or "45"

Specific Element wildcards may be separated by a vertical bar,
for example,

%42% %43% | %44% %45%

matches any clash where one element name contains "42" or
"43" and the other contains "44" or "45"

You can filter for individual items by entering their full name in the
Element Wildcards field, for example /P-1234 will only find
clashes with item “/P-1234". Note that the “/” at the beginning of
the item name is needed as Clash Manager stores the full
OUTFITTING name.

The items on the Advanced tab are as follows:

Project-define (default Used to select whether or not clashes involving items of unknown
Class) list with Class, or Fabricated or Unclassified, are to be included in the
checkboxes for 'ALL',  report. For all classes, use the ALL checkbox.

‘Unknown’, 'Fabricated’

and 'Unclassified'.

Project-define (default Used to select the Priority(ies) of clashes to be included in the
Priority) list with report. For all Priorities, use the ALL checkbox.

checkbox for each

listed priority.

Status list with Used to select the Status of clashes to be included in the report,
checkbox for each or to select 'Unknown status'. For all Status, use the ALL
listed status. checkbox.

Discipline and Status The 'Discipline' and 'Status' checkboxes called 'Automatically Set'

checkbox groups with  and 'Manually Set' are for selection of whether the report is to

And/Or radio group. include values automatically set by Assign/Accept rules and/or
values manually set. When 'And' is selected at the radio group,
both the discipline and the status checkbox selection must be
satisfied. When 'Or' is selected, either the discipline or the status
selection must be satisfied.

Limits Used to select items within or outside the defined 3D physical
limits.
Remarks Like Used for selection of clash items filtered only by their remarks.

Oracle style Wild cards (%) may be used. For example, an entry
of %VALV% will include clashes with VALV (valve) mentioned in
the remarks. When entering strings, ensure that the exact string
appeatrs in the remarks of the clashes concerned.
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Comments list with Used to select clashes with particular comments to be included in
checkbox for each the report.
listed comment
Like Used for selection of clash items filtered only by their comments.
Oracle style Wild cards (%) may be used.
Date Radio group for selection of Any Date, New clashes, Clashes

between selected dates, Clashes during a selected preceding
period. 'New clashes' are those occurring since the last 'Track
Changes' command (see 'Clash Manager Options' form -
Advanced tab).

Group/Detail Two dropdown lists for comparisons of '‘Group Status' with ‘worst

Difference detail' and 'Group Level/Type' with ‘worst detail'. The dropdown
lists have options of 'Not compared', '‘Better than', 'Worse than’,
Equal to' and 'Not equal to'. The report is filtered to include only
clashes where the group status (and/or level/type) compared with
the worst case detail status (and/or level/type) are as selected at
the dropdown lists.

Note: The Grading order of standard Clash Status is preset at
the Status tab of the Clash Manager Configuration form,
but the user can insert user-defined status between the
standard ones. The grading order of Group Level/Type is
set at the Level/Type tab of the Clash Manager
Configuration form.

Reset Checks all checkboxes and blanks all text fields on the tab.
Search Comment Comment filter applies to the last comment only, unless this box
History is checked

Enable Advanced All items on the Advanced Filter Tab are ignored unless this box
Filter is checked. When the box is checked, only clash groups and

details that satisfy EVERY filter selection made on the Advanced
tab together with the basic filter selection are reported.

Consolidated Report

The report shows Project Details, Selected Filtering, Clash Set Details including lists, a
Summary of Total Counts, and information on the Clash Groups and Clash Detail applicable
to the Clash Reports currently displayed. It is created when 'Consolidated XML Report' or
'‘Consolidated HTML Report' is selected at the standard saving form accessed from the
‘Clash Reports' window 'File' dropdown menu.

The report is generated in a file in neutral XML format, which is then displayed in Internet
Explorer (version 6 or later). The layout is determined by the style sheet supplied with Clash
Manager.

Report Header

The report header starts with the comments entered by the user at the 'Report Comments'
dialog box, displayed when the report file was saved at the standard saving form. The
comments are followed by a table giving general project information.
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Depending on whether or not the report is filtered, a note appears saying that the filter is
inactive, or details of the filter are tabulated.

If a single clash set was selected for the clash run, details of the clash set are tabulated. If
multiple clash sets were selected a note appears to that effect.

The report then shows a statistical summary of clash status for clash groups and details.

5.7.2 Clash Groups

Tabulated data is presented showing for each clash group that currently appears in the
Clash Reports Clash Group pane:

Group discipline, status, level and type

Element 1 discipline and GTYPE

Element 2 discipline and GTYPE

Group comments, user, co-ordinates, and when created.

5.7.3 Clash Detail

Tabulated data is presented showing for each clash detail that currently appears in the
Clash Reports Clash Details pane:

Group number, index, discipline, level and type

Element 1 discipline and GTYPE

Element 2 discipline and GTYPE

Group comments, user, co-ordinates, when created and remarks.

5.8 Element Report

The Element Report displays details of all elements that have been involved in clash
checks. The report is presented in a separate window that includes a main menu with
dropdown menus, a toolbar and a status bar. A popup (right-click) menu is available. A pane
showing report filter details can be included.

5.8.1 The Report

The report is in tabular format; each row being dedicated to an element.
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=] # 7% %6

Element Hame State Dizcipline Glype Class Group Element |~

& /1.1/2"158-5w-90001-BBA3 Clash Free | UMALLOCATED |PIPE Unknown /PIPE-15B-5w

W /1.142-158:4-90005:44N3.01 Clash Free | UNALLOCATED | PIPE Unknown JPIPE-1548:4

W 1.142-158-4-90007-44N3.01 Clash Free | UMALLOCATED | PIPE Unknawh /PIPE-154-4

W #1.1/2-158-4-9001 D-44N3.01 Clash Free | UMALLOCATED |PIPE Unknown SPIPE-154-4

W /1.142-158-Fw/-90018-44N3.01 Clash Free | PIFING FIFE Unknown JPIPE-158-Pw

W 1.1/2-158-Fii-00019-44N2.01 Clash Free | PIFING FIFE Unknawh JPIPE-154-FPw

W #1.1/2-154-Fw/-90022-44N3. 01 Clash Free | PIPING FIPE Unknown /PIPE-154-Fus

W /1.142-154-RY-90010-BFU 3.01 Clash Free | PIFING FIFE Unknown JPIPE-154-RY

& /1.142-154-RV-90026-BFU .01 Clash Free | PIFING FIFE Unknawh /PIPE-154-RY

W /1.1/2-154-Ry-30041-BFU3.01 Clash Free | UMALLOCATED |PIPE Unknown /PIPE-154-AY

W /1.142-158-RY-90043-BFU 3.01 Clash Free | PIFING FIFE Unknown JPIPE-154-RY

W /1.142-154-5C-00004-4443.01 Clash Free | UMALLOCATED | PIPE Unknawh /PIPE-1584-5C

K| A.1/2-154-5C-90004-5443.01 /803 | Unapproved | UNALLOCATED |BRAM Unknawin /PIPE-154-5C

W /1.172-158-5L-90007-4443.01 Clash Free | PIFING FIPE Unknown JPIPE-154-5L

X A1.1/2-154-5L-90007-4443.01/B01 | Unappraved | FIFING BR&N Unknowh /PIPE-154-51

W A1.1/2-154-5L-90007-4442.02 Clash Free | PIFIMNG FIPE Unknawin /PIPE-154-51

W /1.172-158-5L-9001 4444301 Clash Free | UNALLOCATED | PIPE Unknown JPIPE-154-5L

W 1.142-158-5L-90015-A443 01 Clash Free | PIFING FIFE Unknowh /PIPE-154-0

K| A.1/2-154-5L-90015-4443.01/B01 | Unappraved | PIPING BR&N Unknawin /PIPE-154-0

W /1.172-158-5L-9001 7-A443.01 Clash Free | PIFING FIPE Unknown /PIPE-158D-5L

W 1.142-1585-90001 -4443.01 Clash Free | PIFING FIFE Unknowh /PIPE-1544

W A1.1/2-1585-90001-44473.02 Clash Free | PIFIMNG FIPE Unknawin /PIPE-1544

W /1172158590001 -4443,03 Clash Free | PIFING FIPE Unknown JPIPE-15484

W 1.142-1585-90002-4443.01 Clash Free | UMALLOCATED | PIPE Unknowh /PIPE-1544

o A1.1/2-1585-00003-44473.01 Clash Free | UMALLOCATED | PIPE Unknawin /PIPE-1544

W /1.142-1585T-90007-BBU 3.01 Clash Free | PIFING FIPE Unknown JPIPE-15445T

& /1.1/2-156-Cw/-90002-44N3.01 Clash Free | UMALLOCATED | PIPE Unknowh /PIPE-15B-Ciw

¥ M.1/2-158-0w-90002-44M3.01 /803 | Unapproved | UMALLOCATED | BRAM Unknowin /PIPE-15B-Ciw hs

5868 Elements | 12/09/2007
The data in the columns is identified by the column headings, namely,
Element Name  OUTFITTING identification
State The worst case state of Approved, Conditional, Pending, Unapproved
or Clash Free. Note that the worst case state is displayed rather than
the Status

Discipline Owner discipline
Gtype OUTFITTING type
Class Project-defined field, by default known as Class

Group Element The element in the hierarchy at which Clashes may be aggregated

Note: In the example above the Purpose Project-defined field is configured as
“MMSDESCRIPTION”

The left-hand column shows the status of the group, as follows:

Approved
™ Unapproved
2 Pending
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Conditional

.( Clash Free

5.8.2 Filter Pane

This pane appears below the report and displays the filter criteria and values currently set to
limit the data shown. The information appears in a two-column table showing criteria in the
left-hand column and values in the right-hand column.

Filter

Element Report Filker Active

Clazh State Show All Approval States
Dizcipling Show All Clash Dizsciplines
kS Dizcipling Show All Clash Areas
Element

Advanced Options OFF

5868 Elements | 12/03/2007

5.8.3 Popup Menu

The options available and their functions are as follows:

OPTION FUNCTION

Show Clashes Calls up the Clash Reports window displaying reports filtered to
include all clashes associated with the selected items.

Set Designh CE Sets the selected item to be the OUTFITTING Current Element.

View Element Views the elements.

Claim Element Extracts the selected element in the OUTFITTING hierarchy
and brings it to the user's OUTFITTING workspace.

Flush Element Saves the OUTFITTING changes to the master model.

Issue Element Issues the OUTFITTING changes to the master model.

Add to Design List Adds the selected element to the OUTFITTING draw list.

Set Filter Leads to the Clash Manager - Filter Form.

Enable Filter Applies the filter criteria to the data displayed.

Save As Saves the report in a chosen format.

5.8.4 Main Menu

The Main Menu is displayed across the top of the Clash Manager - Element Report window.
Its options lead to the following dropdown menus:
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PD Clash Manager - Element Report
File Edit “ew Tools Help

[ — FTETITT T Tk oo T ..  Tw

5.8.5 File Dropdown Menu

The available options and their purposes are:

Save As Displays the standard saving form. This enables the user to save
information in the report as follows:

Comma Separated (*.csv)
(Tab Separated (*:txt)

( XML (*.xml)

XML & Stylesheet (*.xml).

Refresh Refreshes the report using the current filter.

Close Closes the window.

5.8.6 Edit Dropdown Menu

The available options and their purposes are:

Select All Selects all tabulated items in the report. Is greyed-out if the number
of records in the active pane exceeds the Large
Transaction>Warnings>Claim/Flush/Issue/Edit/Select All
setting at the 'Clash Manager Options' form.

Remove Selected Removes the selected items from the report.
Remove All Removes all items from the report.

Find Leads to the standard 'Find' dialog box.

5.8.7 View Dropdown Menu

The available options and their purposes are:

Filter Controls whether or not the Filter pane is displayed
Toolbar Controls whether or not the tool bar is displayed
Status Bar Controls whether or not the status bar is displayed.

5.8.8 Tools Dropdown Menu
The available options and their purposes are:
Set Filter Leads to Clash Manager Filter Form.
Enable Filter Applies the filter criteria to the data displayed.
Clear 3D Display Clears the OUTFITTING graphics display.
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Clear 3D Labels Clears the Clash Group/index Text Labels on the OUTFITTING
graphics display.
Options Leads to the Clash Manager Options Form.

Help Dropdown Menu
The available options and their purposes are:
Contents Displays this Online Guide in a new window

About MMS/Clash Manager Displays the product version in a new window.

Tool Bar

When selected for display, the toolbar appears under the Main Menu. The icons and
purposes of the buttons are as follows:

PD Clash Manager - Element Report
File Edit “ew Tools Help

E BB 728

Selected elements are added to the active OUTFITTING Design List.

o [#

Clears the OUTFITTING graphics display.

Clears the Clash Group/index Text Labels on the OUTFITTING graphics
display.

=) R

Refreshes the report using the current filter.

Finds selected data on the current report.

Applies the filter criteria to the data displayed.

Leads to the Clash Manager - Filter Form.

N o A F

Displays the filter pane.
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Status Bar

When selected for display, the status bar appears across the bottom of the window. It
includes information on the:

filtered or not filtered status of the display,
number of objects displayed,

Oracle connection status,

OUTFITTING status,

date.

Options Form

This form consists of two tabs called Preferences and Advanced. Below the tabs are OK
and Cancel buttons for respectively implementing or ignoring any changes made.

AYEYA Clash Manager Options g|
Preferences T Advanced
FOMS Element Colours
Apply Group changes to Clazh Detail True
Enable Quick Keps 172 & U/P/CHA Falza g
Enable 30 View Representation Falze Element 2 |
Auto Yiew True
Auto Reset Linits Drravalist Repart Highlight Colours
Auta Rotate Origin Tre _
Auta Clear 30 Dizplay True
Auta Dizplay Clazh Detail True Data Changs |
Chart Histary Count ALL _
+] Clash Check CE
+ Large Tranzactions g
7 Clash Dwner
Clazh tanager Configuration... ‘ Background

(]9

Preferences Tab

The Preferences tab enables users to set their preferred method of handling clash
information and highlighting features in the Clash report and in the OUTFITTING display

The pane at the left-hand side of the tab enables the following methods of handling clash
information to be chosen from a list, selected (true), or deselected (false):
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Apply Group
changes to Clash
Detail

Enable Quick
Assigh Keys
1/2 & U/PICIA

Enable 3D View
Representation

Auto View

Auto Reset Limits

Auto Rotate
Origin

Auto Clear 3D
Display

Auto Display
Clash Detail

Chart History
Count

True/False

True/False

True/False

True/False

None
Drawlist

Selected

True/False

True/False

True/False

Select ALL
or number

GUI

Updates relevant data in Clash Detail report when
changes are made to Clash Groups.

Note: Depending on the policy selected for the
project at the Clash Manager Configuration
form, the options of the dropdown list may be
restricted to either True or False. If the user is
free to choose, both options are available.

Caution: It is recommended that this option is set to
True. If it is set to False, clash recomputation with the
‘Clash Group Status from details' option selected (see
Clash Recomputation form) may reset the status of all
clash groups to the status of their worst case clash
details.

Enables shortcut keys to be used:

1 - to set Owner Discipline to Discipline of First
element

2 - to set Owner Discipline to Discipline of Second
element

U - to set clash status to Unapproved

P - to set clash status to Pending

C - to set clash status to Conditional

A - to set clash status to Approved.

Enables or disables highlighting of clashing elements
in OUTFITTING

Elements referenced in the Selected Clashes are
added to the Drawlist

No Limits set for the graphics display
Limits of the graphics display are set to the Drawlist

Limits of the graphics display are set to the volume
enclosed by the Elements referenced in the Selected
Clashes

Sets the rotation origin of the graphics display to the
clash position (if one clash is selected) or the centre of
Elements referenced in the selected clashes (when
more than one clash is selected)

Clears the graphics display before adding elements to
drawlist

Selecting a Group record automatically populates the
related Clash Detail under Clash Detail pane (if
displayed)

Sets the number of previous milestones to be included
in the statistical display on the Clash Manager form
when clash history is selected.
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Clash Check CE (leading to
Display Report and Retain =I Clash Check CE
Filter options) D'S':'lfay HEF":'“ True
Fietain Filker Falze
Display When set to True, the clash reports, both group and
Report detail, are automatically displayed after a Clash Check
CE process.

Retain Filter When set to True, the Clash Check CE reports are
filtered using a temporary filter that includes ALL filter
options, with the Element Name filter set to the
appropriate Group Element of the Current Element.

When set to False, the filter is disregarded.

Large Transactions
(leading to Warnings and Worst
Case Update Threshold options)

-1 Large Tranzactionz
=| ‘warnings [record counts... ]
Clazh Details from Selected Groups 1000
A0 Yiew from Selected Groups 10
Claim./Fluzh/lssue/Edit/Select-al. .. 100

Worst Caze Update Threshold 100
Warnings (record Clash Details from Selected Groups (default 1000)
counts...) 3D View from Selected Groups (default 10)
(leads to further options Claim/Flush/Issue/Edit/Select All (default 100)
see next column) (See Large Transactions below.)
Worst Case Update (See Worst Case Update Threshold below.)

Threshold (default 100)

Large Transactions

The Warning options enable the user to set the values of record counts that determine when
the 'Clash Manager - Large Transaction' dialog box is displayed. This dialog box warns the
user that there will be a delay because a large number of records are about to be displayed
and/or a large number of operations are about to be performed, and requests confirmation
or cancellation of the operation. Details of the record counts are as follows:

Clash Details from Selected Groups - this operates when Auto Display Clash Detail
has been selected, clash details are being viewed and the total number of clash
groups selected exceeds the set value.

3D View from Selected Groups - this operates when clash Auto View has been
selected and the total number of clash groups selected exceeds the set value. (Note:
Warnings of both Clash Details... and 3D View... may be displayed. This gives the user
the opportunity to perform or cancel one or both operations.)

Claim/Flush/Issue/Edit/Select All - this operates when any one of these actions is
initiated for a number of clash groups that exceeds the set value. The setting also
determines how many records can be present in the active pane of the 'Clash Report'
window before the Select All option of the Edit menu is greyed out.
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Worst Case Update Threshold

The value set for this option determines which of two methods is to be used by the software
to update the clash status of elements. The methods are referred to as 'Single Update' and
‘Global Update'. The Single Update method processes a single clash element, searching
the database for the worst case and updating the clash element status accordingly. This
method is efficient for single clashes, but the time taken is proportional to the number of
clashes involved. The Global Update method is routinely used at the end of every clash run
to determine the worst case clash status of all elements in the database. It uses more
sophisticated processing methods and is consequently faster per element than the Single
Update method, but always processes all elements.

The Single Update method is used for all elements when the number of elements is below
the Worst Case Update Threshold setting; the Global Update method is used when the
number is above the setting.

The optimum value for Worst Case Update Threshold depends on the speed of the system
and the volume of data. This is discussed further in Clash Manager Performance Hints.

Element Colours

The Element Colours buttons lead to a Select Colour dialog box, from which the required
colours can be selected. The buttons are labelled Element 1 and Element 2 and are
highlighted with the selected colours.

Select Element Colours:

N
.

Memate T [0K] Cancel

The Report Highlight Colours buttons lead to a standard Windows Colour dialog box, from
which the required colours can be selected. Each buttons is labelled with the aspect it
controls on the Clash Reports and is highlighted with the selected colour.
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AN EEEENEN
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Cuztom colors:

B
A EEEENENEN

Define Cugtom Colors >

] 4 | Cancel |

5.9.2 Clash Manager Configuration
The Clash Manager Configuration button leads to the Clash Manager Configuration Form.

Note: In the case of Standalone Clash Manager, a dialog box prompting entry of the Clash
Manager Admin Password appears for non-administrative users. This password is
set in the 'Clash Manager Configuration' form - Project tab, to prevent unauthorized
access to the 'Clash Manager Configuration' form. Once entered, the user will not be
prompted again to enter the password until the session ends. Supervisors of
Administrator discipline are not required to enter this password.

Advanced Tab

The Advanced tab is used for major 'housekeeping' tasks and to introduce discrete periods
or points in the history of clash runs (milestones).
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Clash Manager Advanced Options:

AYEVA Clash Manager Options E

Freferences

Description |

Recompute Properties. .. | -f Load Clash File... |

Track Changes |

Reszet Group Status | FT—tll FReszet Group Owrner |

Dele

te All Unreferenced Groups, Elements and Comments |

De

lete All Clash Data, including Comments and Historny |

k. | Cancel |

Note: It can be accessed only by Supervisors of the Administrator discipline.

The tab contains the following items:

Description

Track Changes

Recompute Properties

Load Clash File

Reset Group Status

Reset Group Owner

For optional entry of a description of the new period or point
(milestone)

Initiates saving the current discipline/status/counts. This has
the effect of adding another point in the history shown on the
Clash Manager form. 'New' clashes are tracked from this
point.

Leads to the Clash Recomputation Form. Used following
change in the model.

Leads to the Load Clash File Form. Used following a failure
during clash file handling.

When all individual clashes within a group have the same
status, it is applied to the Group.

When all individual clashes within a group have the same
owner discipline, it is applied to the Group.
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Delete All Unreferenced Removes from the clash report data any groups or elements
Groups, Elements, and that are no longer involved with clashes

Comments

Delete All Clash Data, Removes all clash report data from the database, but not
including Comments configuration data. Therefore, clash set definitions, check list,
and History obstruction list and so on remain, but can be deleted manually.

The clash history is deleted.
Remaining data is truncated to recover unused space in the
Oracle Table Space.

Note: Counters are NOT reset (as Oracle does not provide
this facility).

Clash Recomputation Form

Recomputation is an Administrator Configuration task that becomes necessary when the
values of significant attributes in the model have been changed, for example, if discipline
codes are changed. This is because these changes to the model are not automatically
communicated back to the Clash Manager, unless the relevant clash sets are rerun, or the
recomputation process is initiated at this form.

The changes to the model can have been made independently in OUTFITTING, or in Clash
Manager at the 'Clash Manager Configuration' form. Following changes made in
OUTFITTING, the Recomputation form must be accessed manually. When significant items
are modified at the Clash Manager Configuration form, the Recomputation form is displayed
automatically with the appropriate default entries in the relevant checkboxes. Examples of
the changes that cause automatic display of the form are:

* rules added or deleted

* regular expressions modified
e defaults changed

« defined attributes changed.

Note: When the recomputation process is performed, it is usually necessary to preserve
the current approval status, in spite of any change in Acceptance Rules that would
subsequently lead to different results. Also, it should be noted that Rules are applied
only when a clash is initially discovered; subsequent manual settings of attributes

usually need to be preserved. Clash acceptance can be excluded from the process,
as can any other aspects, by appropriate entries at this form.
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j AVEYA Clash Manager - Clash Recomputation

[ Classz
B
B

Clazh Properties

Element Propertiez

[ Dizcipline

[~ Group Ownership of Clash Detail

[T Clazh Assignment [Discipling Owner]
[" Clazh Acceptance [Clash Status)

[ Clash Group waorst case Level/Type
[ Clash Group Statuz from details
Skip 'Uszer Modified' Discipline/Status v

Resat | Cancel

~

The form contains the following items:

Element Properties block containing:

Class, Priority, Discipline, The states are referred to here as 'checked', 'checked

MMS Discipline

shaded', and 'blank'.

.The checkbox titles are the default values of project-defined
fields that can be set at the Clash Manager Configuration
form. The fields are used for selecting attributes, the values
of which are to be copied verbatim into the Clash Manager
database for reporting purposes and use for filtering etc.
Areacode (and others) are defined on the Project tab of the
form. Class and Priority and Discipline have their own tabs.
The checkbox titles show the default values and/or those of
the attribute(s) set by the user.

When 'checked', the value of the particular attribute is
unconditionally recomputed for every element. The phrase
Recompute ALL appears before the checkbox title.

When ‘checked shaded', the value of the particular attribute
is only recomputed for elements where the attribute is
currenty UNSET. The phrase Recompute only unset
appears before the checkbox title name.

When 'blank", the attribute is not affected by the recompute
process.
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Clash Properties block containing:

Five checkboxes at the left-hand side of the block. (Checking a checkbox enables
recomputation of the associated property. When the checkbox is blank, the property is not
affected by the recomputation process)

Group Ownership of
Clash Details

Clash Assignment
(Discipline Owner)

Clash Acceptance
(Clash Status)

Clash Group worst case
Level/Type

Clash Group Status from
details

When the checkbox is checked, Clash Group Ownership is
recomputed for every clash detail.

When the 'ALL' option is selected at the dropdown list, the
discipline ownership is recomputed for every clash detalil.
When a discipline is selected, the ownership is recomputed
for clash details for that discipline only.

When the 'ALL' option is selected at the dropdown list, the
clash acceptance status is recomputed for every clash
detail.

When a status is selected, the clash acceptance status is
recomputed for clash details where the status is currently
the one selected.

When the checkbox is checked, the Clash Group worst case
Level/Type is recomputed for every clash detail

When the checkbox is checked, the status of each active
clash group is reset to the value of the worst case status of
any of its member clash details. This option is provided for
cases where clash detail status has been set by hand and
the group status consequently may be out-of-date.

Caution: If any group status has been set by hand, and 'Apply Group changes to Clash
Details' on the 'Clash Manager Options' form has been set to False, the member details
status will not necessarily match the group status. Therefore, recomputation using the
'‘Clash Group Status from details' option could change the Clash Group status to that of
the worst case member clash detail.

Two checkboxes at the lower right-hand side of the block

Skip 'User Modified'
Discipline/Status

Remove 'User

When the checkbox is checked, the recomputation includes
only clash details that have been set automatically using
Assignment/Acceptance Rules.

When the checkbox is unchecked, the recomputation
includes all clashes, and processes them according to the
assignment/acceptance rules.

When the checkbox is checked, all Manual Flags (see Note

Modified' Flag on Auto Rules checkboxes) are unset and, in future, all
clashes are treated as though their details had been set
automatically.

Progress bar Indicates the percentage completion of the recomputation process

OK Initiates the recomputation process

© 2007 AVEVA Solutions Ltd

5:42 12.0



AV=VA

Clash Manager User Guide

GUI

Reset Restores the recently changed settings made at the Clash Manager

Options form

Cancel Cancels the selections made and closes the form

5.11 Load Clash File Form

This form is used for loading desclash output files to replace any that are partially loaded

following a system failure. The form also provides facilities for merging selected files into the

results of the latest clash run.

The form initially displays three panes; the top left-hand showing directories; the bottom left-

hand showing a summary of the selected directory contents; the right-hand showing the file

content of the selected directory. Only files compatible with Clash Manager can be selected
in the right-hand pane.

The form can be extended at the right-hand side to show a fourth pane that displays the

contents of the selected file.

AVEVA Clash Manager - Load Clash File 3
=1 ~|  Defaul |
[ -~
= temp

(L1 {6E249BEE -B714-11D7-80E 8-00500,4.21 757E
(2~ TR9E tmp
[ ~ved21 2. tmp
(2 haperfdata_martin.ward
(2 msohtml
(2 msohtmll
(27 Oralnztall2007-08-24_11 -BE-D4d
(20 Oral restall2007-08-24_12-06-11PM
(2 outlock logging
B8 pclam |PE_martinward 165
_D pelar_|PE_martin ward_265 e
E:D\r:;aar?r::s\gclloaanglglggﬁrggrtin.ward_1 51} Compatible dezclash filex [".out]j v Al
| Cancel |

In addition to the panes, the form includes the following items:

Dropdown list and For selection of drives and directories. The Default button

associated Default button  sets the directory to % TEMP% and selects the first Clash

(top left-hand of form) Manager directory for the current project.

Dropdown list (bottom For selection of the type of file displayed in the pane above

right-hand of form) it. The options are Compatible desclash files (*.out) (the
default) and All Files (*.*).

All When the box is checked, all files compatible with Clash
Manager in the selected directory are loaded, when the
process is initiated. This has the effect of creating a new
clash run containing only those loaded clashes.

When the box is unchecked, only the selected files are
merged into a copy of the latest clash run, when the loading
process is initiated.
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OK For initiating the file loading process and closing the form.
Cancel For ignoring the selections made and closing the form.
|>>] or |<<]| For extending or contracting the form.

Clash (Group) Properties Form

This form enables the properties of a clash group or an individual clash to be updated.
When a clash group is involved, the word 'Group' appears in the box title. There are minor
differences between the fields available for a clash group or an individual clash. These are
indicated in this topic by 'Group only' or 'Clash only' after the particular field names.

Clash Group 1821 Properties E|
Status
X Unknown W i Fluies Unapproved
Discipline Elements
e | 1 |/PIPE-158-4G
r | 2 |/PIPE-154-B
& | PIPING
v Auto Rules
¥ Apply to each Clash Detail
Comments T Details
Altribute | Element 1 | Element 2 Dats |29”DE£2DD?14:22:31
PDMS Mame /FIPE-154-A0G /PIPE-154-B East [38
Digcipline PIPIMNG FIFING
Class Unknown Unkrown Marth |D
GTYPE Z0OME ZOME
wiorst Caze  Unapproved IUnapproved Up |o
Level |HH Type: |CLA
< >
ak. Cancel

Note: Auto Rules Checkboxes: The Auto Rules checkboxes enable the user to set or
unset flags that tell the system that the Status or Owner Discipline has been
manually updated. Following the initial automatic acceptance or assignment, the
flags are unset, but when the user carries out manual updates, they become set.
When a recomputation process becomes necessary, the user often does not want
manual updates to be changed, and recomputation options are available to prevent
this. However, the user may require that certain manual updates are recomputed and
the flag for these can be unset by means of the appropriate Auto Rules checkbox.
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The checkbox can also be used to set the flag, if required, thus making an automatic
update appear to be manual.

At the top of the form is a Status section. The currently selected status is represented by a
green tick, green tick over blue question mark, blue question mark or red cross adjacent to a
'Status' element, which can be either a field or a dropdown list. The current status, namely
Approved, Conditional Approval, Pending or Unapproved, as applicable, is written at the
right-hand of the section. An Auto Rules checkbox adjacent to the Status element enables
the user to select whether the status is to be treated by the system as automatically applied
by the Auto-accept Rules, or manually applied.

When the Auto Rules checkbox is checked, the 'Status’ element becomes a field,
highlighted by the 'Value Automatically Set' colour selected at the 'Clash Manager Options'
form. In these circumstances, any recomputation process will treat the Status as having
been automatically set and will update it in line with any applicable new rule or design
change.

When the Auto Rules checkbox is unchecked, the 'Status' element becomes a dropdown
list, and a Spanner (wrench) icon is displayed to signify manual selection. The new
discipline may be selected at the dropdown list, but access controls may restrict the
available Status. In these circumstances, any recomputation process will treat the Status as
having been manually set and will update it, or skip it, as specified at the 'Clash Manager -
Clash Recomputation' form.

The Discipline section is for selection of the discipline responsible for resolution of the
clashes. Selection is by a 3-button radio group that enables mutually exclusive selection of
the owning discipline to be that of Element 1, Element 2 or Other discipline. The Other
discipline element can be either a field or a dropdown list. An Auto Rules checkbox
adjacent to the Other element enables the user to select whether the owner discipline is to
be treated by the system as automatically applied by the Auto-assign Rules, or manually
applied.

When the Auto Rules checkbox is checked, the radio group is disabled and the Other
element becomes a field, highlighted by the 'Value Automatically Set' colour selected at the
'‘Clash Manager Options' form. In these circumstances, any recomputation process will treat
the Discipline as having been automatically set and will update it in line with any applicable
new rule or design change.

When the Auto Rules checkbox is unchecked, the radio group is enabled and the Other
element becomes a dropdown list. A Spanner (wrench) icon is displayed to signify manual
selection. The new status may be selected at the dropdown list, but access controls may
restrict the available disciplines shown in the dropdown list and may inhibit the selection of
one or more of the radio buttons. In these circumstances, any recomputation process will
treat the Discipline as having been manually set and will update it, or skip it, as specified at
the 'Clash Manager - Clash Recomputation' form.

The Elements section displays the identity of Element 1 and Element 2 within the group or
clash.

The Apply to Each Clash Detail (Group only) checkbox is checked, if the change of
properties is to apply to each clash within the group.

The Member of Group (Clash only) field displays the owner group number.

The lower part of the form is occupied by tabs titled Comments and Details respectively.
Below the tabs are OK and Cancel buttons for respectively implementing any property
changes and closing the box or just closing the box.
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Comments

This tab provides facilities for addition and deletion of comments. The Quick Comment
button displays a list of pre-defined comments associated with the current owner discipline,
together with pre-defined comments that may be applicable to any clash.

The automatic Acceptance & Assignment Rules automatically create comment records
showing the name of the rule that succeeded.

Comments may be edited (or deleted) before saving, but thereafter form part of the
historical record and may not be changed or deleted.

Note: All comment records are stored together with the user’s windows UserID and the
current date.

Details

The text box at the left-hand lists details of the attributes of the elements involved in the
clash or clash group. The fields at the right-hand show the date and the co-ordinates of the
clash or clash group.

The text box (Clash only) at the bottom right-hand displays a narrative description of the
clash, derived from the data displayed on the tab. This description is the derivation of the
'Remarks' shown on the 'Clash Details' reports.

Edit Clash Groups Form

This form enables a supervisor of the Administrator discipline to edit the properties of
multiple clash groups or clashes, by changing the owner discipline and/or status and/or
adding new comments. If other users edit multiple clash groups or clashes, records to which
they do not have access rights are ignored. The clash groups or details concerned are
selected at the Clash report.

Edit Clash Groups 1821 . . . 1823 @
Oviner Discipline — { pipiNG |1 Auto Rules
Status X |Unkn0wn j [ Auto Rules
Mew Comment W Apply ta each Clash Detai
I [

oK Cancel

A change of Discipline or Status automatically creates an additional comment record. This
comment will appear in the comments section of the Clash Report and on the Comments
tab of the Clash (Group) Properties form.

Any changes to the properties of the clash groups or details are made at the Owner
Discipline, Status and Comments dropdown lists. The utilization of the Owner Discipline
and Status dropdown lists depend on whether:

1. All, some or none of the clash groups or details have automatically or manually set
owner disciplines,
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2. All, some or none of the clash groups or details have automatically or manually set
status,

3. The current status is the same in all clash groups or details,

4. The current owner discipline is the same in all clash groups or details.
Situations a. and b. are shown by Auto Rules checkboxes adjacent to the dropdown lists
(refer to Clash (Group) Properties Form), whereas c. and d. are shown by characteristics of

the dropdown lists. The situations and the displays are summarized in the following table (in
which ‘item' means Owner Discipline or Status):

Situation Dropdown List Auto Rules Checkbox
All items manually set | Active - entry can be Blank - can be set to Checked to
updated make the system react as though all

items were automatically set

All items automatically | Inhibited - text is greyed- | Checked - can be set to Blank to
set out - read-only make the system react as though all
items were manually set

Some items Inhibited - text is greyed- | Checked greyed-out - can be set to
automatically set out - read-only Blank or Checked to make all items
others manually set appear to be manually or

automatically set, as above

All items the same <item name> displayed | Makes dropdown list active or
inhibited, as above

Items diffe <...>displayed Makes dropdown list active or
inhibited, as above

To update the owner discipline or status of the selected clash groups or details, click on the
appropriate Auto Rules checkbox until it is blank and then select the new discipline or
status at the dropdown list.

When the Apply to each Clash checkbox is checked, the changes made in multiple Clash
Groups will apply to each clash within each group.

As required, select the required comment at the New Comment dropdown list.

To implement the updates and close the form, click on the OK button. To ignore any entries
and close the form, click on the Cancel button.

Clash Manager Configuration Form

This form provides viewing and setup facilities for features of clash management. The
central part of the form is occupied by several tabs. These are described in separate topics.
The clash management features and the tabs associated with them are as follows:
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BN AVEVA Clash Manager Configuration

Security ] Group ] Agzign ] .t’-‘n.ccept] Levela’T_l,lpel Gt_l,lpe.n"Tlacking]

Project l Dizcipline ] Clazs ] Pricrity I Statuz I Comments ]
Project Title |
Client |
Froject Mumber Admin Pazsword

Froject |MaR ) ]

Dizplay Units

dzerd |STSTEM ™ MM

Pagzaword [ " Ftins

™ Free

Default MDE  |AALL_MWO_MDS

Apply Group Changes to Clazh Detail |Free -

Project Defined Field

Dezcription |ﬁ3«reacode

Attibute |AREACODE of zone

Default |

Save Cancel

Clash Management Feature Associated Tab Titles
Data Access Control Security

Automatic acceptance of certain clashes Accept, Class*, Status
Automatic assignment of an owner disciplineto  Assign, Class*, Discipline, Priority*
a clash

Clash Manager Access Control Project

Clash details Comments, Level/Type
Automatic grouping of primitive clashes Group

Advanced Filtering options for Clash Reports Class*, Priority*, Status
MDBs and GTYPEs included in Tracking Gtype/Tracking
Changes

* The Class and Priority tabs are user-definable and can be configured for any attribute or
user-defined attribute associated with the clashing elements or their owning hierarchy. (The
names Priority and Class illustrate the typical configuration, and are used in this Online
Guide for the tabs and for any form elements that display information derived from them.) It
should be noted that the values of the attributes defined are stored against each clashing
element in the Clash Manager database. This additional attribute information can be used in
the Assign and Accept rules.
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Buttons below the tabs have the following names and purposes:

OK Saves updated data and closes the form
Save Saves updated data and leaves the form displayed
Cancel Closes the form without saving any updates.

Note: If significant changes are made at this form, a message ‘changes in Configuration
require recomputation of Clash & Element Properties' is displayed. When this
message is accepted, the Clash Recomputation form is automatically displayed.

Accept

This tab is for setting up details of clashes that can be automatically accepted and
automatically set to a given status, such as Approved.

BN AVEVA Clash Manager Configuration

Froject I Dizcipline ] Clazs ] Pricrity I Statuz I Comments ]
Security I Group ] Agzign  Accept ] Levela’T_l,lpel Gt_l,lpe.n"Tlacking]
Status
""" ~ f/
Accept Rulel —
Accept Rule2
Accept Rule3 -
Unapproved
-1+ Pending
Statuz Pending
—I- Conditional
S | Tes|
Elerment | Attribute Walue
< >
Save Cancel

The clash acceptance process checks a number of 'Rules' in sequence (from top to bottom
as displayed on the form). Each Rule consists of a number of 'Rule Expressions'. The first
Rule found in which all its Rule Expressions evaluate true is used by the acceptance
process. Rule Expressions, which are formed of certain keywords, literals and regular
expressions (wildcards) are described under Notes on Rules and Rule Expressions.

The Status of the clash is set to the status owning that rule. A comment is created showing
details of the status and the rule which matched is automatically attached to the clash and or
clash group record.
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Note: Acceptance Rules may be complicated and time-consuming to develop. A simple
method of testing is available to avoid a (very lengthy) Re-Computation option, which
may reveal further modifications to the rules are required. The test facilities are
available at the 'Clash Manager -Test Rules' form, which is accessed by means of
the Test button. The new configuration does not need to be saved prior to using the

test facilities.

The names and purposes of the items on the tab are as follows:

Upper pane showing a
hierarchy with Status as
the primary nodes which,
when expanded, display the
applicable Acceptance
Rules

Up and Down

Test

Lower pane showing a list
of Rule Expressions under
Element, Attribute and
Value headings

5.14.2 Security

When an Acceptance Rule is highlighted, its rule syntax is
shown in the lower pane.

A Popup Menu is available (mouse right-click) with options
of Edit, Add and Delete. This is used to edit an existing
rule name, add a new rule, or remove an existing rule.

These are used to reposition the highlighted rule in the
hierarchy.

Leads to the Test Rules Form.

The listing shows the syntax of the Acceptance Rule that is
highlighted in the upper pane.

Popup Menus (mouse right-click) are available from the
three components of the Rule Expressions. (Note that the
current options are omitted from the editing options of the
displayed menus and that the Esc key can be used to abort
the entry in an in-place options box.)

The Element Popup Menu options are:

Editing options - @element-1, @element-2, @general
Add Rule
Delete

The Attribute Popup Menu options are:

Editing options - @discipline, @class, @priority, etc, and
@gtype

Edit - leads to in-place editing options box

Add Rule

Delete

The Value Popup Menu options are:

Editing options - @element-2, etc, see Notes on Rules and
Rule Expressions

Edit - leads to list-of-values

Add Rule

Delete

This tab enables the administrator to update and view the overall security arrangements for
Clash Manager. For details of the security arrangements, refer to Access Rights.
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BN AVEVA Clash Manager Configuration

Project ] Dizcipling ] Clazz ] Pricrity ] Status ] Comments ]
Security l Group ] Azzign ] Accepl] Levela’Typel Gl}lpe;"Tracking]

" CIVILS
_._l.l' EQLIF
HUlRE

a PIFING

Status Cwner Check CE  Comments  Users
'E_.l-" Security Level - Changing Clagh Statuz
']

e Ly

tdember of any Descipling invalved in Clash
may change Clazh Statug

Cuztom Lesel | Drefault Lessel |

Save Cahicel

The tab essentially displays one of four panes for setting Security Levels (namely, Status,
Owner discipline, Check CE, and Comments), or a dialog box called 'User Access Levels'
for setting the User Access Levels. The particular security level pane, or the dialog box, is
selected by clicking on the appropriate icon in the row across the top of the tab.

The size of the 'User Access Levels' dialog box, when located on the tab, may unacceptably
restrict the displayed information. To overcome this effect, the dialog box can be undocked,
by clicking on the button at its top right-hand corner, and resized by dragging its borders.
The dialog box is docked by clicking on the button at its top right-hand corner.

Note: The Security Levels panes cannot be accessed while the dialog box is undocked and
a message 'User Access Levels Dialog Undocked...' is displayed on the tab.

Status, Owner, Check CE and Comments Panes

The layout of each pane is the same, but the messages displayed are appropriate to the
selected Security Level.

Across the top of the pane, the selected icon and a description of the Security Level are
displayed.

The elements displayed in the centre of the pane, depend on whether the pre-defined or
custom settings are being used. When pre-defined settings are being used, a slider control
enables the security to be set to one of the five states namely, High, Medium High,
Medium, Medium Low and Low. The name of the selected state and a narrative statement
of its effect appear to the right-hand of the slider control. The default state for each security
level is Medium. When custom settings are being used, the pane displays the message:
'‘Custom - To change the settings, click Custom Level - To use the recommended settings,
click Default Level'.
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At the bottom of the pane are two buttons. The Custom Level button leads to the 'Clash
Manager - Security Settings' form, at which the pre-defined settings for the particular
Security Level can be superseded by custom (user-defined) settings. The Default Level
button is for selecting the default state.

For each Security Level there are five pre-defined states namely, High, Medium High,
Medium, Medium Low and Low. Each of these states has corresponding settings (minimum
requirements). The default State for each Security Level is Medium and this is used as the
guideline when access rights are mentioned in the Clash Manager Procedures.

As required, the Administrator may override the pre-determined settings by specifying
custom settings for one or all of the Security Levels.

The pre-determined States and Settings are detailed in the following tables.

Security Level - Status

State Setting - description of minimum requirement

High Supervisor of ADMIN discipline

Medium High Supervisor of Owner discipline AND Member of ADMIN
discipline

Medium (the default) Supervisor of Owner discipline

Medium Low Member of Owner discipline

Low Member of ANY discipline involved in Clash

Security Level - Owner

State Setting - description of minimum requirement
High Supervisor of ADMIN discipline
Medium High Supervisor of other discipline and Member of ADMIN may

Acquire Ownership

Supervisor of current discipline and Member of ADMIN may
impose ownership

Medium (the default) Supervisor of other discipline may Acquire Ownership

Supervisor of current discipline and Member of ADMIN may
impose ownership

Medium Low Supervisor of other discipline may Acquire Ownership

Supervisor of current discipline may impose ownership

Low Member of ANY discipline involved in Clash

Note: Only the Supervisor of ADMIN discipline may impose ownership on a discipline not
directly involved
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Security Level - Clash Check CE

State Setting - description of minimum requirement
High Supervisor of ADMIN discipline

Medium High Member of ADMIN discipline

Medium (the default) Supervisor of CE discipline

Medium Low Member of CE discipline

Low Member of ANY discipline

Note: Clash Check CE automatically creates and runs a personal Clash Set. A suitable
level of security is important in order to maintain some control of the growth of
Clash Sets

Security Level - Comments

State Setting - description of minimum requirement

High Supervisor of ADMIN discipline or

Supervisor of ANY discipline involved in Clash and Member of
ADMIN discipline

Medium High Supervisor of ANY discipline involved in Clash
Medium (the default) Member of ANY discipline involved in Clash
Medium Low Member of ANY discipline

Low Anybody

User Access Levels

This dialog box is for selecting Users and their access levels. It displays a single pane on
which the access arrangements are shown in tree format. The major nodes of the tree are
Users and Disciplines.

User membership of a discipline is granted by dragging the discipline and dropping it onto
a user name. Alternatively, the discipline can be selected from a right click menu. Similarly, a
user name may be dropped onto a discipline.

A checkbox is located against the left-hand side of each user and discipline symbol.
Supervisor rights are shown in the tree by a checked box against the discipline under the
user and by a checked box against the user under the discipline.

Assign

This tab is for specifying the tests and order in which they are to be performed during
automatic assignment of an owner discipline to a clash.
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B\ AVEVA Clash Manager Configuration

Project ] Dizcipline ] Clazs ] Priarity ] Status ] Carmrments ]
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Application O Friority =
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UMALLOCATED ~ /’
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+ PIFIMNG
CIWILS FIPE
Col e drelT™ v TESt
Itenn Aftribute W alue
< >

Save Cancel

The tests can check the relative Priority, Class and/or Discipline of each element of pairs of
clashing elements. The tests can also check a number of 'Discipline Assignment Rules'. The
testing process proceeds test-by-test until a result indicates the owner discipline of the
clash. The testing process then assigns the owner discipline to that clash and continues by
testing the next clash.

In the Priority and Class tests, the owner discipline is set to the element with the higher
'‘Order'. These Orders are as set at the Priority and Class tabs, respectively.

The Element Discipline test is normally the last of the sequence and consequently is used
when none of the other tests have produced an owner discipline. If the discipline of each
clashing element is the same, that discipline is set as the owner. If the disciplines are
different, the discipline default (as set at the Discipline) is used. Typically, this is
'UNALLOCATED'.

Each Rule in the Discipline Assignment Rules consists of a number of 'Rule Expressions'.
Rule Expressions, which are formed of certain keywords, literals and regular expressions
(wildcards), are described under Notes on Rules and Rule Expressions. The first discipline
with a Rules whose Rule Expressions all evaluate true becomes the owner discipline, by
default. Alternatively a setDiscipline keyword operator may be used in a rule expression to
assign the owner discipline to that of one element or the other, or even to a third unrelated
discipline.

A comment is created showing details of the discipline assigned and the Rule which
matched is automatically attached to the clash and/or clash group record. This comment
appears in the Comments section of the Clash Report and on the Comments tab of the
Clash Group Properties form.
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Note: Assignment Rules may be complicated and time-consuming to develop. A simple
method of testing is available to avoid a (very lengthy) Re-Computation option, which
may reveal further modifications to the rules are required. The test facilities are
available at the 'Clash Manager -Test Rules' form, which is accessed by means of
the Test button. The new configuration does not need to be saved prior to using the

test facilities.

The names and purposes of the items on the tab are as follows:

Order of Application

Up and Down

For selecting which tests are to be performed and the order
(from top to bottom) in which they are carried out. The
checkbox against the test is checked, if the test is to be part of
the sequence. The records show the name of the tests.
'‘Assignment Rules' means 'Apply the Discipline Assignment
Rules'.

For setting the sequence of records as displayed from top to
bottom of the pane and hence the sequence of the tests.

Discipline Assignment Rules pane containing:

Discipline Assignment
Rules pane showing a
hierarchy with Discipline
as the primary nodes
which, when expanded,
display the applicable
Assignment Rules

Up and Down

Test

Lower pane showing a list
of Rule Expressions under
Element, Attribute and
Value headings

When an Assignment Rule is highlighted, its rule syntax is
shown in the lower pane.

A Popup Menu is available (mouse right-click) with options of
Edit, Add and Delete. This is used to edit an existing rule
name, add a new rule, or remove an existing rule.

These are used to reposition the highlighted rule in the
hierarchy and hence determine the sequence (from top to
bottom) in which the rules are applied.

Leads to the Test Rules Form.

The listing shows the syntax of the Assignment Rule that is
highlighted in the upper pane.

Popup Menus (mouse right-click) are available from the three
components of the Rule Expressions. (Note that the current
options are omitted from the editing options of the displayed
menus and that the Esc key can be used to abort the entry in
an in-place options box.)

The Element Popup Menu options are:

Editing options - @element-1, @element-2, @general
Add Rule
Delete
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The Attribute Popup Menu options are:

Editing options - @discipline, @class, @priority, etc, and
@gtype

Edit - leads to in-place editing options box

Add Rule

Delete

The Value Popup Menu options are:

Edit - leads to list-of-values

Add Rule

Delete

Example of Assignment Rules

BN AVEVA Clash Manager Configuration

Security ] Group

Praject ] Dizcipling ] Clazz ] Pricrity ] Status ] Comments ]
Aszsign ] Accept ] Level/Type ] Giype/Tracking ]

Order of
Application O

Azgignment Rules
Class

Friciity

Element Dizcipline

Dizcipline Order / Agzignment Fules

SUPPORTS

—I- PIPING

CIVILS PIPE
EQUIPMENT

XY

STRUCTURAL

PriorityRule

Itern

| Attribute

| Y alue

(@general
(@element-1
(@element-1

@type
(@Priarity
(@dizcipling

Tauy
Test Pricriy2
FIFING

oK

Save

Cahicel

In the above illustration of the tab, the order of the tests is Assignment Rules, Priority, Class
and finally Element Discipline. The testing process is as follows:

1. The Assignment Rules are applied. The first rule in which all Rule Expressions
evaluate true is used to determine the owner discipline.

2. If no Assignment Rule is satisfied, the Classes of the elements are checked. If the
Classes are different, the element with the higher class determines the owner
discipline. (The illustration shows this test disabled, because the checkbox is
unchecked.)

3. If the Classes are the same, if the Priorities of the clashing elements are different, the
element with the higher priority determines the owner discipline. (The illustration shows
this test disabled, because the checkbox is unchecked).
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4. |If the Priorites are the same, the Element Disciplines are checked. If the Disciplines are
different, the default discipline, typically 'UNALLOCATED' becomes the owner
discipline. Otherwise, the discipline common to both elements becomes the owner.

Note: It is useful to apply the tests, even if the discipline of both clashing elements is the
same, because the owner discipline highlighted in the Clash Report may well
represent the element that must be moved to resolve the clash, based on the relative
priorities or classes of the elements.

Class

This tab is for specifying Classes that are used in auto-acceptance and auto-assign-to-
discipline rules for clash ownership. The tab is also used to set the Classes in the 'Order’
they are to be considered, when the relative importance of the class of each element within
a clash is the subject of an automatic acceptance or assignment process.

B\ AVEVA Clash Manager Configuration

Secuity ] Group I Azgign ] .-’-‘«ccept] Level.n"T_l,Jpe] thpea’Trackingl

Froject ] Dizcipline Class l Friciity ] Statug ] Comments I
Description Attribute Y alue

Unkrown

Fabricated

Unelagsified

Dezcription |Elass

Altribute |:-<>-: of zite

Default |Unkn0wn j Dizcaver

The tab enables the values of a OUTFITTING attribute to be associated with the values of
the Ship Model Management class attribute for the purpose of automatic assignment of a
class to a clash.

Note: This configuration is separate from the 'Project Defined Field' configuration at the
Project Tab.

The pane at the top of the tab enables a particular Ship Model Management Class
Description and its Attribute Value to be selected. A Popup Menu is available (mouse
right-click) with options of Edit, Add, Delete and Set Default. This is used to edit an existing
class, add a new class, remove an existing class, or set an existing class as default. The
description is user-defined, the attribute value must match the OUTFITTING attribute value
for the particular class.
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The associated Up and Down buttons are for rearranging the '‘Order' of the classes, from
top to bottom. The least important class is at the top; the most important at the bottom. From
a pair of clashing elements, the auto-assignment process selects the discipline of the less
important element to be the owner of the clash, that is, the element with the class that is
nearer to the top of the list.

The Description field is for specifying the text to appear as the report column header for the
attribute values.

The Attribute box enables the OUTFITTING attribute associated with the selected class
attribute value to be specified. Clash Manager will search for the attribute on the clashing
item, and if not found there, will search the owning hierarchy for it. If Not Used is selected,
the CLASS attribute does not appear in the Clash Manager GUI. Note that CLASS is
designed to produce a modest number of look-up records, when a value is used as a
wildcard. An attribute, such as a NAME that would return a large number of values should
not be used.

The Discover button automatically produces a list of class descriptions and attributes that
are applicable to elements in clashes that have been discovered by Clash Manager. Each
Description of the various classes is formed by a concatenation of the OUTFITTING
attribute name followed by the particular attribute value. For example, for an attribute ‘type’
and a value BEND, the description is 'type BEND'. Each listed attribute value is available as
a Regular Expression wildcard (see Notes on Wildcards) for use in assignment and
acceptance rules. The values are preceded by ~ and followed by $ to ensure that only
complete strings are matched, for example, ~"BEND$.

Comments

This tab is for specifying the pre-defined comments that can be assigned to a clash, by use
of the Quick Comment button on the 'Clash Group Properties’ form.
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The pane on the tab displays Comments associated with a particular Discipline. A Popup
Menu is available (mouse right-click) with options of Add, Edit and Delete. This is used to
add a new comment, edit an existing comment, or remove an existing comment. The
associated Up and Down buttons are for rearranging the sequence of comments.

5.14.6 Discipline

This tab is concerned with associating the values of a selected OUTFITTING attribute with
the values of Ship Model Management discipline attributes for the purpose of automatic
assignment of an owner discipline to a clash. Displayed data is directly provided by PE
Workbench, except in the case of Stand Alone Clash Manager.
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Save Cancel

The pane at the top of the tab displays the list of Disciplines and their attribute values and,
except for Stand Alone Clash Manager, are read-only. For Stand Alone Clash Manager, a
Popup Menu is available (mouse right-click) with options to Add, Edit, Delete and Set as
Default. This is used to add a new discipline, edit an existing discipline, remove an existing
discipline and automatically set a discipline as default. Using this menu, the user creates the
list of Disciplines and their attributes that Clash Manager can match with the values of the
specified OUTFITTING attribute.

It is necessary to tell Clash Manager how to identify a discipline from a clashing element’s
attributes or its owner’s attributes. The Attribute box enables the user to do this by
specifying the particular attribute that, when evaluated, matches one of the attribute values
shown in the right-hand column in the discipline table. For example, an :MMSDISC value of
'P' would normally correspond to the 'P' set as the attribute of discipline 'Piping'. Clash
Manager will search for the attribute on the clashing item, and if not found there, will search
the owning hierarchy for it.

Note: If Not Used is selected, the attribute does not appear in the Clash Manager GUI, but
the default discipline will be UNALLOCATED, unless set otherwise, by the drop-
down list.

If a match is found then that discipline is associated with the clashing element, otherwise the
clash is assigned to a default discipline selected from the Default drop-down list. If a
clashing element does not match any of the specified values then it is set to a special
discipline called ‘UNALLOCATED".

Note: This configuration is separate from the 'Project Defined Field' configuration at the
Project Tab.
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Group

Many clashes may exist between pairs of significant elements. The clashes exist at lower
levels in the hierarchy, that is at the primitive level. These low level clashes may be grouped
together and selected for viewing, reporting and approval as a single entity, namely, as a
clash group.

AVEYA Clash Manager Configuration

Project ] Dizcipline | Clazs ] Friarity ] Status ] Carmrments ]
Secuity  Group l Agzign ] Arccept ] Level/Type ] Gtype/Tracking ]
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Save Cancel

This tab is for specifying aspects of clash groups, and the level in the hierarchy at which the
clashes are reported.

The items on the tab are as follows:

The Group Clashes between element pairs within +/- field and associated mm/inch
dimension radio group are for specifying the proximity of primitive clashes to be reported as
a group. Because the specified values are 'plus or minus', the coordinate dimensions of the
volume in which the clashes are considered to be a group are each twice the stated value.
The default setting for the group distance between element pairs is 100mm, but it is
common practice to have this value changed to 2000mm to make the clash grouping more
effective. The decision to change the distance should be done only in consultation with the
project discipline lead designers. The distance setting can be changed at any time during
the project life cycle, but the clash groups must then be recomputed. Making fundamental
changes to the group settings mid-project is not a recommended practice.

The Default Group Level dropdown lists are used to specify the level in the hierarchy at
which the clashes are grouped within the appropriate discipline. For example, clashes within
a pipe, may be reported at primitive level, at the branch level or at the pipe level. The
defaults are PIPE-PIPE, EQUI-EQUI, STRU-SCTN, HVAC-HVAC, REST-REST and
normally these are used. Clashes in other disciplines such as Hull and Room Design do not
default to single levels and are handled by Group Rules described below.
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The pane at the bottom of the tab is for specifying exceptions to the default group levels.
The exceptions are defined under headings of GTYPE, Attribute, Value and Group Level.
A Popup Menu is available (mouse right-click) with options of Add, Edit and Delete, used
to add a new GTYPE and details, edit an existing GTYPE details, or remove an existing
record. Up and Down buttons at the right-hand side of the pane are used to position the
highlighted record in the list and hence determine its priority.

Note: Before you can select a GTYPE that is not at a group level, you must first make it a
Controlled GTYPE (Refer to Gtype/Tracking).

A recommended exception to the default group levels concerns modelling of service
supports. In this case, although clashes are grouped by default at SCTN level for steelwork,
for support steelwork the group should be at STRU level, as this is typically the owning level
in the hierarchy for a support. To achieve this, the entry is: a GTYPE of ZONE, with
Attribute PURP, Value SUPP and Group Level STRU.

A Group Rule with GTYPE * will allow clashes to be grouped at the level of any type entered
under Group Level. For example, to group clashes with Hull objects at any of HPANEL,
CPANEL, BLEVEL or BBLOCK, create four rules with entries as: GTYPE *, Attribute and
Value left blank, Group Level HPANEL in the first rule, Group Level CPANEL in the
second rule, and so on.

Other examples for Cableway and Room Design objects are shown in the picture above.
The entry with GTYPE * and Group Level CWAY will group all clashes below cableways to
the owning cableway. The entry with GTYPE * and Group Level ROOM will group all
clashes below rooms to the owning room. The entry with GTYPE CTWALL and Group
Level CTWALL will group clashes with constant thickness walls at that level, but note that
clashes with CTWALL objects below ROOM objects will be grouped at ROOM level due to
the earlier rule.

Contiguous Group Rules with identical expressions are combined and tested at each level
so that if given groups contain one another, the lowest in the hierarchy is used. A Group
Rule with a specific GTYPE or with different expressions will end that combining process
(but may begin another).

Level/Type

This tab is for specifying the relative order of clash level/type combinations. The order is
used to compute the worst case clash of a Group.
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The Types can be 'Clash’, "Touching' or 'Clearance'.

The Levels can be 'Hard/Hard',

'Hard/Insulation', 'Hard/Soft', 'Insulation/Insulation’,

'Insulation/Soft', 'Soft/Soft', and 'Not Proven'.

The names and purposes of the items on the tab are as follows:

Pane listing level/type Note: There is no popup menu available for modification of

combinations under Clash
Level and Clash Type

the pane contents. The selected levelltype
combination can be moved up or down the list by
means of the Up or Down button.

Up and Down For setting the sequence of Level/Type combinations, as
displayed in the pane and hence the order of worst case
selection. The worst case is at the top of the list. Generally,
there is no need to redefine the default order.

Note: For brevity, Clash Level is abbreviated in the Clash Reports as follows:

Abbreviation | Clash Level Description

HH Hard/Hard
HI Hard/Insulation (or Insulation/Hard)
HS Hard/Soft (or Soft/Hard)

Il Insulation/Insulation

IS Insulation/Soft (or Soft/Insulation)
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SS Soft/Soft
NP Not Proven
Priority

This tab is for specifying Priorities that are used in auto-acceptance and auto-assign-to-
discipline rules for clash ownership. The tab is also used to set the Priorities in the 'Order’
they are to be considered, when the priority of each element within a clash is the subject of
an automatic acceptance or assignment process.

BN AVEVA Clash Manager Configuration
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Save Cancel

The tab enables the values of a OUTFITTING attribute to be associated with the values of
the Ship Model Management priority attribute for the purpose of automatic assignment of a
priority to a clash.

Note: This configuration is separate from the 'Project Defined Field' configuration at the
Project Tab.

The pane at the top of the tab enables a particular Priority Description and its Attribute
Value to be selected. A Popup Menu is available (mouse right-click) with options of Add,
Editing, Delete. This is used to add a new priority, edit an existing priority, or remove an
existing priority. The description is user-defined, the attribute value must match the
OUTFITTING attribute value for the particular priority.

The associated Up and Down buttons are for rearranging the 'Order’ of the priorities, from
top to bottom. The least important priority is at the top; the most important at the bottom.
From a pair of clashing elements, the auto-assignment process selects the discipline of the
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less important element to be the owner of the clash, that is, the element with the priority that
is nearer to the top of the list.

The Description field is for specifying the text to appear as the report column header for the
attribute values.

The Attribute box enables the OUTFITTING priority attribute to be selected. Clash
Manager will search for the attribute on the clashing item, and if not found there, will search
the owning hierarchy for it. If Not Used is selected, the PRIORITY attribute does not appear
in the Clash Manager GUI. Note that PRIORITY is designed to produce a modest number of
look-up records, when a value is used as a wildcard. An attribute, such as a NAME that
would return a large number of values should not be used.

The Discover button automatically produces a list of priority descriptions and attributes that
are applicable to elements in clashes that have been discovered by Clash Manager. Each
Description of the various priorities is formed by a concatenation of the OUTFITTING
attribute name followed by the particular attribute value. For example, for an attribute
‘priority’ and a value 10, the description is 'priority 10'. Each listed attribute value is available
as a Regular Expression wildcard (see Notes on Wildcards) for use in assignment and
acceptance rules. The attribute values are preceded by ~ and followed by $ to ensure that
only complete strings are matched, for example, *10%.

Following operation of the Discover button to determine all available values, the resultant
data can be edited to give acceptable ranges of priorities. For example, returned priorities
with values of ~10$ through ~19% could be edited to a single description ' Low Priority' with a
value *1[0-9]$.

Project

This tab is for entry of project-wide details.
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The Project Title, Client, Project Number, Project, Userid, Password and Default MDB
fields at the top of the tab are for entry of those project details. Except in the case of Stand
Alone Clash Manager, they are read-only, as they are configured in PE Workbench.
(Modification of the settings is at the PE workbench Project Administration form.)

For Standalone Clash Manager, the above fields are available for entry of the relevant
project data. An additional field Admin Password is available for entry of the password
required by non-administrative users to access the Clash Manager Configuration form.
When Clash Manager opens the configuration form it also starts a background Data Access
Routines process. This DARs process enables Clash Manager to directly interact with the
associated project during configuration setup. This allows Clash Manager to process and
test assignment, acceptance and other rules that are configured. The project login data and
MDB defined on the form is the used by Clash Manager during DARS entry.

Note: Each clash set has its own MDB definition used for entry during a clash set run.

The Display Units section allows the user to select the Units in which the values are to be
displayed in Clash Manager.

The Apply Group Changes to Clash Detail dropdown list enables the Administrator to
specify the policy for the project. The selection made here determines whether or not the
user can use the facility on the 'Clash Manager Options' form to choose whether or not
group changes are applied to clash details within a group. The options of the dropdown list
are:

Always - group changes are always applied and the user cannot change the policy
Never - group changes are never applied and the user cannot change the policy
Free - the user can choose whether or not group changes are applied.

© 2007 AVEVA Solutions Ltd 5:66 12.0



_AV:VA Clash Manager User Guide

5.14.11

GUI

The items in the Project Defined Field box are for selecting an attribute, the value of which
is to be added to the clash report for each clashing item. This additional data is useful for
filtering and sorting purposes in the main body of the report.

The Attribute Name field is for specifying the name of the attribute, e.g. AREA. Clash
Manager will search for the attribute on the clashing item, and if not found there, will search
the owning hierarchy for it.

The Description field is for entering the attribute value that appears in the Clash Report.

The Default field is for specifying a default value for the attribute if the OUTFITTING
attribute is not set.

An example of how an attribute can be used is as follows. Many companies use 'PURPose’
as the Attribute Name and the Zone radio button selected for capturing the description of a
ZONE's content over and above the naming convention. The ZONE is named with the
Piping Specification PSPE and the Attribute Name 'PURPose’ is given a Description
‘PROC’ for Process Piping and ‘UTIL’ for Utility Piping. Clash Manager then allows the user
to filter the clash report based on these values.

Note: The Class, Discipline and Priority tabs have groups of items similar to those in the
Project Defined Field box and which have similar functionality.

Status

This tab displays a listing of the standard status and enables user-defined status to be
entered within the list. It also enables a restriction to be placed on who can update a clash
from or to particular status.

: AVEYA Clash Manager Configuration @
Security I Group ] Agzign ] .t’-‘n.ccept] LB\-‘BL-"T_','DE] Gt_l,lpe.n"Tlacking]
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Description State Arncess

f proved

Conditional Conditional

Fending Fending
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Save Cancel
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The tab also specifies the default status to be allocated to new clashes that do not satisfy
auto-acceptance rules.

The standard status cannot be removed, and sequence in which they are displayed signifies
their order of priority, when 'worst case' clash details are evaluated by the system. The
sequence cannot be changed, but user-defined status can be inserted into the list.

The pane at the top of the tab displays the various Status details under Description, State
and Access. A Popup Menu is available (mouse right-click) with options of Add, Edit,
Delete and Set Default.

For standard status, the Description and State entries are identical, hamely, Unknown,
Unapproved, Pending, Conditional and Approved, and are read-only. The standard status
values are explained below:

e Unknown - an initial or default status applied to new clashes if none of the automatic
acceptance rules are triggered (the default status for a clash can be configured and is
described later)

e Unapproved - the clash has not been reviewed and remains as a valid or outstanding
clash for the project

* Pending - this status is used to indicate that the clash is currently under review by the
design teams

» Conditional - this status is used to indicate that the clash has been reviewed and
resolved in the OUTFITTING DESIGN model. This also implies that following the next
clash run this clash will no longer appear in the clash report. For reporting purposed
this status implies a resolved clash.

* Approved - this status is used to indicate that the clash has been reviewed and is
considered acceptable by the design team. The clash will continue to be reported in
subsequent clash runs but its approved status will remain with the clashing items
throughout the remainder of the project lifecycle. In Model Management terms if an
element has only ‘Approved’ clash status in the database then it is considered ‘Clash
Free’.

For user-defined status, the Description can be any text; the State must represent a
standard status.

The Access defines who can apply the particular status to a clash or change a clash from
the particular status to another. This access restriction is in addition to any set at the
Security tab. Access can be set to a discipline, in which case, only a user who has
supervisor rights to that discipline can change the status. The alternative access settings
are blank or 'Any', both of which signify that there is no access restriction, other than that set
at the Security tab.

The Default Status (for New Clashes) dropdown list is for specifying the status to be
applied to new clashes that are not automatically accepted.

Gtype/Tracking

This tab enables the administrator to specify which MDBs and controlled GTYPEs are to be
included in a Track Changes operation. Additionally, the tab provides facilities for specifying
Tracking Selection Rules that further restrict the range of controlled GTYPEs to be included
in the operation.
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MDBs

At the top of the tab, a pane called MDB displays a listing of the MDBs defined in Clash
Manager. Against each MDB is a checkbox, which is checked by default when the MDB is
first defined. As required, the administrator can un-check a checkbox to remove the
particular MDB from the Track Changes operation.

Controlled GTYPE

In the middle of the tab, a pane displays a listing under headings of GTYPE and State. The
listing is used to present a list of available GTYPEs and to enable certain of them to be
made Controlled or Uncontrolled. (Only a Controlled GTYPE is the subject of a Track
Changes operation.)

Except in the case of Standalone Clash Manager, a range of controlled GTYPEs is
predefined in PE Workbench. These predefined GTYPEs appear in the list and cannot be
made uncontrolled or deleted at this form. Also, GTYPEs that are Group Level Elements
(see the Group tab) and certain others that may be group level elements, such as ZONE,
are always controlled and cannot be made uncontrolled or deleted at this form.
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Further GTYPEs can be added at this form and these can be made controlled or
uncontrolled, or deleted, as required. A popup menu is available for this purpose. Its options
are as follows:

Add For adding another GTYPE immediately below the currently
selected GTYPE. Leads to an in-place edit window at which the
GTYPE can be entered. (Note that the Esc key can be used to
abort the entry in the in-place window.)

Control Makes the selected GTYPE controlled or uncontrolled

Delete Removes the selected GTYPE from the list.

Examples for hull, room design and cable way objects are shown in the picture above, with
CPANEL, CTWALL and CWAY made Controlled GTYPEs.

Note: You must first make a GTYPE Controlled before you can select it in a Group Rule
(Refer to Group).

Tracking Selection Rules

At the bottom of the tab, a pane is available for specifying rules that further restrict the range
of GTYPES to be included in the Track Changes operation. For the syntax of the Tracking
Selection Rules refer to Notes on Element Rule Syntax.

Note: A DB (and its hierarchy, that is, sites, zones, pipes, branches, etc) may be included in
many MDBs. For example, Site 12 (through the inclusion of containing DBs) may be
visible in two MDBs:

MDB1 /sitel, /sitel2
MDB?2 /site2, /site12.

Each Site and everything below it will exist in a single DB [name clashes are not impossible,
two sites with the same name may exist in different DBs, but only one would be generally
accessible through its name when included in the same MDB]. All branches of a PIPE would
be in a single DB, but that DB and thus the PIPE may be visible through more than one
MDB.

Clash Manager can combine MDBs and in the process may encounter duplicates, in which
case Selection Rules may return other starting points in the hierarchy, for example, a list of
ZONES.

It is important that the Selection Rules, when evaluated, return a list of unique items.

A popup menu is available. The options and their purposes are as follows:

Add For adding items or expressions to the particular list. Leads to an in-place
edit window, at which the item or expression can be entered. (Note that the
Esc key can be used to abort the entry in in-place windows.)

Edit For editing the selected expression. Leads to an in-place edit window, at
which the expression can be edited.

Browse For adding elements derived from the OUTFITTING hierarchy. Leads to the
'‘Browse Model' form
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Delete Deletes the selected item from the list. (The item is not deleted from the
model.)
Evaluate Evaluates the selection rules for each of the checked MDBs. Leads to the

‘Evaluate' form, which displays a consolidated listing of the results. In the
absence of any rules, the form displays a list of all SITEs in each of the
checked MDBs.

Note: Double-clicking a GTYPE name leads to the '‘Browse Model' form. Double-clicking on
an expression leads to the in-place edit window.

Test Rules Form

This form is for testing Assignment and Acceptance rules before they are applied to the
whole model by the Recomputation process. The form enables a subset of existing clash
records to be selected in order to display what would happen if the current rules were
applied to the 3D model. The form is intended to aid configuration; it does NOT allow the
evaluated status or discipline of the selected clash records to be saved.

: PD Clash Manager - Test Rules {(Group) @l

@& Group " Detail  Element Name % \wildcard
" Query I Evaluate Hules‘ Get 'Work ‘

Group | Element] | Element2 | Discipling | Status | Mew Discipline | New Status | Clevel| CType | Disciplingl | CGTypel | Class Discipline2 | CGType2 | Class

A group of elements at the top of the form enables the user to select the clash groups or
details and then apply the new rules to them. The main area of the form is occupied by
tabulated records showing the results of the selection and evaluation.

The elements at the top of the form and their purposes are:

Group / Detail radio For selection of the subset of clash records. The radio group is

group and Element for selection of whether clash groups or details are to be tested.

Name % Wildcard The entry in the field determines the range of clashing elements.
Oracle style wildcards are used (see Notes on Wildcards).

Query Interrogates the 3D model and displays records of the clash
groups or details that match the entry in the 'Element Name %
Wildcard' field.

Evaluate Rules Applies the new rules to the displayed records and shows the

new owner disciplines and status.

Get Work Resets the current MDB, and makes available changes to the
model after a 'SaveWork'.
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The tabulated records show, for each clash group or clash detail that satisfies the selection
criteria, information under the following headings:

Group

Index (clash details
only)

Element 1
Element 2

Discipline

Status

New Discipline

New Status

CLevel
CType
Discipline 1
Discipline 2

Remarks

The group identification. Populated after Query.

Clash identification number. Populated after Query.

First element of the clash. Populated after Query.
Second element of the clash. Populated after Query.

Owner discipline according to existing rules. Populated after
Query.

Status according to existing rules. Populated after Query.

Blank after Query. Populated after rule evaluation. Shows owner
discipline as assigned by the new rules. The name of the rule is
shown for NEW clashes only.

Blank after Query. Populated after rule evaluation. Shows the
status as applied by the new acceptance rules. The name of the
rule is shown for NEW clashes only.

Populated after Query. Shows the clash level.
Populated after Query. Shows the clash type.
Discipline of first element. Populated after Query.
Discipline of second element. Populated after Query.

Blank after Query. Populated after rule evaluation. Shows a
narrative description of the clashing elements.

A popup menu is available from the tabulated records. The options and their purposes are

as follows:

Query

Evaluate Rules

Get Work

Properties

Interrogates the 3D model and displays records of the clash groups or
details that match the entry in the 'Element Name % Wildcard' field.

Applies the new rules to the displayed records and shows the new
owner disciplines and status.

Resets the current MDB, and makes available changes to the model
after a 'SaveWork'.

Available only when a record is selected. Leads to the 'Clash Manager
- Clashing Elements - Properties' form, which displays values of all
attributes that may be involved in the setting of discipline or status of
the elements in the selected record.

The procedure for using the form is firstly to select clash group or detail and enter an
element name and wildcard to represent elements that will be affected by the updated rules.
Initiate the Query and then check the displayed records to ensure that they represent the
required typical elements. If they do not, re-enter element and wildcard details and re-query
the data. When the records are as required, apply the new rules and check whether the
results are as required. If the OUTFITTING Model has recently been changed, use the 'Get
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GUI

Work' feature and repeat the evaluation. Close the form by clicking on the X at the top right-
hand corner. Take action at the '‘Clash Manager - Configuration' form to correct or implement
the new rules, as appropriate.

Clashing Elements - Properties Form

This form provides the administrator with all data necessary to analyze the effects of all
attributes that may be involved in the automatic setting of owner discipline and/or status of a
pair of clashing elements. The particular elements are selected at the 'Clash Manager - Test
Rules' form.

BN AVEVA Clash Manager - Clashing Elements - Properties

Altribute Element1 Element2 »~
‘MDEMatePos

MDSMudgeDist 0.000000
MDSPackRef

MOSPad unset
MDSRotated FaLSE
MDSRatDir

MDESref

MDSStop unzet
:MDSStap2 unzet
MDSSuppType unzet
MDS5Swasher FaLSE
MDS Trirnrner FalLSE
MDY prmbdto TRUE

MMEDISC FIFE PIFE
Clasz

** Rules Attibutes **

@dizcipline FIFING FIFIMG
(Etype CLA CLA
comment of spref unzet

The information is in three-column tabulated records, headed Attribute, Elementl and
Element2, which respectively show the name of an attribute, its value for elementl and/or its
value for element2.

The upper section of the table displays standard OUTFITTING attributes and User-defined
attributes.

The next section, headed 'Project Attributes' displays the project-defined fields, such as
Discipline, Class and Priority, and the level in the hierarchy where the attribute occurs.

The lower section, headed 'Rules Attributes' displays a consolidated list of the attributes
from ALL rules that affect the clashing elements. The rules may not be involved in every
instance. The attributes may not exist on the clashing elements themselves, in which case
they exist on elements in the hierarchy above them.

Security Settings Form

This form is accessed from the Security Tab of the Clash Manager - Configuration form. It
enables the user to specify custom (user-defined) settings that can take the place of the pre-
defined settings for a particular Security Level (see Access Rights).
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B} AVEVA Clash Manager - Security Settings EJ

= Security Level - Changing Clazh Status
O% adwiristatar
Dﬁ Member of Administrators
Dﬁ Supervisor of Owner Dizcipline
Dﬁ Member of Dwner Discipline
Dﬁ Supervisor of either Dizcipling invakeed
ﬁ Member of either Discipling irvolved
Dﬁ Supervizor of any Discipline
Dﬁ Member of any Discipline
- Qg Mominated Uzers

O&¢ Urrestricted

Reset custam settings

Reszat ta:

CI[ e
Ok | Canicel |

The elements of the form and their purposes are:

Pane displaying Top checkbox labelled To show which security level being

atree of with the Security Level customized. The checkbox is always
checkboxes checked.
Eight checkboxes These are initially populated as for the
labelled with settings currently in use. The administrator
combinations of can select (tick) and deselect (clear) the
member, supervisor checkboxes to reflect the customized
and discipline minimum requirements for a user who is

allowed to perform tasks at the particular
Security Level.

Checkbox labelled This checkbox can be selected in addition to

Nominated Users any selected above. When the checkbox is
ticked, a branch of checkboxes labelled with
user names is displayed.

Ticking a checkbox in the branch,
unconditionally allows the particular user to
perform tasks at the particular Security Level.

Leaving a checkbox blank, bars the user from
performing the tasks.

Bottom checkbox When this checkbox is checked, any user can

labelled Unrestricted perform tasks at the particular Security Level.

Reset Custom Reset to: For selecting the appropriate state, when the

Settings custom settings are to be reset to pre-defined
settings.

Reset For resetting the customized settings to the

pre-defined settings for the State selected in
the dropdown list.
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OK Saves any changes and closes the form

Cancel Ignores any changes and closes the form
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6.1

6.1.1

6.1.2

Entry Information

Entry Information

Notes on Wildcards

Clash Manager uses two different styles of wildcards:
« In the configuration, standard Regular Expression syntax is used exclusively.

* In the GUI filters, Oracle/SQLServer style wildcards ( "%" and " " ) are used
exclusively.

Regular Expression Summary

Value Meaning
N Matches the start of a line
$ Matches the end of a line

Matches any character

* Matches zero or more occurrences of the previous expression

[string] Matches any one of the characters listed in string

In addition to the standard Regular Expression syntax there is a simple NOT operator <!>. If
the exclamation mark is the first character of the Regular Expression, the rule evaluates
TRUE if the expression fails.

Examples of Regular Expression Syntax

Example Matches Result of Example

Expression Expression

~AB]305% A string beginning with ‘A" or ‘B’ and | A305 or B305
ending with ‘305’

[AB]305 A string containing ‘A’ or ‘B’ followed by | IBMA305HAL or
‘305’ PQRB305LMN

ITEMP45 Any string that does NOT contain | /THIS/string/Matches
‘TEMP45’
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6.1.4

6.2

6.2.1

Entry Information

NSA5/.* A string beginning /S45 and ending with | /S45/ABCanythinggoeshere
TEMP45$% TEMP45 345/TEMP45
IN[S45 Any string that does not begin with /S45

Oracle/SQLServer Wildcard Summary

Value | Meaning

% Any number of characters of any value

Each underscore represents a single character of any value

Examples of Oracle/SQLServer Wildcard Syntax

Example Expression Matches

%pipe% Any string of any number of characters that contains 'pipe’

pipe_ Any string that starts 'pipe’ and ends with a single character

Notes on Rules and Rule Expressions

Rule expressions are used in the syntax of Rules used for the evaluation of:
« the automatic assignment of clashes to disciplines

and
< the automatic acceptance and status definition of clashes.

Expression Components
Each expression consists of an Element, an Attribute and a Value.

Keywords are used for Elements and can be used for Attributes and Values. All keywords
are prefixed by ‘@".

Element keywords may be:
@general which refers to the ‘clash’,
@element-1 which refers to one of the clashing elements,

@element-2 which refers to the other element.

Note: No particular order is implied and there is no relationship to the elements 1 & 2
shown on the Clash Report.

Attribute may be a Keyword related to the Item, or may be any OUTFITTING Attribute, for
example SHOP, or NAME etc

Value may be selected from a list-of-values related to the given attribute, or a Regular
Expression, (Refer to Notes on Wildcards) or a Keyword (Refer to Expression Syntax).
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Note: The rules are formed by logical 'AND' operators between the expressions. There is
no facility for logical 'OR’ operators.

6.2.2 Expression Syntax

Element Attribute Value

@element-1 | Assighment & Acceptance Rules
@element-2

@class A Defined Class
(field name is project defined)

@priority A Defined priority
(field name is project defined)

@areacode Regular expression
(field name is project defined)

@discipline A defined discipline

Any OUTFITTING attribute eg | Regular expression or keyword
NAME @element-2  or @element-1  which
evaluates true if the given attribute has the
same value as element-1 or element-2
respectively, or one of the keywords listed
below.

Expression can include one of the
comparison operators > >= < <= together
with a value, and will evaluate true if the
condition is met for the given attribute
value.

Other keywords may be (where N is 1 or
2):

@ref-of-element-N  replaced with the
reference of the clashing element,

@ref-of-owner-ele-N replaced with the
reference of the owner of the element,

@first replaced with the first member of
the clashing element

@first+n replaced with the nth member of
the clashing element, e.g. @first+1

@last replaced with the last member of
the clashing element

@last-n replaced with nth from last
member, e.g. @last-1

@gtype A GTYPE selected from list. (This list
originates from the Clash Manager
Configuration form - Gtype/Tracking tab.)
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@general Assignment & Acceptance Rules
@status A defined status
@level Clash Level, one of HH, HS, HI, II, IS, SS,
NP selected from a drop-down list
@type Clash Type, one of CLAsh, CLEarence,

TOUch selected from a drop-down list

Assignment Rules

@setDiscipline

Keyword @element-1 or @element-2.

The owner discipline is set to that of
element-1 or element-2 respectively.

6.2.3 Examples of Rules and their Syntax
Rule evaluates true if NAME of element 1 is same as element 2
Element Attribute Value
@element-1 NAME @element-2

Rule evaluates true if the name of either element contains the text ' TEMP’

Element

Attribute

Value

@element-1

NAME

TEMP

Rule evaluates true if name of either element begins with the text ‘/S/TEMP’

Element

Attribute

Value

@element-1

NAME

NSITEMP

Rule evaluates true if name of either element does not begin with the text ‘/S/ITEMP’

Element

Attribute

Value

@element-1

NAME

INNSITEMP

Rule evaluates true if name of neither element begins with the text /S/ITEMP’

Element Attribute Value
@element-1 NAME INSITEMP
@element-2 NAME INS?TEMP

Rule evaluates true if either element is PIPING and type of clash is TOUching

Element Attribute Value
@element-1 @discipline PIPING
@general @type TOU
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Rule evaluates true if one element is PIPING, the other STRUCTURAL, the name of the
STRUCTURAL item contains the text TEMP and type of clash is TOUching

Element Attribute Value
@element-1 @discipline PIPING
@general @type TOU
@element-2 @discipline STRUCTURAL
@element-2 NAME TEMP

Rule evaluates true if both elements are STRUCTURAL, the GTYPE of a clashing element

is PANEL and the type of clash is TOUching

Element Attribute Value
@element-1 @discipline STRUCTURAL
@general @type TOU
@element-2 @discipline STRUCTURAL
@element-1 @gtype PANE

Rule evaluates true if both elements have values of UDA :LSIZE that meet their respective

conditions.
Element Attribute Value
@element-1 :LSIZE > 1500
@general LSIZE <100

Rule evaluates true for a clash between a nozzle and a flange as second last member of a

connected branch.

Element Attribute Value

@element-1 @gtype FLAN

@element-1 tref of owner @ef-of-element-2
@element-1 sequence @last-1
@element-2 cref @ref-of-owner-ele-1
@element-2 @gtype NOzz

Rule evaluates true for a clash between a nozzle and a flange as second member of a

connected branch..

Element Attribute Value
@element-1 @gtype FLAN
@element-1 href of owner @ef-of-element-2
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@element-1 sequence @first+1
@element-2 cref @ref-of-owner-ele-1
@element-2 @gtype NOzz

Notes on Element Rule Syntax

The syntax for elements and their attributes discussed here applies to the items and
expressions in the

¢ Obstruction, Check and Exclude lists on the 'Clash Manager - Clash Set Data’ form and
to the

« Tracking Selection Rules entered at the Gtype/Tracking tab of the Clash Manager
Configuration Form.

The syntax can be:

<elementName>
OR
<gtype> ::= BRAN|SUBE|STRU|FRMW/|SUBS|PIPE|EQUI|SITE|REST|HVAC|ZONE
OR
<expression> [and <expression>]...
where:
<expression> ::= <expressionStyleA> | <expressionStyleB>
where:
<expresionStyleA>::= <attribute> [OF <gtype>|<eleName>] [NOT] <op> <value>
<expresionStyleB>::= <attribute> [NOT] <op> <value> [OF <gtype>| <eleName>]
where:
<attribute> ::= PDMS Element Attribute or UDA
<op>:=eq|ne|gt]|lt|=]!=|<>]|>]|<]|like
<value> ::= [<quote>] string [<quote>] | numeric | <inches> | <wildcard>
where:
<quote> ::= <singleQuote:"> | <verticalBar:|>
<inches> ::= numeric"

<wildcard> ::= regular expression

OR
<discardwildcard> ::= !<wildcard>
where:

<wildcard> ::= regular expression
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Note: For Regular Expression syntax, refer to Notes on Wildcards.
Strings must be quoted if they would otherwise be confused with a keyword eg a

<GTYPE> or <OP> etc

The <discardwildcard>’s are applied after all other expressions, they have the effect
of discarding or removing items from the list.

Examples

name of zone like ~/STRU

returns ZONE names beginning "/STRU"

site

returns all SITES

zone

returns all ZONEs

bore of pipe gt 100

returns PIPEs with bore > 100mm

bore gt 100 of pipe

returns PIPEs with bore > 100mm

bore gt 4" of pipe

returns PIPEs with bore > 4 inches

bore gt 100 and :pdmsarea like 15A
of pipe

returns PIPEs with bore > 100mm

and :PDMSAREA contains 15A

bore gt 100 and :pdmsarea = 15A
of pipe and name of site like »/
STRU

returns PIPEs with bore > 100mm

and :PDMSAREA equals 15A which are under a
SITE whose name begins "/STRU"

name of pipe like 'PIPE'

syntax error if 'PIPE' is not quoted (would otherwise
be an unexpected GTYPE)

name of pipe like /PIPE

/PIPE does not need to be quoted, it will not be
confused with a GTYPE

name of pipe not like 'PIPE'

returns all pipes whose name does not contain
'PIPE'

IPIPE

removes from the resulting list,
containing the text 'PIPE’

any name

Note that name of pipe not like 'PIPE' and !PIPE are very different, the former ADDs to the
resulting List, the latter only removes items from the List.

name of bblock like .* and name of
blevel like ACC

returns all blevels whose names contain "ACC"
below all bblocks

expression” error message.

Note that for default Group Level element types (ZONE, PIPE, HVAC, BRAN, EQUI,
SUBE, SUBS, FRMW, SBFR, SCTN, REST, HANG), the expression can use this type
alone. Other types require sub-expressions which reference each prior level in order to
locate the element. In the above example an expression such as "name of blevel like
ACC" alone would not provide enough information and would generate an "Incomplete

The List may only contain consistent element types. For example a SITE may not be added
to the List if it already contains ZONES. Note however that items below the level defined for
Grouping Clashes will be elevated to that Group Level. For example if clashes in a pipe are
configured to be grouped at the PIPE level, any expression which would return a BRANch or
a component will if fact return a (single) PIPE. The Evaluate option may be used on any of
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the Obstruction/Exclude or Check lists to display what would be used when the Clash Set is
run.

Default units are mm, inches may be used but the inch symbol, a double quote (") MUST be
specified. An alphanumeric string ending with a double quote must itself be quoted if it is to
be evaluated against a string. For example: :mystringatt = |4"| of pipe.
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7 Model Management Wizard

When the Model Management Wizard is executed, by running MMWizard.bat, a series of
screens guide the administrator though the steps to be taken. Details for each of the options
are given below.

The Model Management Wizard performs some administration tasks applicable to all Model
Management products. These are available on the General tab. It also performs other tasks
specific to Clash Manager. These are available on the Clash Manager tab. The Model
Management Wizard provides basic backup facilities for Clash Manager databases. Details
of options not relevant to Clash Manager are not covered here.

Use of the Model Management Wizard is largely self-explanatory. The first screen sets out
the functions performed by the Wizard and introduces the available options, selectable from
the second screen

The main menu of the Model Management Wizard looks like this:

AVEYA Model Management Wizard §|

Model Manager Wizard

Please Select Option ™ Project Mainkenance
(" Configure Project For Model Management
(" Create Standalone Clash Manager Project

" Password Encryption

Zancel < Back

The options available are:

Project Maintenance Allows the user to maintain a project

Create Standalone Clash Creates a Standalone Clash Manager project
Manager Project

Password Encryption Allows automated Logins to be used
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Before you can use Model Management products on a OUTFITTING project you must first
create a Model Management configuration file for the project.

You use the Model Management Wizard to create or update the Model Management
configuration file for a project. New configuration files must be based on an existing
configuration file (e.g. from another project or the sample configuration file supplied).

As well as using the Model Management Wizard to configure a project for Model
Management, before Clash Manager or Deliverable Manager can be used some product-
specific additions to the Oracle database are required.

The administrator will need to run the Wizard again to perform the necessary operations.

7.1  Project Maintenance

AVEVA Model Management Wizard

X

Model Manager Wizard

Project Maintenance

(" Configure Project For Model Management
(" Create Standalone Clash Manager Project

" Password Encryption

Zancel < Back Mext =
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If you select the Project Maintenance option the Wizard presents you with the Open Model
Management Project form, which allows you to select a project to maintain:

AVEYA Model Management Wizard fgl

Open Model Management Project

Open Madel Management

pra
Project Please select the UBSieritE |

Madel Management Project frorr
and specify the Qracle Login Password
details
Project |IF'E j

Cancel | < Back

Select a project name from the Project drop-down list, and enter a valid username and
password in the appropriate fields. Click the Next button to continue, the Back button to
step back a stage or the Cancel button to cancel.

The Wizard then presents you with the Project Maintenance screen:

AVEYA Model Management Wizard E|

Project Maintenance

- Model Manager ~
[] Recreate Model Manager Database Objects i
[] Create Lexicon PML Macro file "lexicon, pralmac”
[] Create PML GTYPE config data File "des-audit, prald:
[] Create DAC PML macra file "perops. pralmac”
- Clash Manager
[ Delete Clash Manager Daka
[] Recreate Clash Manager Database Objects
Integrated PE Project [ Export Clash Manager Data
[ Import Clash Manager Data
[ Remove Clash Manager Support
DM 12 - Deliverable Manager
[] Delete Deliverable Manager Data
[] Recreate Deliverable Manager Database Obijects
[ Export Deliverable Manager Data
[ Impaort Deliverable Manager Data ha

CLASH 5.4

Zancel | < Back | | |

The menu on the right is sensitive to the options that apply to the project you have selected
- for different projects this menu may contain different options. The area on the left contains
information specific to the project.

© 2007 AVEVA Solutions Ltd 7:3 12.0



_AV:VA Clash Manager User Guide

7.1.1

Model Management Wizard

Clash Manager Options

The Model Management Wizard is also responsible for configuring the Oracle database that
is used by Clash Manager. This Oracle database can either be used solely for Clash
Manager, or it can be one already used by PE Workbench and thus provides integrated
AVEVA product capability.

The Model Management Wizard provides options to add Clash Manager support to an
existing PE project, to create a new standalone Clash Manager project or to migrate Clash
Manager version 4 configuration data to Clash Manager version 5 format thus enabling
users to upgrade and take advantage of the additional functionality in version 5.

The Model Management Wizard also provides facilities that assist an Administrator in
managing Clash Manager customisation and data. In particular after an Administrator has
customised one project the customisation can be copied to another project using the Export
and Import options provided.

The options available in this menu depend on how the project is set up. The sets of options
available are:

Set 1 Set 2 Set 3

Upgrade Clash Manager Delete Clash Manager Data | Add Clash Manager Support
Database

Remove Clash Manager Recreate Clash Manager
Support Database Objects

Import Clash Manager Data

Export Clash Manager Data

Remove Clash Manager
Support

The option sets are mutually exclusive; i.e. you will get Set 1, or Set 2, or Set 3.

Remove Clash Manager Support

This option removes all Clash Manager tables and views from the Oracle Database and
removes related database packages and procedures. The space used in Oracle is freed.
The procedure cannot be undone; it would be necessary to add Clash Manager Support and
configure the project again to use Clash Manager after applying this option. An Export is
recommended before executing this option.

Delete Clash Manager Data

This option removes Clash Manager report data from the project, but retains Clash Manager
configuration. It performs the same function as the Delete All Clash Data, including
Comments and History button on the Clash Manager Options form. The clash set
definitions, check list, obstruction list are retained, but can be deleted manually.

The clash history is deleted. Remaining data is truncated to recover unused space in the
Oracle Table Space. However, unlike Delete All Clash Data, including Comments and
History, the Clash Index counters can optionally be reset to zero.

The procedure cannot be undone.
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Recreate Clash Manager Database Objects

This option recreates the internal oracle Grants and Synonyms that allow Clash Manager
users to read and modify clash data. This option will need to be run if new tables are added
to the oracle database as part of a new release of Model Management (refer to the Release
Notes delivered with each product release) or if new tables are added to the PE Workbench
database as part of a new release of PE Workbench.

Import Clash Manager Data and Export Clash Manager Data

These options are provided to help administrators manage customisation and project data.
Customised setup can be copied from one project to another using an Export from the
original project as Import to a new project. Export/Import also provides a basic backup
facility for administrators with limited Oracle Administration experience. Experienced Oracle
Administrators will probably prefer to use the more flexible, but more complex, backup
facilities provided as an integral part of Oracle.

After the Import/Export option has been selected, the administrator will be asked to enter the
Oracle Username and Password for the relevant project and specify whether Import or
Export is required.

The Export process creates a file of exported information. The Model Management Wizard
suggests what filename should be used, but the administrator is able to override the name
and location. By default only customisation information is exported, but a full data export can
be selected.

The Import process reads a file of exported information. The administrator is asked to
Browse and select a file created by the Model Management Wizard’s Clash Manager Export
option. The administrator is able to select which parts of the customisation from the Export
file are to be imported into the receiving project. If any conflicts between the information to
be imported and existing configuration and customisation in the receiving project are
detected the administrator will be asked to resolve these.

Create Standalone Clash Manager Project

When selecting the Create Standalone Clash Manager Project option from the Model
Manager Wizard screen the Enter Database Login having DBA Rights screen is
displayed. Select from the Data Provider dropdown menu either Oracle or SQL Server.

SQL Server

When selecting the SQL Server option from the Data Provider dropdown menu the form
shown is displayed:
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AVEYA Model Management Wizard Create Clash Manager, Project

Creating a new Clash
Manager Database

Enter Database Login having DBA Rights

X

Daka Provider |SQL Server j
Server Host |UKCAMD3478\SQLEXPRESS v |
DEA Username |sa A SBWM
DBE#& Password |****
Database |CIashManager ﬂ

Collation |Latinl_General_C5_a3

=l
Reset Default Collation

Cancel | < Back | Mext = |

|

The administrator will have to select the Server Host (the server list can be refreshed by
clicking the button to the right), enter the DBA Username and Password, and select a
Database and Collation (which must be Case Insensitive - click the button to the right to
reset the Default Collation).

Select the Next button to display the Projects Details form. This form and all subsequent
forms are common to both the Oracle and SQL Server options. Refer to Oracle and SQL

Server

7.2.2 Oracle

When selecting the Oracle option from the Data Provider dropdown menu the form shown is

displayed.
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B\ AVEVA Model Management Wizard Create Clash Manager Project [Z|

Enter Database Login having DBA Rights

Data Provider |Oracle j

DE&A Username 1svstem

Creating a new Clash

Bt
Manager Database DB#A Password |

Conneck String |0ra34?8

Cancel | < Back | et = ] : |

The administrator will have to enter the DBA Username and Password, and the Connect
String.

Select Next to display the Select Oracle TABLESPACEs form.

AYEVA Model Management Wizard Create Standalone Clash Manage... E|

Select Oracle TABLESPACEs

Default Tablespace |PR5_D.C\T.0. j
IMDEY Tablespace |PF‘!5—”\"D>< j
TEMP Tablespace |TEMP j

Zancel | < Back | ek = | |

The administrator will have to enter the Default Tablespace, INDEX Tablespace and a TEMP
Tablespace.

Select the Next button to display the Project Details form.

This form and all subsequent forms are common to both the Oracle and SQL Server option.
Refer to Oracle and SQL Server.
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The administrator will then need to enter the Project Code, Username and Password and

specify a Default MDB.

AVEVA Model Management Wizard Create Standalone Clash Manage... fg|

AYEYA
PDMS/Marine Project Details
AYEYA POMSIMarine Project Code
AYEYWA PDMSIMarine User
These details are used to
_run desclash and in the AVEYA PDMS{Marine Password
internal conneckion to the
Model, The Default MDE is
used in global operations an Default MDE I—
the database, independant
of Clash Sets
Cancel | < Back | | |

Select the Next button to display the Clash Manager Project Details form.

The administrator will have to enter a Title, Number, Client name and an Admin Password
for the Clash Manager

project.

AVEVA Model Management Wizard Create Standalone Clash Manage... E|

Further Project setup
may be required after
creation using the Tools
Configuration opkion in
the Clash Manager
Application

Clash Manager Project Details

Title |

MNumber |

Client |

Admin Password |

Display Units
MM

" FINCH

{* User Preference MM or FINCH

Cancel

Select the Next button.
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AVEVA Model Management Wizard Create Standalone Clash Manage... [

Create Standalone Clash Manager Project ~
¥PD Clash Manager Project: MDS
Configuration File: C:) AYEYA' Pdms1 2.0 pdmsuit,DFLTSCLASH_MDS.cfg

PDMS Project: MDS

AYEYA PDMS/Marine User: pr5
Default MDB: /IPE

Connect String: mwypekst
Default Tablespace: PR5_DATA
TEMP Tablespace: TEMP

INDEX Tablespace: PR5_INDX
Number: aveva

Title: aveva

Client: aveva

Ready To Create Standalone Clash Manager Project ...

Please press FINISH to complete the task| "

Cancel | < Back | | Finish |

The Wizard displays the information about both the projects, giving the administrator the
opportunity to cancel the process. If the administrator continues, remarks on the progress
are displayed until it is completed.

7.3 Password Encryption

If you select the Password Encryption option the Wizard presents you with the Copy
Encrypted Password to Paste Buffer form, which prompts you to enter a password.

AVEYA Model Management Wizard §|

Copy Encrypted Password to Paste Buffer

Enter Password |

Re-enter Password |

Zancel | < Back | | |

Encrypted passwords held in the Model Management configuration file enable automated
logins. The password must agree with the password for the nominated USERID in the
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underlying database system. If that password is changed, a corresponding change must be
made to the configuration file. The Model Management Wizard provides the required
password encryption. When running the Model Management Wizard the administrator
merely selects this option and enters the password twice.

AVEVA Model Management Wizard g|

Loading ASPCLASHLIBORA 10 Application. 1

Loading ASPCLASHLIBORA10.Automation.1
Loading ASPCLASHLIBORA10Messenger.1

Encrypted Password is

EFBBBF56BECZZ3F063E1620364E96407667364086439625B65BDb2C362

[copied to Paste Buffer]

Cancel | < Back | | Disriss |

This encrypted password is automatically copied into the Paste Buffer and can be pasted
into the DATABASE section of the {project}.cfg file. For example:

[DATABASE]
CONNECT-STRING | ipe
USERID | mms

PASSWORD | DCBA3B02A6A174C1648F7461524374F963ED6227963
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Performance Hints

Large Transactions - Worst Case Update Threshold

The setting of the Worst Case Update Threshold is entered at the Clash Manager Options
form. The value of the setting has a significant effect on the performance of the system.
There is a large performance degradation if the setting is too low; a performance gain if the
setting is correct. The principles are as follows.

Clash Manager holds information regarding the worst case clash status of a design element.
This information is used in MOM and is shown as the clash status of an item e.g. PIPE,
STRU, FRMW and holds the clash-free status of the controlled item. The software has two
ways of updating this status as a result of the user, or a clash run, changing the clash status
of an item. The first method (Single Update method) involves processing an individual clash
element, searching the database for the worst case and updating the element clash status
accordingly. This single element processing is quick for single clashes, but its speed of
processing is directly proportional to the number of clashes to be processed. So if you were
to use this method to process, for example, 1000 clashes, it would take approximately 1000
times longer. The second method (Global Update method) used by the software involves a
Global clash worst case process and is designed to work with ALL of the clashes in the
database. As this involves processing large amounts of data the software utilises more
sophisticated processing methods to speed things up. The second method is used at the
end of every clash run to determine the worst case clash status for all elements in the
database.

The 'Worst Case Update Threshold' value allows the user to determine when this more
efficient Global update is triggered, rather than using the single update method, which would
be very slow for large numbers of selected clashes in the clash groups grid. So, in summary,
this setting value will trigger the Global update for ALL clashes in the database rather than
using the single clash element processing method.

The value to set for this threshold is based on the volume of data in the clash tables and the
speed of your system. It is recommended that timing tests are carried out to determine the
optimum value.

If you prefer not to use the Global Update method, set the Threshold to a very large value so
that the system never reaches the trigger point and works on the single clash-by-clash
method.

Number in Clash History

When selecting Clash History Count at the Clash Manager Options form, bear in mind that
the greater the number of runs in the clash history, the slower the system performs.

© 2007 AVEVA Solutions Ltd 8:1 12.0



_AV:VA Clash Manager User Guide

8.3

8.4

8.4.1

8.4.2

Performance Hints

Changing Clash Status of Multiple Clash Groups

To improve the performance of the system when updating the clash status of multiple clash
groups, ensure that, at the Clash Manager Options form, the Auto View and Auto Display
Clash Detail options are set to OFF (false).

Clash Manager Functions

Three functions of the Clash Manager can be implemented by the MMSCMD operating
system command line interface. The functions are:

* Running a Clash Set
e Track Changes
* Loading a Desclash Report File.

The functions can be set to take place automatically, for example, overnight. The facility is
intended to be used by administrators.

General Syntax
The syntax is:

Mmscmd <userid> <password> <connectString> <project>
<configFile> <logfile> -clash <clash options>

Where:

<userid> is the Oracle userid of the PE project

<password> is the Oracle password of the PE project

<connectString> is the connect string to the Oracle instance hosting the PE
project

<project> is the OUTFITTING project related to PE project. It must
correspond with the configuration file project details.

<configFile> is the Model Object Manager configuration file

<logfile> is the path of the file to which start/finish messages are logged.

It may include symbols #date# and #time#.
-clash is the command to specify clash management

-<clash options> See below, under Clash Options

Clash Options

These are arguments for the clash command that determine the functions to be performed.
The arguments and equivalent functions are as follows:

set <set number> "<comments>" Running a clash set
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trackChanges '‘<comments>" Track changes

loadFile <set_number> "<comments>" Loading a Desclash Report File
<clashFileName>[-L]

Running a Clash Set

The complete process, using MMSCMD, is identical to performing the task manually using
the standard GUI. Indeed, during the run, the standard RUN CLASH SET GUI is displayed
enabling, for example, the run to be cancelled.

The desclash module of design is run with the Check List, Obstruction List and Exclude
Lists derived from the nominated clash set. Defined Gap and Clearance, Bcheck options,
etc, are also included.

A separate desclash report file is generated for each Check List item. The generated
desclash Report File(s) are loaded into the Clash Manager database.

Acceptance and Assignment rules are applied to new clashes to automatically set Clash
Status and Discipline ownership.

In the final phase, after all desclash Report File(s) are loaded, Clash Group Level Type
Worst cases are set, Garbage Collection is performed (including removing unwanted
historical data which is configured as part of the Clash Set definition) and lastly Element
worst case Clash States are set.

Note that the required OUTFITTING environment must be set prior to executing the
software with this option, for example by calling evars.bat from the installed folder.

Note: It is common practice to schedule smaller clash sets to run overnight during the
project working week and an overall clash set to run each weekend. Also, it is
recommended that only one batch of clash sets is run at a time, otherwise contention
for access to clash records can occur.

Syntax
The syntax is:

Mmscmd <userid> <password> <connectString> <project>
<configFile> <logfile> -clash set <set_number> ‘'<comments>"'

Example

call c:\Aveva\pdmsl2.0\evars.bat c:\Aveva\pdmsl2.0

rem following command line shown on several lines for clarity
c:\Aveva\ModeIManagementl2.0\mmscmd enrl secret vanl sam
c:\Aveva\projects\sam\samdflts\sam.cfg
c:\MMS\logFfiles\log.txt -clash set 1 "run clash set 1"

Track Changes

This process saves the current discipline/status counts from which future changes may be
tracked. This has the effect of adding another point in the history displayed on the clash
summary chart shown on the Clash Manager form. "NEW" clashes are tracked from that
point.

The equivalent process can be initiated by the Track Changes button on the Clash
Manager Options form - Advanced tab.
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That is no requirement to set OUTFITTING environment variables prior to using this option.

Syntax

The syntax is:

Mmscmd <userid> <password> <connectString> <project>
<configFile> <logfile> -clash trackChanges ''<comments>"

Example

call c:\Aveva\pdmsl2.0\evars.bat c:\Aveva\pdmsl2.0

rem following command line shown on several lines for clarity
c:\Aveva\ModeIManagementl2.0\mmscmd enrl secret vanl sam
c:\Aveva\projects\sam\samdflts\sam.cfg
c:\MMS\logfiles\log.txt -clash trackchanges "AFD"

Loading a Desclash Report File

This process enables a desclash report to be loaded directly into the Clash Manager
database, without re-running the Clash Set. It may be used, if following a lengthy desclash
run, the normal loading process is interrupted.

The equivalent process can be initiated by the Load Clash File button on the Clash
Manager Options form - 'Advanced tab.

Note that only desclash report files created by OUTFITTING running Clash Manager should
be loaded using this option.

Phase two of the loading process may be omitted (by using the -L option). Phase two
comprises Setting Clash Group Level Type Worst cases, Garbage Collection (including
removing unwanted historical data, configured as part of the Clash Set definition) and finally
Updating Element worst case Clash State. This option may be used when loading several
files, but the last execution should not include the option, since it is most important that
Phase two of the loading process is executed.

Note that the required OUTFITTING environment must be set prior to executing the
software with this option, for example by calling evars.bat from the OUTFITTING installed
folder.

Syntax

The syntax is:

Mmscmd <userid> <password> <connectString> <project>
<configFile> <logfile> -clash loadFile <set_number>
"<comments>" <clashFileName> [-L]

Example

call c:\Aveva\pdmsl12.0\evars.bat c:\Aveva\pdmsl12.0

rem following command Bline shown on several lines for clarity
c:\Aveva\ModelIManagementl2.0\mmscmd enrl secret vanl sam
c:\Aveva\projects\sam\samdflts\sam.cfg
c:\MMS\logfiles\log.txt -clash loadfile 1 "clash setl"
C:\Temp\pclam_SAM_cadusr_1\pclam_0001.0UT
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Running Clash Manager Options in Batch or Unattended Mode
The windows command AT can be used to run the options in batch or unattended mode.

Commands to run MMSCMD should be placed in a command file, for example in a file
called c:\MMS\proj\TrackC.bat

Note that the required OUTFITTING environment must be set prior to executing the
software with this option, for example by calling evars.bat from the OUTFITTING installed
folder.

Example

set USERNAME=pTf

set LM_LICENSE_FILE=744@pc357

call c:\Aveva\pdmsl2.0\evars.bat c:\Aveva\pdmsl2.0

rem following command line shown on several lines for clarity
c:\Aveva\ModeIManagementl2.0\mmscmd enrl secret vanl sam
c:\Aveva\projects\sam\samdflts\sam.cfg
c:\MMS\logfiles\log.txt -clash trackchanges "interium"

An example of how the AT command may be executed is:

AT 20:30 /Zinteractive /every:Su cmd /c c:\MMS\proj\TrackC.bat
This runs the Track Changes function every Sunday evening at 20:30.

Note: As an alternative to the AT command, clash set batch runs can be scheduled using
the Windows 'Scheduled Tasks' GUI.
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Implementing Clash Manager on an Existing
Project

Introduction

This topic describes the key activities that are typically employed on a OUTFITTING project
utilizing Clash Manager to report and resolve modeling interferences. Two types of user
carry out these activities: administrators and project discipline designers. The following text
describes the responsibilities of each user and provides guidance for a ‘best practice’
implementation of Clash Manager onto a small, medium or large OUTFITTING DESIGN
project.

Discipline Designer Role

Depending on the size and scope of the project you first need to decide what role the
discipline designers take in the clash resolution process. There are typically three
approaches that can be taken:

< All discipline designers have access to the Clash Manager reports and are responsible
for ensuring the clash free status of their part of the model. This approach is most
suitable for medium to large projects where a large clash data set is anticipated and
requires frequent review by all designers on a regular basis.

< Discipline leads or a small number of nominated discipline designers are given access
to the Clash Manager reports. These users are responsible for ensuring the clash free
status of their discipline’s part of the model. This approach is most suitable for small to
medium projects where a small team of users can adequately manage and review the
Clash Manager reports on a regular basis.

e An overall clash coordinator is responsible for all clashes on the project and is tasked
to review the Clash Manager reports and perform clash resolution in consultation with
discipline designers. This approach is most suitable for small projects where only a
small clash data set is anticipated and can be easily handled by one person on a part
time basis.

The options described above are for guidance only but represent the typical approaches
taken by existing users in the deployment of Clash Manager. You may decide to adopt one
of the above approaches directly or formulate your own solution to match your specific
project requirements.

Clash Manager Configuration

Before Clash Manager can be used on a project it is necessary to perform some basic
configuration tasks. The focus of these tasks is to produce a structured and organized
presentation of the clash data so that it can be easily evaluated for decisions to be taken on
how to manage the clashes. The following notes are divided into two sections; one
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describes Basic Configuration tasks for small to medium sized OUTFITTING projects and
the other covers Advanced Configuration of the application for larger OUTFITTING projects.

User Settings

Clash Manager stores all configuration settings described here in the Oracle database.
Additionally, individual User settings are stored locally on the user’'s computer in either
registry or xml files. The items stored are described below.

Settings.xml

Stored in user’s windows profile under

%APPDATA%\AVEVA\Model Management\ Project Settings\{project code}

- where %APPDATA% is the location the user’s Application Data is stored. This may not
necessarily be on the user’s local machine if the user has a ‘roaming’ windows profile.

e.g. C:\Documents and Settings\{user name}\Application Data\AVEVA\
Model Management\Project Settings\{project code}\settings.xml

Used by Model Object Manager to store column display settings and named filter settings.
Older versions of Clash Manager created a copy of this file for consistency with Model
Object Manager, but no Clash Manager settings were stored.

ClashManagerSettings.xml

Stored in user’s windows profile under
%APPDATA%\AVEVA\Model Management\ Project Settings\{project code}

e.g. C:\Documents and Settings\{user name}\Application Data\AVEVA\
Model Management\Project Settings\{project code}\ClashManager
Settings.xml

Used by Clash Manager to store user filter settings, including named filters. Retained on exit
from Clash Manager.

Registry

Stores the current Clash Manager window sizes and positions. Retained on exit from Clash
Manager.

Basic Configuration

To access the Clash Manager Configuration form select Tool>Settings to display the Clash
Manager Option form. Select the Clash Manager Configuration button. The Clash
Manager Configuration will be displayed.

Clash Manager required the following configuration tasks to be completed regardless of the
project size:

e Project

» Discipline
e Security

e Group

¢ Assign
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Advanced Configuration

In addition to the Basic Configuration tasks, for medium to large projects it is recommended
that Clash Manager is set up to automate as much of the administration and coordination of
clash processing as possible. To achieve this the following configuration tasks need to be
completed:

e Class

* Accept
e Priority
e Status

¢ Comments
e Level/Type
« Gtypel/Tracking

User Preferences

For both the basic and advanced configurations it is also necessary to consider how the
discipline users and clash coordinators interact with the Clash Manager reports. The
Preferences tab on the Clash Manager Options form contains an important setting for how
clash group changes are handled:

AVEYA Clash Manager Options Pz|
Preferences T Advanced
’. - PDMS Element Colours
Apply Group changes to Clagh Detail True ' _
“ETonIE WIICE TenE 172 & L Lin T ;
Enable 30 “ievs Representation Falze Element 2 |
Aubo Wiew True
Auto Rezet Limitz Dirawlizt Feport Highlight Colours
Auta Rotate Origin True _
Auto Clear 30 Display True
Auto Digplay Clagh Detai True Data Change |
Chart Higtory Count ALL _
+ Laoe Tomaact [ Vilue iy Set_|
+ Large Tranzactions
| Clash Ovner
Clash Manager Configuration... | Background
(1] 4

It is strongly recommended to have this preference set to True to make sure all changes
made to a clash group automatically cascade down to all associated clash details. This
removes problems where, for example, a clash group may be approved and its clash details
remain unapproved.

Using Clash Manager with the Laser Model Interface

When used in conjunction with the Laser Model Interface, Clash Manager employs a range
of methods to highlight clashes with laser models. The result will depend on the functionality
that has been implemented by the laser model vendor, but can include showing an outline
box around the cell of the laser model that contains the clash, showing the portion of the
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laser model within that cell in a higher visual density than the surrounding region, and
highlighting the content of that cell.

Clash Manager will automatically initialise a connection to the laser model driver via the
macro des-pclam-Imi-init.pomimac which is provided in the Model Manager pdmsui/dfits
folder for local customisation to suit the laser model software installed at the client site. LMI
initialisation is invoked by Clash Manager during a background Desclash run when an
XCELL is encountered in the obstruction list, and also on first encountering an XCELL
during viewing of clash groups in the interactive Design session.

The same macro can also be used to set the Desclash run to test with Cells or
ExactGeometry. The ExactGeometry setting will generate more accurate (and thus fewer)
clashes, but at the expense of increased runtime. The ExactGeometry option may not be
supported by any particular laser model software vendor.

Please note that laser models are not supported in OUTFITTING prior to version 11.6.SP2.

Users' attention is drawn to the implications for licensing of the laser model software when
using Clash Manager. If an interactive Design session and a background Desclash session
occur simultaneously there is the potential for Clash Manager to request two concurrent
laser model connections.

Clash Manager Workflow

This section describes the typical workflow for Clash Manager implemented on any size of
project. The workflow processes are divided into five main activities:

¢ Initial Configuration and Setup

» Clash Set Execution

« Engineering Clash Resolution

e Clash Reporting, Audit and Recomputation
¢ Clash database audit and recomputation
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